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MagneMotion System Configurator User Manual 

Important User Information
Read this document and the documents listed in the additional resources section about installation, configuration, and operation of this equipment before 
you install, configure, operate, or maintain this product. Users are required to familiarize themselves with installation and wiring instructions in addition to 
requirements of all applicable codes, laws, and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to be carried out by suitably 
trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use or application of this 
equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and requirements associated with 
any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is prohibited.

Additional Safety Information

Although every effort is made to keep this manual accurate and up-to-date, MagneMotion® and Rockwell Automation® assumes no 
responsibility for any errors, omissions, or inaccuracies. Information that is provided in this manual is subject to change without 
notice. Any sample code that is referenced in this manual or included with MagneMotion software is included for illustration only 
and is, therefore, unsupported.

Rockwell Automation recognizes that some of the terms that are currently used in our industry and in this publication 
are not in alignment with the movement toward inclusive language in technology. We are proactively collaborating with 
industry peers to find alternatives to such terms and making changes to our products and content. Please excuse the 
use of such terms in our content while we implement these changes.

ATTENTION: For additional safety notices and definitions, see the Notes, Safety Notices, and Symbols section and/
or the Safety Notices section.
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About This Manual

Overview

This section provides information about the use of this manual, including the manual 
structure, related documentation, format conventions, and safety conventions.

Purpose

This manual explains how to install and use the MagneMotion® Configurator. This software is 
used to create and modify the Node Controller Configuration File to define the transport 
system. This file is used for all transport systems. For MagneMover® Lite™ systems, 
creation and maintenance of the graphical representation of the system in the Track Layout 
File, which is used to generate the Node Controller Configuration File, is also covered.

This manual is not intended to provide design guidelines for the installation or a reference for 
the operation of a transport system. Use this manual in combination with the other 
documentation that accompanies the transport system to install, configure, test, and operate a 
transport system.

Audience

This manual is intended for people who install, configure, and maintain the Node Controller 
Configuration File and the Track Layout File for the transport system.

Prerequisites

The information and procedures that are provided in this manual assume the following:

• Basic familiarity with general-purpose computers and with the Windows® operating 
system.

• Complete design specifications, including the physical layout of the transport system, 
are available.

• All personnel who configure, operate, or service the transport system are properly 
trained.

Notes, Safety Notices, and Symbols
Notes, Safety Notices, and Symbols that are used in this manual have specific meanings and 
formats. Examples of notes, the different types of safety notices and their general meanings, 
and symbols and their meanings are provided in this section. Adhere to all safety notices 
provided throughout this manual to help achieve safe installation and use.
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Notes

Notes are set apart from other text and provide additional or explanatory information. The text 
for Notes is in standard type as shown in the following example.

NOTE: A note provides additional or explanatory information.

Safety Notices

Safety Notices are set apart from other text. The symbol on the left of the notice identifies the 
type of hazard. The text in the message panel identifies the hazard, methods to avoid the 
hazard, and the consequences of not avoiding the hazard.

Examples of the standard safety notices that are used in this manual are provided in this 
section. Each example includes a description of the hazard indicated. Labels may also be on or 
inside the equipment to provide specific precautions.

NOTICE Identifies an informational notice that indicates practices
that are not related to personal injury that could result in
equipment or property damage.

IMPORTANT Identifies information that is critical for the successful
application and understanding of the product.

ATTENTION: Identifies information about practices or
circumstances that can lead to personal injury or death,
property damage, or economic loss. Attentions help to
identify a hazard, avoid a hazard, and recognize the
consequence.

SHOCK HAZARD: Identifies information about
practices or circumstances where a severe shock hazard
is present that could cause personal injury or death.

AUTOMATIC MOTION HAZARD: Identifies
information about practices or circumstances where the
possibility of machinery automatically starting or moving
exists, which could cause personal injury.
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Related Documentation

These documents contain additional information concerning related products from Rockwell 
Automation. Before configuring or running the components, consult the other manuals listed 
in this document about support, installation, configuration, and operation of the transport 
system. You can view or download publications at rok.auto/literature.

Resource Description
MagneMotion QuickStick and 
QuickStick HT Design Guide, 
publication MMI-RM001

This manual explains how to design and configure the track layout 
and transport system.

QuickStick Motor Technical Data, 
publication MMI-TD051

This manual includes technical specifications for the QuickStick 100 
and QuickStick 150 motors.

MagneMotion Node Controller 
Interface User Manual, publication 
MMI-UM001

This manual explains how to use the supplied interfaces to configure 
and administer node controllers that are used with transport systems. 
This manual also provides basic troubleshooting information.

MagneMotion LSM Synchronization 
Option User Manual, publication 
MMI-UM005

This manual explains how to install, operate, and maintain the LSM 
Synchronization Option for use with transport systems.

MagneMotion NCHost TCP/IP 
Interface Utility User Manual, 
publication MMI-UM010

This manual explains how to use the NCHost TCP/IP Interface 
Utility to run a transport system for testing and debugging. This 
manual also explains how to develop Demo Scripts to automate 
vehicle motion for that testing. 

MagneMotion Virtual Scope Utility 
User Manual, 
publication MMI-UM011

This manual explains how to install and use the MagneMotion 
Virtual Scope utility. This utility provides real-time feedback of the 
change in Linear Synchronous Motor (LSM) performance 
parameters. 

MagneMotion Node Controller 
Hardware User Manual, publication 
MMI-UM013

This manual explains how to install and maintain the node 
controllers that are used with transport systems.

MagneMover LITE Ethernet Motor 
Configuration and Communication, 
publication MMI-UM031

This manual describes the network topologies for wiring 
MagneMover LITE Ethernet motors and for combining both RS-422 
and Ethernet motors in the same transport system.

MagneMotion Host Controller TCP/IP 
Communication Protocol User Manual, 
publication MMI-UM003

This manual describes the communication protocols between the 
high level controller and a host controller. This manual also provides 
basic troubleshooting information.

MagneMotion Host Controller 
EtherNet/IP Communication Protocol 
User Manual, publication MMI-UM004
Power Supply Reference Manual 
1606-XLS960F-3, 
publication 1606-RM032

The manual provides the specifications for the 1606 power supplies.

MagneMover LITE User Manual, 
publication MMI-UM002

This manual explains how to install, operate, and maintain the 
MagneMover LITE transport system. This manual also provides 
information about basic troubleshooting.

QuickStick 100 User Manual, 
publication MMI-UM006

This manual explains how to install, operate, and maintain the 
QuickStick 100 transport system. This manual also provides 
information about basic troubleshooting.

https://rok.auto/literature
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/mmi-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/td/mmi-td051_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um005_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um010_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um011_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um031_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um003_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um004_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/1606-rm032_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um002_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um006_-en-p.pdf
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QuickStick 150 User Manual, 
publication MMI-UM047

This manual explains how to install, operate, and maintain the 
QuickStick 150 motors and magnet arrays. This manual also 
provides information about basic troubleshooting.

QuickStick HT User Manual, 
publication MMI-UM007

This manual explains how to install, operate, and maintain the 
QuickStick High Thrust (QSHT) transport system. This manual also 
provides information about basic troubleshooting.

EtherNet/IP Network Devices User 
Manual, publication ENET-UM006

Describes how to configure and use EtherNet/IP devices to 
communicate on the EtherNet/IP network.

Ethernet Reference Manual, publication 
ENET-RM002

Describes basic Ethernet concepts, infrastructure components, and 
infrastructure features.

System Security Design Guidelines 
Reference Manual, publication 
SECURE-RM001

Provides guidance on how to conduct security assessments, 
implement Rockwell Automation products in a secure system, 
harden the control system, manage user access, and dispose of 
equipment. 

UL Standards Listing for Industrial 
Control Products, 
publication CMPNTS-SR002

Assists original equipment manufacturers (OEMs) with construction 
of panels, to help ensure that they conform to the requirements of 
Underwriters Laboratories.

Product Certifications website, 
rok.auto/certifications.

Provides declarations of conformity, certificates, and other 
certification details.

Resource Description

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um047_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um007_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/enet-um006_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/enet-rm002_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/enet-rm002_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/rm/secure-rm001_-en-p.pdf
�http://literature.rockwellautomation.com/idc/groups/literature/documents/sr/cmpnts-sr002_-en-p.pdf
https://rok.auto/certifications
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Introduction 1

Overview

This chapter provides an overview of the MagneMotion® Configurator, the transport system 
hardware and software, and the basic set of tasks for using the MagneMotion Configurator. 
Use this manual to configure and maintain the Track Layout File and the Node Controller 
Configuration File for a transport system.

This manual supports:

• MagneMover® Lite™ transport systems.

• QuickStick® transport systems.

• QuickStick HT transport systems.

Included in this chapter are overviews of:

• The MagneMotion Configurator.

• The transport system components.

• The transport system software.

• Getting started with the Configurator.

MagneMotion Configurator Overview
The MagneMotion Configurator is a Windows® .NET software application that is provided by 
Rockwell Automation. This application is used to create and edit the Track Layout File and 
the Node Controller Configuration File for the transport system. These files use text and XML 
to define the parameters for the components in the transport system.

The transport system is a configuration of linear synchronous motors that are placed 
end-to-end to form long chains, or paths. These chains are used to move and position vehicles 
in a controlled manner at various acceleration/deceleration and velocity profiles while 

NOTICE QS 100, QS 100 Plus, and QS 150 are in the QuickStick
motor family and use similar screens.

QSHT and QSHT 5700 are in the QuickStick HT motor
family and use similar screens.
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carrying a wide range of payloads with high precision. The transport system consists of the 
following components at a minimum:

• Motors.

• Vehicles with magnet arrays.

• Node controllers.

• Power supplies.

• Configuration file defining paths and nodes.

• User-supplied host controller (general-purpose computer or PLC).

Each of the components of the transport system must be defined in the Node Controller 
Configuration File for proper operation of the transport system. The MagneMotion 
Configurator allows creation or editing of the Node Controller Configuration File without 
having to access the XML directly.

The MagneMotion Configurator provides a graphical interface to define or modify the various 
elements of the Track Layout File. The Configurator also provides a tree-like structure to 
define or modify the various sections and elements of the Node Controller Configuration File. 
In the Configurator, each element in the Node Controller Configuration File is displayed in 
the Configuration Tree and has a related Properties page where the properties for that element 
can be defined or modified.

NOTICE The Node Controller Configuration File can be viewed,
and edited, in various applications such as web browsers,
text editors, and XML editors. However, Rockwell
Automation recommends using only the MagneMotion
Configurator to make sure that the file is formatted
correctly and contains the correct entries.
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Transport System Components Overview
This section identifies the components of a transport system, see Figure 1-1 and described 
after the figure.

Figure 1-1: Simplified Example of Transport System using RS-422 Communication

• DC Power Cables and Communication Cables – Distributes DC power to the 
motors and carries communications, such as RS-422 or Ethernet, between the 
components of the transport system.

• High-Level Controller (HLC) – Software application that is enabled on one node 
controller. This application handles all communication with the user-supplied host 
controller and directs communication as appropriate to individual node controllers.

• Host Controller – User-supplied controller for control and monitoring of the transport 
system using either TCP/IP or EtherNet/IP™ communications.

• Motor/Stator – Refers to a linear synchronous motor (LSM).
• Network – Ethernet network providing communication (TCP/IP or EtherNet/IP) 

between the host controller and the HLC (TCP/IP is used between node controllers).
• Node Controller (NC) – Coordinates motor operations and communicates with the 

HLC. Several types of node controllers are available. All node controllers support 
Ethernet communication with the host controller and the motors.

• Power Supply – Provides DC power to the motors.
• Vehicle with Magnet Array – Carries a payload through the transport system as 

directed. The magnet array is mounted to the vehicle facing the motors and interacts 
with the motors, which move each vehicle independently.

QS 150
Motor 

DC Power 
Cables

Power
Supply

Node Controller
(and High-Level 
Controller)

Host
Controller
(PLC or PC)

Network 
(Ethernet)

Motor
Communication
Cables
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Transport System Software Overview
Several software applications are used to configure, test, and administer a transport system, 
see Figure 1-2 and described after the figure. See Related Documentation on page 11 for the 
reference manuals for these applications.

Figure 1-2: Simplified View of Transport System Software Organization

Utilities
• NC Web Interface – A web-based software application that is supplied by Rockwell 

Automation and resides on the node controllers, for administration of the transport 
system components.

Host Controller
(EtherNet/IP or TCP/IP)

MagneMotion Configurator

NC Web Interface

NCHost TCP Interface Utility

Node Controller Software Image
(controller_image)

Motor ERF Image Files
(motor_image.erf)

Motor Type Files
(motor_type.xml)

Magnet Array Type Files
(magnet_array_type.xml)

Node Controller Configuration File
(node_configuration.xml)

MagneMotion Info and Config Service
(MICS_motor_data.xml)

Restricted Parameters File
(restricted parameters.xml)

System Control

System Testing(NCHost.exe)

(MMConfigTool.exe)

track_file.mmtrkdemo_script.txt

Virtual Scope Utility

NC Console Interface

(MMI_Virtual_Scope.exe)

(TCP/IP)

(RS-232)

Node Controller

Node Controller
Administration

Performance
Monitoring

Node Controller
Administration

node_configuration.xml

MagneMotion Comm Tool
(mmi_commtool.exe)

NC File Retrieval Tool
(NC_File_Retriever.exe)

MICS_motor_data.xml

Motors
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• NC Console Interface – A serial communication software application that is supplied 
by Rockwell Automation and resides on the node controllers, for administration of the 
node controller.

• Virtual Scope Utility – A Windows software application that is supplied by Rockwell 
Automation to monitor and record the change of motor performance parameters. 
These parameters are displayed as waveforms to analyze the performance of the 
motors.

• NCHost TCP Interface Utility – A Windows software application that is supplied by 
Rockwell Automation to move vehicles for test or demonstration purposes. This 
application supports system testing without the host controller to verify that vehicles 
move correctly before integrating the transport system into a production environment.

• MagneMotion Configurator – A Windows software application that is supplied by 
Rockwell Automation to create or change the Node Controller Configuration File. 
This software supports all transport systems. For MM Lite™ systems, it is also used to 
create or change the Track File and Track Layout File.

• Ethernet Motor Commissioning Tool – A Windows software application that is 
supplied by Rockwell Automation to create and edit MagneMotion Information and 
Configuration Service (MICS) files.

• NC File Retrieval Tool – A Windows software application that is supplied by 
Rockwell Automation to download configuration and operation files from the 
specified HLC and all node controllers in the transport system.

File Types
• Node Controller Software Image File (IMG file) – The software file for the node 

controllers (controller_image), includes the node controller and HLC applications. 
The Node Controller Software Image file is uploaded to all node controllers in the 
transport system.

• Motor ERF Image Files (ERF file) – The software files for the motors (motor_
image.erf). The Motor ERF Image files are uploaded to all node controllers in the 
transport system and then programmed into all motors.

• Motor Type Files – XML files (motor_type.xml) that contain basic information about 
the specific motor types being used. The Motor Type files are uploaded to all node 
controllers in the transport system.

• Magnet Array Type File – An XML file (magnet_array_type.xml) that contains 
basic information about the specific magnet array type that is used on the vehicles in 
the transport system. The Magnet Array Type file is uploaded to all node controllers in 
the transport system.

• Node Controller Configuration Files – An XML file (node_configuration.xml) that 
contains all the parameters for the components in the transport system. Multiple Node 
Controller Configuration Files can be uploaded to all node controllers in the transport 
system, but only one is active.
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• MagneMotion Information and Configuration Service (MICS) File – An XML file 
(MICS_motor_data.xml) that contains the network topology parameters for the 
transport system when using Ethernet communication with the motors. The file 
includes the MAC address of each motor and the location of each motor on a path. The 
MICS file is uploaded to all node controllers in the transport system.

• Restricted Parameters File – An XML file (restricted_parameters.xml) that provides 
access to restricted configuration elements for specific transport systems. The 
Restricted Parameters file is uploaded to the HLC. For the development of a custom 
Restricted Parameters file for a specific transport system, see Rockwell Automation 
Support.

• Demo Script – A text file (demo_script.txt) uploaded to the NCHost TCP Interface 
Utility to move vehicles on the transport system for test or demonstration purposes.

• Track File – A text file (track_file.mmtrk) that contains graphical path and motor 
information about the transport system. The Track file is used by the NCHost TCP 
Interface Utility to provide a graphical representation of the transport system to 
monitor system operation. The Track file is created for MagneMover Lite transport 
systems using the MagneMotion Configurator. For the development of a custom Track 
File file for a specific QuickStick transport system, see Rockwell Automation Support.

• Track Layout File – An XML file (track_layout.ndx) that contains the parameters for 
the graphical representation of a MagneMover Lite transport system. The Track 
Layout file is used by the Configurator to generate the Node Controller Configuration 
File and the Track file for MagneMover Lite systems.

Getting Started with the MagneMotion Configurator
Use this manual as a guide and reference when using the MagneMotion Configurator. Follow 
the steps in this section to get the entire transport system operational quickly with the aid of 
the other manuals (see Related Documentation on page 11).

NOTE: Make sure that complete design specifications, including the physical layout of the 
transport system, are available before starting to configure the transport system.

NOTICE Modifications to the Image or Type files could cause
improper operation of the transport system.

Table 1-1: Menu Definitions and Short-cut Keys

Menu Action Short-cut
File New XML Config Ctrl+N

Open XML Config Ctrl+O

Save XML Config Ctrl+S
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To get started with the transport system:

1. Download the software for the appropriate transport system and the MagneMotion 
Utilities from rok.auto/pcdc.

NOTE: The minimum requirements for running MagneMotion software applications 
are a general-purpose computer running Microsoft® Windows® 7 or later 
with .NET 4.0. An Ethernet port (web interface) and an optional RS-232 port 
(console interface) are required to connect to the node controllers.

2. Install the components of the transport system as described in the MagneMotion Node 
Controller Hardware User Manual, publication MMI-UM013, the MagneMover Lite 
User Manual, publication MMI-UM002, the QuickStick 100 User Manual, publication 
MMI-UM006, the QuickStick 150 User Manual, publication MMI-UM047, or the 
QuickStick HT User Manual, publication MMI-UM007.

3. Install the MagneMotion Configurator on a computer for user access as described in 
Install the MagneMotion Configurator on page 23.

4. For MagneMover Lite systems, create a graphical representation of the transport 
system to define the components and their relationships in the system as described in 
the following sections of this manual and save it as a Track Layout File (track_
layout.ndx).

A. Run the MagneMotion Configurator on page 26.

B. Create and Save Track Layout Files on page 31.

C. Add required transport system components to the track layout:

• Layout the Motors and Switches on page 48.

• Define the LSM Sync Option Motors on page 49.

• Define the LSM Air Cooled Option Motors on page 51

• Define the LSM High Payload Option Switches on page 51

Edit Insert Before Ctrl+Shift+I

Insert After Ctrl+I

Add to End Ctrl+E

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Delete Del (Delete)

Table 1-1: Menu Definitions and Short-cut Keys

Menu Action Short-cut

https://rok.auto/pcdc
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um002_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um006_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um047_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um007_-en-p.pdf
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• Locate and Define the Nodes on page 52.

D. Add optional transport system components to the track layout:

• Identify Direction of Forward Motion on page 59.

• Locate the Precision Locators on page 59.

• Define Vehicles on page 60.

• Locate Legs on page 61.

• Dimension the Layout on page 63.

• Add Descriptive Text on page 64.

• Select Save NDX Layout on the File menu in the Configurator Menu 
Bar to save all changes to the Track Layout File. on page 65.

5. For MagneMover Lite systems, automatically create the Node Controller 
Configuration File (node_configuration.xml) from the Track Layout File to define the 
components and operating parameters of the transport system as described in 
Automatically Create the Node Controller Configuration File on page 55.

6. For all systems, edit and save the Node Controller Configuration File (node_
configuration.xml) to define the components and operating parameters of the transport 
system as described in the following sections of this manual.

A. Run the MagneMotion Configurator on page 26.

B. Create and Save Node Controller Configuration Files on page 36.

C. Set EtherNet/IP Settings on page 80, when using EtherNet/IP communication 
(typically an Allen-Bradley® ControlLogix® controller) to control the 
transport system.

D. Defining HLC Control Groups on page 82, when the transport system is 
subdivided into smaller transport systems (HLC Control Groups) with multiple 
host controllers and multiple HLCs and where Gateway nodes are used to 
transfer vehicles from one HLC Control Group to another.

E. Define each transport system component that is used in the transport system:

• View and Edit Functions on page 75.

• Set Configurator View and Edit Functions on page 75.

• European Number Formatting on page 74.

• Create and Edit Path on page 89.

• Define and Edit Motors and Vehicle Parameters on page 93.

• Show Per Motor Control Loop Parameters on page 111.

• Create and Edit Nodes on page 119.

• Define and Edit Node Controllers on page 162.
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• Create and Edit Stations on page 167.

• Create and Edit Single Vehicle Areas on page 171.

• Create and Edit Simulated Vehicles on page 176.

• Define and Edit E-Stops on page 179

• Define and Edit Interlocks on page 181.

7. Set the IP address for each node controller and specify the node controller to be used 
as the HLC (see the MagneMotion Node Controller Interface User Manual, 
publication MMI-UM001).

8. Upload the configuration, image, and type files to each node controller using the node 
controller web interface (see the MagneMotion Node Controller Interface User 
Manual, publication MMI-UM001).

9. When using motors with Ethernet communication, create the MICS file and provision 
the motors (see MagneMover Lite Ethernet Motor Configuration and Communication, 
publication MMI-UM031).

10. Program the motors using the Motor ERF Image Files (see the MagneMotion Node 
Controller Interface User Manual, publication MMI-UM001, and the MagneMotion 
NCHost TCP Interface Utility User Manual, publication MMI-UM010).

11. Test and debug the transport system by using the NCHost TCP Interface Utility and 
Demo Scripts (see the MagneMotion NCHost TCP Interface Utility User Manual, 
publication MMI-UM010). NCHost provides an easy method to verify proper 
operation and make adjustments such as refining the control loop tuning.

NOTE: The NCHost TCP Interface Utility is for test and verification trials only. The 
host controller must be used to control the MM Lite transport system after 
verification of functionality.

12. Configure the host controller for transport system control as required to meet the 
material movement needs of the facility where the system is installed.

• When using TCP/IP communication, see the MagneMotion Host Controller TCP/IP 
Communication Protocol User Manual, publication MMI-UM003 and MagneMotion 
Host Controller EtherNet/IP Communication Protocol User Manual, publication 
MMI-UM004.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um031_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um010_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um010_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um003_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um004_-en-p.pdf
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Use the MagneMotion Configurator 2

Overview

This chapter describes how to install and use the MagneMotion® Configurator to create and 
edit Node Controller Configuration Files for transport systems. This chapter also covers how 
to create and edit the Track Layout Files for MagneMover® Lite™ systems.

 Included in this chapter are:

• Installing the MagneMotion Configurator.

• Running the Configurator.

• Track Layout File overview.

• Creating, editing, and saving Track Layout Files.

• Node Controller Configuration File overview.

• Creating, editing, and saving Node Controller Configuration Files.

• Overview of uploading the Node Controller Configuration File to the node controllers.

NOTE: The Node Controller Configuration File must be uploaded to each node controller in 
the transport system anytime changes are made to the file.

Install the MagneMotion Configurator
The MagneMotion Configurator that is supplied with the transport system must be installed. 
During the installation process, the computer is checked to make sure that all required 
software components are also installed. The minimum software requirements for installing 
and running the Configurator are:
• Microsoft® Windows® 7 or later, SP1.
• Microsoft .NET 4.0.

1. Access the folder where the software was copied and run MMConfigToolSetup.msi.
NOTE: The permissions and security settings on the computer may need to be 

adjusted to allow this installation.
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The MagneMotion Configurator Tool setup wizard is opened, see Figure 2-1. If 
Microsoft .NET 4.0 is not installed on the computer where the MagneMotion 
Configurator is being installed an alert is displayed instead.

Figure 2-1: MagneMotion Configurator Tool Installer

A. If the .NET Framework alert is displayed, follow the directions to install 
Microsoft .NET 4.0.

B. After .NET 4.0 is installed, restart the installation process from Step 1.

2. Select Next.

The MagneMotion Configurator Tool setup wizard prompts for an installation path 
and usage permissions, see Figure 2-2.

Figure 2-2: MagneMotion Configurator Tool Installation Setup
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3. Accept the defaults and select Next.

The MagneMotion Configurator Tool setup wizard prompts for confirmation of the 
installation, see Figure 2-3.

Figure 2-3: MagneMotion Configurator Tool Installation Confirmation

4. Select Next.

5. Adjust the security settings for this computer to allow this installation as necessary.

The MagneMotion Configurator Tool setup wizard installs the software, see 
Figure 2-4 and places an Icon for access on the desktop, see Figure 2-6.

Figure 2-4: MagneMotion Configurator Tool Installation Progress
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After the installation is complete, see Figure 2-5 the MagneMotion Configurator can 
be used as described in Run the MagneMotion Configurator on page 26.

Figure 2-5: MagneMotion Configurator Tool Installation Complete

6. Select Close.

Run the MagneMotion Configurator
This section describes how to start and stop the MagneMotion Configurator. The Configurator 
is used to create and edit the Node Controller Configuration File, which contains the 
parameters for the components in the transport system. Always make sure to use the version 
of the Configurator that was supplied with the transport system.

1. Select the MagneMotion Configurator Tool icon, see Figure 2-6.

Figure 2-6: MagneMotion Configurator Tool Icon

NOTE: An alternative method is to start the program from the Windows Start icon; 
select All Programs, select MagneMotion from the folder list, then select 
MagneMotion Configurator Tool.

The MagneMotion Configurator window opens with an empty Configuration Tree 
and the Global Settings page that is displayed in the Configuration Settings Pane, see 
Figure 2-8. For MagneMover Lite systems the System Layout Pane is displayed with 
a blank layout.
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The first time the MagneMotion Configurator is started, the Select System Type 
dialog, see Figure 2-7. This configures the user interface to display only those 
functions appropriate to the selected motor type.

Figure 2-7: Select System Type

2. Select the type of motor type that this installation is being used with and select OK. 
This can be changed anytime when the Configurator is running, through the System 
Type option on the File menu.

The dialog closes and the user interface is configured for the selected motor type.
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Figure 2-8: MagneMotion Configurator for MagneMover Lite

3. Move the bars that separate the panes in the window to access either the System 
Layout Pane or the Configuration Settings Pane, see Figure 2-9 and Figure 2-10. 
Use the scroll bars to see the text in the panes, or resize the window as necessary.

NOTE: When the cursor is moved over the separator bars, it changes to either the 
Horizontal Resize cursor ( ) or the Vertical Resize cursor ( ). 

Configuration Tree
Configurator Menu Bar

Configuration Settings Pane

Track Symbols Area
Layout Toolbar

System Layout Pane
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Click-and-hold the left mouse button after the cursor changes to move the 
bars.

Figure 2-9: System Layout Pane Expanded

Figure 2-10: Configuration Settings Pane Expanded

System Layout PaneLayout Toolbar Layout Area

ConfigurationConfigurator Configuration
Menu Bar Tree Settings Pane
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4. Do one of the following:
• If this transport system is new, see Track Layout File Overview on page 30. 

Then proceed to Create and Save Track Layout Files on page 31 to create the 
Track Layout File. From the Track Layout File, see Automatically Create the 
Node Controller Configuration File on page 57 to generate a Node Controller 
Configuration File. 

After the Node Controller Configuration File is created, see Node Controller 
Configuration File Overview on page 34. Then proceed to Edit Existing Node 
Controller Configuration Files on page 38 to clean up the generated Node 
Controller Configuration File.

• If this transport system was previously configured, see Edit Existing Node 
Controller Configuration Files on page 38 to update the Node Controller 
Configuration File.

• If this transport system is being reconfigured, see Edit an Existing Track 
Layout File on page 33.

Stop the MagneMotion Configurator
1. Make sure that all files (node_configuration.xml, track_layout.ndx, and track_

file.mmtrk) are saved.

NOTE: File types .ndx and .mmtrk are for MM Lite only.

2. Stop the MagneMotion Configurator:
• From the File menu select Exit.
• Select the X in the upper-right corner.

Track Layout File Overview
The Track Layout File (track_layout.ndx) is an XML file that defines the components of the 
MagneMover transport system for graphic display. The properties that are defined include the 
relationship of the motors to each other, the location and type of nodes, the direction of 
movement, and the quantity of vehicles. The MagneMotion Configurator provides a tool for 
editing this file graphically, which eliminates the need to either view or edit the XML directly. 
The file can have any name for convenient reference.

See the physical layout drawings of the transport system to determine the components and 
their configuration in the transport system.
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Required Track Layout File Elements

Graphic symbols (icons) are used to represent the main elements of the transport system in the 
Track Layout File. These elements must be defined so the Track Layout File can be used to 
generate the Node Controller Configuration File (see Generate Image Files on page 68).

• Motor Icons – Provides motor symbols that can be positioned as required in the track 
layout. Right-click on the symbol after it is positioned to identify the motor as a Sync 
or Air Cooled version.

• Switch Icons – Provides left and right switch symbols that can be positioned as 
required in the track layout. Switches can be configured as either Merge, Diverge, or 
Merge-Diverge. Right-click on the symbol after it is positioned to identify the motor 
as a High-Payload version.

• Node Icon – Provides a node symbol that can be positioned as required in the track 
layout. After positioning the icon, the type of node must be specified. Right-click on 
the symbol after it is positioned to change the type of node.

Optional Track Layout File Elements

Additional graphic symbols are used to represent optional elements of the transport system in 
the Track Layout File. These elements can be defined to allow the Track Layout File to be sent 
to Rockwell Automation to create a Bill of Materials for the transport system.

For additional information and Track Layout definitions, see Track Layout Options on 
page 192.

Create and Save Track Layout Files
With the MagneMotion Configurator running (see Run the MagneMotion Configurator on 
page 26), create an initial Track Layout File. Save the new Track Layout File immediately so 
that there is a Track Layout File to work from.

Create a New Track Layout File

1. On the File menu, select New NDX Layout.

NOTE: Make sure that any open Track Layout has been saved before selecting New.

2. Define the layout of the transport system (see MM Lite Transport System Layout on 
page 41).

Save a New Track Layout File

1. On the File menu, select Save NDX Layout As....
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The Save As dialog box, see Figure 2-11, is displayed.

Figure 2-11: Save As Track Layout File Dialog

2. Browse to the appropriate location to save the file.

3. For File name, enter an appropriate descriptive name, and select Save. The extension 
for this file must be .ndx.

The Track Layout File is saved.

4. From the File menu select Exit.
• Select the X in the upper-right corner.
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Edit an Existing Track Layout File
With the MagneMotion Configurator running (see Run the MagneMotion Configurator on 
page 26), open an existing Track Layout File. Edit the existing Track Layout File as required 
and then save all changes.

1. On the File menu, select Open NDX Layout....

The Load Track Layout File dialog box, see Figure 2-12, is displayed.

Figure 2-12: Load Track Layout File Dialog

2. Use the dialog box controls to select the Track Layout File that was previously created 
and select Open.

The Track Layout File is loaded and the file name (track_layout.ndx) is displayed at 
the top of the System Layout Pane.

3. Edit the track layout as required to define the configuration of the transport system 
(see MM Lite Transport System Layout on page 41).

4. Save all changes to the file by selecting Save NDX Layout on the File menu.

5. From the File menu select Exit or select the X in the upper-right corner.

The Exit MagneMotion Configurator confirmation message, see Figure 2-13, is 
displayed.

Figure 2-13: Exit MagneMotion Configurator Confirmation Message

6. Select Yes on the message to exit (any unsaved work is lost).

The MagneMotion Configurator window closes.
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Node Controller Configuration File Overview
The Node Controller Configuration File is an XML file that defines the elements and 
parameters of the transport system. The MagneMotion Configurator provides a tool for 
editing this file, which eliminates the need to either view or edit the XML directly. The file 
can have any name for convenient reference, but it must always have the .xml extension.

If the Node Controller Configuration File is uploaded through Configuration Files, it is 
renamed node_configuration.xml. If the Node Controller Configuration File is uploaded to the 
node controller through Managed Configurations, the file name is unchanged. In both cases, 
the file name on the computer remains unchanged. See the MagneMotion Node Controller 
Interface User Manual, MMI-UM001.

See the physical layout drawings of the transport system to determine the components and 
their configuration in the transport system.

Required Node Controller Configuration File Elements

The categories in the Node Controller Configuration File represent the main elements of the 
transport system. These elements must be defined for the proper operation of the transport 
system (see Transport System Configuration on page 71).

• Global Settings – Basic parameters that control how all vehicles behave when moving 
through the transport system, how the transport system reacts to loss of 
communication, and startup conditions. These parameters are used as default values 
for all paths, motors, and nodes unless override values are defined for specific path, 
motor, or node elements.

• Paths – Software components that define the route that a vehicle travels. Paths include 
one or more LSM motors arranged end to end. All paths connect to one node at the 
beginning of the path. Paths must connect to a second node at the end of the path if 
vehicles are to travel from the end of the path onto another path. Paths are unique and 
do not overlap. See Create and Edit Path on page 87 for details.

• Motors – Hardware components that move the vehicle on the track, this component is 
a LSM motor. A motor is composed of a motor controller directing one or more 
drivers. See Define and Edit Motors and Vehicle Parameters on page 91 for details. 
Motors are listed under the path that they are associated with.
• All MagneMover Lite straight and curve motors have one driver internally, 

switch motors have two drivers internally. All control electronics for the 
MagneMover Lite motors are internal to the motor.

• All QuickStick motors have one driver internally. All control electronics for 
the QuickStick motors are internal to the motor.

• All QuickStick HT motors have one driver internally. All control electronics 
for the QSHT motors are external to the motor.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
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• Nodes – Software components that define the connections between paths. All paths 
have a node at the beginning of the path. Additional nodes provide junctions where 
two or more paths meet. Node types define their use, see Create and Edit Nodes on 
page 117 for details.

• Node Controllers – Hardware components that provide monitoring and control of the 
components of the transport system. One node controller is designated as the 
high-level controller (HLC), which provides communication between all node 
controllers in the transport system and the host controller. The upstream end of a path 
must communicate with a node controller. See Define and Edit Node Controllers on 
page 160 for details.

Optional Node Controller Configuration File Elements

Additional categories in the Node Controller Configuration File represent optional elements 
of the transport system. These categories can be defined to provide additional functionality.

• EtherNet/IP™ – Provides communication configuration if the host controller uses 
EtherNet/IP communication (typically an Allen-Bradley® ControlLogix® controller).

• HLC Control Group – Provides structuring of the transport system as a set of smaller 
transport systems (control groups) with separate high-level controllers and separate 
host controllers for each HLC Control Group.

• E-Stop – Provides monitoring of a digital input on the NC to halt all motion on the 
specified paths. Requires a node controller that supports digital I/O. E-Stops are listed 
on the path that they are associated with. this is equivalent functionality to sending a 
suspend command from the host and is not a safety function.

• Interlock – Provides monitoring of a digital input on the NC to halt all motion on the 
specified paths. Requires a node controller that supports digital I/O. Interlocks are 
listed on the path that they are associated with. this is equivalent functionality to 
sending a suspend command from the host and is not a safety function.

• Stations – Specific, designated positions on a path to send a vehicle. Display of 
stations must be enabled on the View menu. Configuration defined stations are for use 
only when host defined stations are not an option. It is recommended that stations are 
assigned and managed in the host controller rather than defined here.

• Single Vehicle Area – A unidirectional area of a path where only one vehicle is 
allowed to move at any time. These areas allow one vehicle to move uninhibited along 
a portion of a path without interfering with any other vehicles. Display of single 
vehicle areas must be enabled on the View menu.

• Simulated Vehicles – Used to define simulated vehicles for use in software 
configuration testing. Display of simulated vehicles must be enabled on the View 
menu.
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After creating the Node Controller Configuration File, upload the file to each node controller 
in the transport system. See Upload the Node Controller Configuration File on page 39 for 
more details.

Create and Save Node Controller Configuration Files
With the MagneMotion Configurator running (see Run the MagneMotion Configurator on 
page 26), create an initial Node Controller Configuration File. Save the new Node Controller 
Configuration File immediately so that there is a Configuration file to work from.

NOTE: After the Node Controller Configuration File is created, make sure that all 
parameters are configured before uploading it to the node controllers.

Create a New Node Controller Configuration File

1. On the File menu, select New XML Config.

The New Configuration confirmation message, see Figure 2-14, is displayed.

Figure 2-14: New Configuration Confirmation Message

2. Select Yes on the message to start a new configuration (any unsaved work is lost).

3. Define the configuration of the transport system (see Transport System Configuration 
on page 69).



Use the MagneMotion Configurator
Create and Save Node Controller Configuration Files

Rockwell Automation Publication MMI-UM046A-EN-P - May 2023 37

Save a New Node Controller Configuration File

1. On the File menu, select Save XML Config As....

The Save XML Configuration file dialog box, see Figure 2-15, is displayed.

Figure 2-15: Save XML Configuration File Dialog

2. Browse to the appropriate location to save the file.

3. For File name, enter an appropriate descriptive name, and select Save.

The Node Controller Configuration File is saved and the title of the Configurator 
window changes to MagneMotion Configurator – file_name.xml.

NOTE: If the Node Controller Configuration File is uploaded to the node controller 
through the Configuration Files page, it is renamed node_
configuration.xml. If the Node Controller Configuration File is uploaded to 
the node controller through the Managed Configurations page, the file 
name is not changed. In both cases, the file name on the PC remains 
unchanged.

4. Continue to edit the Node Controller Configuration File or exit the MagneMotion 
Configurator.

5. Select Exit on the File men or select the X in the upper-right corner.

The Exit MagneMotion Configurator confirmation message is displayed, see 
Figure 2-13.

6. Select Yes on the message to exit (any unsaved work is lost).
The MagneMotion Configurator window closes.
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Edit Existing Node Controller Configuration Files
With the MagneMotion Configurator running (see Run the MagneMotion Configurator on 
page 26), open an existing Node Controller Configuration File. Edit the Node Controller 
Configuration File as required and then save all changes.

1. On the File menu, select Open XML Config....

The Open XML Configuration File dialog box, see Figure 2-16, is displayed.

Figure 2-16: Open XML Configuration File Dialog

2. Use the dialog box controls to select the Node Controller Configuration File that was 
previously created and select Open.

The Node Controller Configuration File is loaded and the title of the Configurator 
window changes to MagneMotion Configurator – file_name.xml. The configuration 
information in the Node Controller Configuration File is available through the 
Configuration Tree on the left side of the window.

NOTE: If the Node Controller Configuration File contains any errors, when the file 
is opened an error message is displayed, see Figure 2-17. The error that is 
displayed in Figure 2-17 indicates that parameters were found in the XML 
that are not present in the Configurator. This can be true for obsolete 
parameters and can be disregarded if those parameters are not in use.
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Figure 2-17: Load Node Configuration – XML Read Error

3. Select OK to close the message.

4. Edit the file as required to define the configuration of the transport system (see 
Transport System Configuration on page 69).

5. Save all changes to the file by selecting Save XML Config on the File menu.

6. From the File menu select Exit or select the X in the upper-right corner.

The Exit MagneMotion Configurator confirmation message, see Figure 2-18, is 
displayed.

Figure 2-18: Exit MagneMotion Configurator Confirmation Message

7. Select Yes on the message to exit (any unsaved work is lost).

The MagneMotion Configurator window closes.

NOTE: The updated Node Controller Configuration File must be uploaded to all node 
controllers in the transport system (see Upload the Node Controller Configuration 
File on page 39).

Upload the Node Controller Configuration File
A Node Controller Configuration File for the specific configuration of the transport system 
must be uploaded to every node controller in the transport system using the node controller 
web interface (see the MagneMotion Node Controller Interface User Manual, publication 
MMI-UM001). If a Node Controller Configuration File for the transport system has not been 
created, see Create and Save Node Controller Configuration Files on page 36.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
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MM Lite Transport System Layout 3

Overview

NOTE: The Node Controller Configuration File defines the parameters of the transport 
system and is used by all node controllers in the transport system.

This chapter provides step-by-step procedures and examples for defining the Track Layout 
File (track_layout.ndx) for MagneMover® LITE™. The Track Layout File provides a 
graphical representation of the transport system. The Track Layout File can then be used to 
generate the Node Controller Configuration File. The graphical layout interface is available 
for the MagneMover LITE system only.

Included in this chapter are:

• Graphical Editing of the track layout.

• Required track layout elements, including:
• Motors and switches.
• Nodes.

• Optional track layout elements, including:
• Dimension lines.
• Text.
• Direction of forward motion.
• Legs.
• Sync option.
• Air Cooled option.
• High Payload option.
• Precision Locators.
• Vehicles.

• Generating files from the track layout, including:
• Node Controller Configuration File.
• PDF and bitmap graphic files.
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Track Layout
This section describes how to define the Track Layout File. The Track Layout File can be used 
to generate the Node Controller Configuration File (node_configuration.xml). The Track 
Layout File is created and edited using the System Layout Pane in the MagneMotion 
Configurator.

1. Run the MagneMotion Configurator. See Run the MagneMotion Configurator on 
page 26 for details.

2. Expand the System Layout Pane.

3. Open the Track Layout File (track_layout.ndx). See Edit an Existing Track Layout 
File on page 33 for details.

The selected Track Layout File is displayed in the System Layout Pane, see Figure 3-1.

Figure 3-1: System Layout Pane with Existing Track Layout

4. Create or edit the required features of the track layout.

A. Layout all motors and switches of the transport system as described in Place 
Motors and Switches on page 48.

B. Specify the location and type of nodes being used as described in Locate and 
Define the Nodes on page 52.
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5. Create or edit the optional features of the track layout.

A. Specify the motors that use the LSM Sync Option as described in Sync Motor 
Identification on page 49.

B. Specify the controllers and cables for the LSM Sync Option as described in 
Place Sync Controllers on page 50.

C. Specify Air Cooled Motor Identification on page 51.

D. Specify High Payload Switch Identification on page 52.

E. Show the location of the Precision Locators as described in Locate the 
Precision Locators on page 59.

F. Show the direction of forward motion as described in Identify Direction of 
Forward Motion on page 59.

G. Show the number and type of vehicles as described in Define Vehicles on 
page 60.

H. Show the location of Legs as described in Locate Legs on page 61.

I. Dimension the track layout as described in Dimension the Layout on page 63.

J. Add text to the track layout as described in Add Descriptive Text on page 64.

6. Generate files from the track layout as described in Generate Image Files on page 66.

7. Select Save NDX Layout for all changes on the File menu in the Configurator Menu 
Bar.

Editing the Track Layout

The track layout can be edited at any time.
• Any symbol can be selected and repositioned at any time by selecting it and dragging 

it to its new position. When repositioning motors, make sure that they snap into place.
• The properties for any symbol that has additional properties can be updated by 

right-clicking on the symbol to reopen their properties dialog box.

Editing Functions
There are several editing functions available through the Layout Toolbar. See Layout Toolbar on
page 190 for details on all editing functions.
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Graphical Editing
The System Layout Pane, see Figure 3-2, provides a method for graphically configuring the 
transport system layout. The pane is divided into three sections; the Layout Toolbar, Track 
Symbols Area, and the Layout Area.

Figure 3-2: MagneMotion Configurator – System Layout Pane

Track Symbols AreaLayout Toolbar Layout Area
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Global Settings

Select Global Settings from the Layout Toolbar to open the Global Layout Settings dialog to 
specify the type of motors and node controllers being used in the transport system layout.

These parameters are used to Automatically Create the Node Controller Configuration File on 
page 55. 

1. Select the appropriate motor type (Ethernet or Serial) for the MM Lite system. This 
helps ensure that the correct motor types are populated in the configuration file. 

2. Select NC Type for the node controllers used on the system. This helps ensure that the 
appropriate quantity of nodes are automatically assigned to each node controller.

Figure 3-3: MagneMotion Configurator – Global Layout Settings

Track Layout Guides

Track layout guides can be positioned in the Layout Area to aid in symbol positioning when 
creating a large track layout. All symbols snap to the guides when they get close to the guide.
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Figure 3-4: Layout Guides

• Guides can be positioned in the Layout Area by moving the cursor over one of the 
rulers, which causes it to change to the Resize cursor (  or ). Click-and-hold the left 
mouse button and drag the guide onto the Layout Area.

• Guides can be repositioned by placing the cursor over the guide, then click-and-hold 
the left mouse button and drag the guide to its new position.

• Guides can be deleted by selecting the guide (the guide changes color) and then 
pressing <Delete>.

Positioning Symbols

To locate a symbol in the Layout Area, use the scroll bars in the Track Symbols Area to 
display the symbols. To drag a symbol, position the cursor over it then click-and-hold the left 
mouse button and move the cursor with the symbol to the required location in the Layout 
Area. For track layout symbols (motors, switches, and nodes), a red box indicates the position 
where the symbols can join, see Figure 3-5. After the symbol is located appropriately, release 
the mouse button. 
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The background automatically expands to include the new symbol if necessary.

Figure 3-5: Track Layout – Snapping Symbol Into Position

If the symbol snaps into location in the wrong orientation, drag it away from all other symbols 
and rotate it by dragging the red handle that is displayed outside the shape. After a symbol is 
positioned, it cannot be rotated until it is ‘unsnapped’ from any other symbols.

Figure 3-6: Track Layout – Repositioning Symbol

Symbol Connection
Point
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Layout the Motors and Switches
This section describes how to define and place motors in the Layout Area. Motors are used to 
move the vehicles on the transport system. A motor must be defined in the Track Layout File 
for each motor in the transport system. See Define and Edit Motors and Vehicle Parameters 
on page 91 for descriptions of all motor and switch types.

Place Motors and Switches

1. Drag straight, curve, and switch LSM symbols from the Track Symbols Area into the 
Layout Area and position them as required. As the symbols are being positioned, they 
orient and ‘snap’ together at the vehicle transport positions. The background 
automatically expands to include the new symbol if necessary.

Figure 3-7: Track Layout – Place Motors

2. Select Save NDX Layout on the File menu in the Configurator Menu Bar to save all 
changes to the Track Layout File.
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Define the LSM Sync Option Motors

Identify curve and straight motors where synchronization of vehicle movement on the motor 
with an external mechanism for material processing or transfer is required. Synchronization is 
not required if vehicles are stopped at predefined stations for material processing or transfer.

NOTE: Identifying motors as using the LSM Sync option is for reference only and does not 
affect the track layout or any generated files. However, when this information is 
included, it can be used to help develop a Bill of Materials for the system if 
necessary.

Sync Motor Identification

1. Right-click on the motor that uses the Sync IT.

The Motor Type dialog is displayed, see Figure 3-8.

Figure 3-8: Define Motors Using the LSM Sync Option

2. Select Sync It in the Motor Type dialog and select OK.

The motor is labeled ‘Sync’.
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Place Sync Controllers

One Sync IT controller is required for every three motors that use the sync option.

NOTE: Defining Sync IT controllers is for reference only and does not affect the track 
layout or any generated files. However, when this information is included, it can be 
used to help develop a Bill of Materials for the system if necessary.

1. Drag the Sync Box symbol from the Track Symbols Area into the Layout Area and 
position it as required.

The Sync Cable Count dialog is displayed, see Figure 3-9.

Figure 3-9: Sync Cable Count Dialog Box

2. Select the quantity of cables running from the Sync IT controller to Sync motors in the 
dialog box and select OK.

NOTE: The quantity of cables can be changed at any time by right-clicking on the 
Sync Box symbol.

3. Select Save NDX Layout on the File menu in the Configurator Menu Bar to save all 
changes to the Track Layout File.
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Define the LSM Air Cooled Option Motors

Identify curve and straight motors where air cooling is required. Air cooling may be required 
for sections of track where vehicles are indexing quickly or with heavy payloads. All air 
cooled motors also have the LSM Sync option.

NOTE: Identifying motors as using the LSM Air Cooled option is for reference only and 
does not affect the track layout or any generated files. However, when this 
information is included, it can be used to help develop a Bill of Materials for the 
system if necessary.

Air Cooled Motor Identification

1. Right-click on the motor that uses the LSM Air Cooled option.
The Motor Type dialog is displayed, see Figure 3-10.

Figure 3-10: Define Motors Using the LSM Air Cooled Option

2. Select Air Cooled in the Motor Type dialog and select OK.
The motor is labeled ‘Sync AC’.

Define the LSM High Payload Option Switches

Identify the High Payload switches on the track. High Payload switches are required for 
systems using Wheeled Vehicles (single or tandem).
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NOTE: Identifying motors that use the LSM High Payload option is required to generate the 
correct configuration file, because the High Payload switches use a different motor 
type. When this information is included, it is also used to help develop a Bill of 
Materials for the system if necessary.

High Payload Switch Identification

1. Right-click on the switch that uses the LSM High Payload option.
The Switch Type dialog is displayed, see Figure 3-10.

Figure 3-11: Define Switches Using the LSM High Payload Option

2. Select High Payload Switch in the Switch Type dialog and select OK.
The switch is labeled ‘HP’.

Locate and Define the Nodes
Nodes are junctions that are defined as the beginning, end, or intersection of paths (strings of 
motors). A node must be defined in the Track Layout File for each path junction. Every path 
must begin at a node and those paths that connect to other paths must terminate at a node. See 
Create and Edit Nodes on page 117 for descriptions of available node types.
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Manual Node Placement

A node symbol must be placed at the beginning of each path and at the end of paths that 
require a node (such as a Terminus node) in the track layout.

1. Drag the node symbol onto the Layout Area and position it at the beginning or end of 
a path, see Figure 3-12.

Figure 3-12: Define Nodes

The Node Type Selection dialog box, see Figure 3-13, is displayed when the mouse 
button is released to position the node.
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Figure 3-13: Node Type Selection Dialog

2. Select the appropriate node from the Node Type Selection, see Figure 3-13.

3. For Serial motors, select the appropriate Port option, and select OK.

The letter in the node symbol is updated to show the node type. Port options are not 
required for Ethernet motors.

4. Select Save NDX Layout on the File menu in the Configurator Menu Bar to save all 
changes to the Track Layout File.

Automatically Place Nodes

Automatically places Merge, Diverge, Merge-Diverge, Simple, and Terminus nodes based on 
the manual placement of one Merge, Diverge, Relay, Simple, or upstream Terminus node (see 
Locate and Define the Nodes on page 52).

NOTE: Automatic placement of the nodes requires that all track components (motors and 
switches) are connected to each other, see Positioning Symbols on page 46.

1. Place a Merge, Diverge, Relay, Simple, or upstream Terminus node at the 
appropriate location in the track layout (see Locate and Define the Nodes on page 52).

NOTE: When using a Simple or Terminus node as the starting point for automatic 
node placement, they are assumed to be placed at the upstream end of the 
path. Any automatically placed Simple nodes are assumed to be at the start 
of a path. Any automatically placed Terminus nodes are assumed to be at the 
end of a path.
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2. Place all Relay nodes at the appropriate locations on the track if Relay nodes are 
desired. 

NOTE: Relay nodes are not automatically placed as they are not always required for 
the track layout. Manually placed Relay nodes are detected during automatic 
placement.

3. Select the Merge, Diverge, Relay, Simple, or upstream Terminus node (see the 
simplified representation in Figure 3-14).

Figure 3-14: Node Selected to Start Automatic Node Placement

4. Select Place the Nodes from the Layout Toolbar.

Merge, Diverge, Merge-Diverge, Simple, and Terminus nodes are automatically 
placed in the track layout based on the position of switches and path ends (see the 
simplified representation in Figure 3-15).

NOTE: Gateway nodes must be placed manually. Automatically assigned Terminus 
and Simple nodes can be manually assigned as Gateway nodes if desired.

Figure 3-15: Nodes Placed Automatically

5. Select Save NDX Layout on the File menu in the Configurator Menu Bar to save all 
changes to the Track Layout File.

Automatically Create the Node Controller Configuration File

A preliminary Node Controller Configuration File can be automatically generated from the 
completed track layout. After the Node Controller Configuration File is created, it must be 
reviewed to make sure the correct number and type of node controllers are being used. Check 
to make sure that the ports on the node controllers are assigned to the correct paths (if making 
changes to the node controllers) and any additional settings are defined.

NOTE: Automatic creation of the Node Controller Configuration File requires that all track 
components (motors and switches) are connected to each other, see Positioning 
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Symbols on page 46. Confirm that any High Payload switches are indicated to help 
ensure that proper motor types are used upon export.

Any components added to the track layout for reference only (SYNC IT controllers, 
Precision Locators, Forward Direction, Vehicles, Legs, Dimension Lines, and Text 
Boxes) are not added to the Node Controller Configuration File. However, when this 
information is included, it can be used to help develop a Bill of Materials for the 
system if necessary.

1. Make sure that no Node Controller Configuration File is open in the Configuration 
Tree (see Transport System Configuration on page 69).

NOTE: Any configuration information in the Configuration Tree is automatically 
deleted and replaced when the new Configuration is generated.

2. Select the beginning point of a path.
All Nodes Placed

A. In the track layout, make sure that all nodes are placed (see Locate and Define 
the Nodes on page 52).

B. Select either a Merge, Diverge, Simple, or Terminus node for the starting 
point for the automatic path generation (see the simplified representation in 
Figure 3-16).

NOTE: When using a Simple or Terminus node as the starting point for 
automatic configuration, they are assumed to be placed at the 
upstream end of the path.

Figure 3-16: Node Selected to Start Automatic Configuration

One Node Placed

A. Place a Merge, Diverge, Simple, or Terminus node at the appropriate location 
in the track layout (see Locate and Define the Nodes on page 52).

NOTE: When using a Simple or Terminus node as the starting point for 
automatic node placement and configuration, they are assumed to be 
placed at the upstream end of the path.
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B. Select the node (see the simplified representation in Figure 3-17).

Figure 3-17: Node Placed and Selected to Start Automatic Node Placement

3. Select Walk the Paths from the Layout Toolbar.

Any existing elements and settings in the Configuration Tree are cleared. Nodes (if 
starting with only one node) and path indicators are added to the track layout, see 
Figure 3-18. Paths with motors, nodes, and node controllers are added to the 
Configuration Tree.

Figure 3-18: Track Layout Showing Path Indicators

4. Select Save NDX Layout on the File menu in the Configurator Menu Bar to save all 
changes to the Track Layout File.

5. Save all changes to the Node Controller Configuration File by selecting Save XML 
Config on the File menu in the Configurator Menu Bar (see Create and Save Node 
Controller Configuration Files on page 36).
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6. See Edit Existing Node Controller Configuration Files on page 38 and Transport 
System Configuration on page 69 to edit the Node Controller Configuration File.

NOTE: Edit the Node Controller Configuration File through the Configuration Tree 
(see Transport System Configuration on page 69) to make sure that any 
automatically placed nodes are defined correctly. Also, verify the correct 
number and type of node controllers are being used and the ports on the node 
controllers are assigned correctly. Define any stations, single vehicle areas, 
simulated vehicles, E-Stops, and interlocks. Additionally, reference names 
can be assigned to paths, nodes, and node controllers.

Selecting a path in the Configuration Tree highlights the path in the Layout 
Area. Selecting a motor in the Configuration Tree highlights the motor in the 
Layout Area. Selecting a motor in the Layout Area highlights the motor in 
the Configuration Tree.

Clear Path Indications

If changes are made to the track layout, it is necessary to clear the path indicators that were 
previously added by Walking the Paths.

1. Select Clear Path Indicators from the Layout Toolbar.

The path indicators are removed from the track layout. Any information in the 
Configuration Tree (paths with motors, nodes, and node controllers, and so on) is not 
changed.

2. Select Save NDX Layout on the File menu in the Configurator Menu Bar to save all 
changes to the Track Layout File.

Figure 3-19: Clear Path Indicators



MM Lite Transport System Layout
Locate the Precision Locators

Rockwell Automation Publication MMI-UM046A-EN-P - May 2023 59

Identify Direction of Forward Motion
Use the Forward Direction symbol to provide a visual identification of the direction of 
forward movement after all motors and switches are positioned.

NOTE: Showing the direction of motion is for reference only and does not affect the track 
layout or any generated files. The actual direction of forward motion is determined 
by the placement of Merge, Diverge, Simple, or Terminus nodes.

1. Drag the Forward Direction symbol onto the Layout Area, position it next to a 
section of motors in the track layout, and rotate it by dragging the red handle, see 
Figure 3-20.

Figure 3-20: Identify Direction of Forward Motion

2. Select Save NDX Layout on the File menu in the Configurator Menu Bar to save all 
changes to the Track Layout File.

Locate the Precision Locators
This section describes how to define the Precision Locators in the Layout Area. The Precision 
Locator provides a method to secure a pallet that is mounted to an MM Lite vehicle to a 
specific location. The standard motor and rail configuration must be used when using this 
option.
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NOTE: Defining the Precision Locators is for reference only and does not affect the track 
layout or any generated files. However, when this information is included, it can be 
used to help develop a Bill of Materials for the system if necessary.

1. Drag the Precision Locator symbol onto the Layout Area and release the mouse 
buton.

Figure 3-21: Define Precision Locator Locations

The Precision Locator (pinning) device dialog box, see Figure 3-21, is displayed.

• Select Cancel to close the dialog box without changing the current selections. 
Select OK to accept any changes.

• In the section Device Selection, select 1-Up through 4-Up single or 1-up 
tandem vehicles to specify if the quantity of Precision Locators mounted to 
the same stand, the default is 1-Up.

• In the section Accessories, select Actuation Sensions to specify if the 
Precision Locator is supplied with actuation sensors, the default is No.
The Precision Locator is labeled ‘S’ if it is supplied with sensors.

• After the dialog box is closed, right-click on the Precision Locator to redisplay 
the dialog box.

2. Rotate and position the Precision Locator symbol as required.

3. Select Save NDX Layout on the File menu in the Configurator Menu Bar to save all 
changes to the Track Layout File.

Define Vehicles
This section describes how to define the vehicles in the Layout Area. Vehicles are the moving 
element in a transport system. The vehicle consists of a platform that carries the payload and a 
passive magnet array that interacts with the motors to provide the necessary propulsion and 
position sensing.
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NOTE: Identifying the quantity and type of vehicles is for reference only and does not affect 
the track layout or any generated files. However, when this information is included, 
it can be used to help develop a Bill of Materials for the system if necessary.

1. Drag the Vehicles symbol onto the Layout Area.

When the mouse button is released, the Vehicle Count dialog box, see Figure 3-22, is 
displayed.

2. Enter the Number of Vehicles/Kits and Vehicle Type that are required in the transport 
system, and select OK.

NOTE: Only one vehicle family (Glide, Wheeled, Precision Rail, Precision Locator) 
and only one vehicle type from that family (single, tandem) can be used at a 
time on a transport system. If using disjointed tracks, you can have multiple 
vehicle types in the track layout. Repeat Step 1 and Step 2 to add additional 
vehicles into the disjointed tracks.

Figure 3-22: Define Vehicle Type and Quantity

3. Select Save NDX Layout on the File menu in the Configurator Menu Bar to save all 
changes to the Track Layout File.

Locate Legs
This section describes how to define the locations for the Legs in the Layout Area. Legs 
should be located every two motor joints or 1.5 meters (4.92 ft), whichever is less 
(Figure 3-23 shows a typical leg installation for a small system). Use tighter leg spacing as 
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required by the system. Use spanning Legs that support multiple parallel motors where 
possible (see Figure 3-23) since they increase system stability.

NOTE: Defining Legs is for reference only and does not affect the track layout or any 
generated files. However, when this information is included, it can be used to help 
develop a Bill of Materials for the system if necessary.

1. Drag the Leg symbol onto the Layout Area. Position the symbol at the appropriate 
location in the track layout and rotate it by dragging the red handle.

Figure 3-23: Leg Type Dialogue Box

2. Right-click on the Leg and select the Leg Type that is needed at that location, see 
Figure 3-23.

3. Select Save NDX Layout on the File menu in the Configurator Menu Bar to save all 
changes to the Track Layout File.
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Dimension the Layout
This section describes how to dimension the track or other elements of the Layout Area.

NOTE: Dimensioning the transport system layout is for reference only and does not affect 
the track layout or any generated files.

1. Drag the Dimension Line symbol onto the Layout Area if dimensioning is required.

2. Drag the handle at each end of the line to position it (zoom in on the Layout Area to 
make sure that the handle is positioned correctly).

Figure 3-24: Dimensioning the Track Layout

3. Select Save NDX Layout on the File menu in the Configurator Menu Bar to save all 
changes to the Track Layout File.
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Add Descriptive Text
This section describes how to add and format text in the Layout Area.

NOTE: Adding descriptive text is for reference only and does not affect the track layout or 
any generated files.

1. Drag the Text Box symbol onto the Layout Area to add descriptive text. Position the 
Text Box at the appropriate location in the Layout Area and rotate it by dragging the 
red handle.

Figure 3-25: Adding Text to the Track Layout

2. Double-click the Text Box to enter or edit the text.
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3. Right-click on the Text Box to open the Text Style Editor, see Figure 3-26, and 
change the text properties as desired then select OK.

Figure 3-26: Text Style Editor

4. Select Save NDX Layout on the File menu in the Configurator Menu Bar to save all 
changes to the Track Layout File.



MM Lite Transport System Layout
Generate Image Files

66 Rockwell Automation Publication MMI-UM046A-EN-P - May 2023

Generate Image Files
Different images files can be created from the System Layout Pane. These include PDF 
(vector image), BMP (bit-mapped image), and graphic files.

NOTE: Select Toggle Grid Lines in the Layout Toolbar to remove the grid lines from the 
image before export if desired.

Create PDF Files

A PDF file of the graphical track layout can be created as a reference document. The PDF is 
Version 1.4 (compatible with Acrobat 5.x and later). The track layout image in the PDF is a 
vector image, which allows editing in applications such as Adobe® Illustrator.

1. Select Create PDF File using File > Export menu in the Configurator Menu Bar.

The PDF Exporter is displayed, see Figure 3-27.

Figure 3-27: PDF Exporter Dialog Box

2. Accept the defaults or change the options for the PDF file if desired and select Save To 
File....

The Save As dialog box is displayed.

3. Browse to the appropriate location to save the file.

4. For File name, enter an appropriate descriptive name, and select Save.

5. Close the PDF Exporter dialog box by selecting Close.
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Create Bitmap Image Files

A bitmap image file of the graphical track layout can be created for use in system 
documentation. The track layout image is saved in BMP format, which is a bit-mapped image. 
This format allows editing in applications such as Adobe® Photoshop.

1. Select Create Image File using File > Export menu in the Configurator Menu Bar.

The bitmap image is created and saved in the same folder as the Track Layout File and 
the alert, see Figure 3-28, is displayed.

Figure 3-28: BMP Creation Alert

2. Select OK to close the message.
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Transport System Configuration 4

Overview
This chapter provides step-by-step procedures and examples for manually defining or editing 
each section of the Node Controller Configuration File for transport systems using the 
MagneMotion® Configurator. The Node Controller Configuration File defines the parameters 
of the transport system and is used by all node controllers in the transport system. The Node 
Controller Configuration File is also used to create the Track File, which is used by the 
NCHost TCP Interface Utility to provide a graphical representation of the transport system to 
monitor the transport system.

NOTE: The Node Controller Configuration File must be uploaded to all node controllers in 
the transport system each time changes are made to it. 

Included in this chapter are:
• Configuration Tree overview.
• Advanced Parameters
• European Number Formatting
• View and Edit Functions, including:

• Copy, Add, and Delete Configuration Settings.
• Configuration settings, including:

• Global Settings.
• EtherNet/IP™.
• HLC Control Group.
• Nodes.
• Node Controllers.
• Paths, Motors, Stations, Single Vehicle Areas, Simulated Vehicles, E-Stops, 

and Interlocks.
• Optional configuration settings, including:

• Control Loop Parameters.
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Configuration Tree

The Configuration Tree that is displayed on the left side of the MagneMotion Configurator 
provides categories for each type of component in the transport system. Each category can be 
expanded to display the individual elements of that component type. The parameters for each 
element, and those categories that do not have elements, can be displayed on the right side of 
the Configurator by selecting the element, or category, in the Configuration Tree.

Table 4-1 provides an overview of the Configuration Tree and identifies those categories and 
elements that have Property pages that are associated with them. Options that are not currently 
supported are not listed in the table.

Table 4-1: Configuration Tree Overview

Configuration Tree Description Parameters Page
Node Configuration (Global Settings) Category Y 75

EtherNet/IP Category Y 78
HLC Control Group Category Y 80
Paths Category 87

Path n Element Y
Motors Category 91

Motor Defaults Element Y
Motor n Element Y

Stations Category 165
Station n Element Y

Single Vehicle Areas Category 169
Single Vehicle Area n Element Y

Simulated Vehicles Category 72
Simulated Vehicle n Element Y

Nodes Category 117
Node n Element Y

Node Controllers Category 160
Node Controller n Element Y

All Stations Category 168
Station n Element Y

NOTICE Fields containing invalid or improperly formatted values
are outlined in red. If you hover over an invalid field, the
error message appears. 
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Define Advanced Parameters

For all sections, the Advanced Parameters are only visible when the Advanced Parameters 
pane is expanded. To expand the Advanced Parameters pane, select the down arrow in the 
Advanced Parameters title bar. To collapse the Advanced Parameters, select the up arrow in 
the Advanced Parameters title bar.

NOTE: QuickStick® and QuickStick HT motor families use different Advanced Parameters 
than MM Lite™. The configurator only shows parameters that are available for the 
active system configuration.

1. Update the advanced parameter settings as required for the path (see Advanced 
Parameters on page 243 for detailed descriptions of all parameters).

2. To access the advanced motor settings, expand the Advanced Parameters dialogue 
box within the Configuration Properties Pane.

The Motor Details page that is displayed in the Configuration Settings Pane is 
updated with the advanced parameters, see Figure 4-1.

Figure 4-1: Example Motor Details Page with Advanced Parameters

3. Select Save XML Config on the File menu in the Configurator Menu Bar.
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European Number Formatting
This section describes how to show/hide European Number Formatting for the display and 
entry of numbers in all pages. 

The US number format uses a point as the decimal mark in a number and a comma as the 
delimiter between groups. The European number format uses a comma as the decimal mark in 
a number and a point as the delimiter between groups. See Figure 4-2 for examples of both 
number formats where the number displayed is one thousand.

Figure 4-2: Number Formatting Conventions

NOTE: The use of group separators is optional when using either style of number 
formatting.

Show European Number Formatting

1. Enable the European Number Formatting option by selecting the European 
Number Formatting option in the View menu in the Configurator Menu Bar.

A check mark is displayed before the European Number Formatting, see Figure 4-3, 
to indicate it is selected and all current values are reformatted, see Figure 4-2.

Figure 4-3: European Number Formatting Option Selected

1,000.00 1.000,00
US Formatting EU Formatting
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View and Edit Functions
There are several functions available through the View menu in the Configurator Menu Bar at 
the top of the MagneMotion Configurator window that can be selected at any time. See 
Configurator Menus on page 197 for available functions.

There are several editing functions available through the Edit menu in the Configurator Menu 
Bar at the top of the MagneMotion Configurator window. These functions are also available 
through the context-sensitive shortcut menus that are displayed by right-clicking on the 
categories and elements in the Configuration Tree.

Copy Configuration Settings

Configuration information can be copied from any element and pasted into another element of 
the same type. It is not necessary for the elements to be on the same path, but they must be in 
the same Node Controller Configuration File. The values of all parameters are copied. Motor 
configuration information can also be copied from the Motor Defaults, and pasted into any 
motor or the Motor Defaults on another path.

NOTE: When a copy operation is performed, the source element is preserved in the 
Configuration Tree.

Cutting configuration information copies the information from the selected element, 
temporarily stores it, and then deletes the element from the Configuration Tree. The 
stored information can then be pasted into the target element (the same as a copy 
operation).

If the copy operation creates a duplicate ID number (nodes, node controllers, stations) or if a 
duplicate ID number is manually entered, an alert similar to the one shown in Figure 4-4 is 
displayed. Change the ID number of the element to a number that is not being used.

Figure 4-4: Duplicate ID Alert

1. Expand the element list in the Configuration Tree by selecting the symbol in front of 
the category or double-clicking the category name.

The element list is expanded and displayed below the category in the Configuration 
Tree.
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2. Right-click on the element to be copied and select Copy... from the shortcut menu. Or, 
select the element to be copied and select Copy on the Edit menu in the Configurator 
Menu Bar.

The parameters of the selected element are copied to an internal clipboard.

3. Right-click on the element to be updated and select Paste... from the shortcut menu. 
Or, select the element to be updated and select Paste on the Edit menu in the 
Configurator Menu Bar.

The copied parameters are pasted from the internal clipboard into the selected 
element.

4. Select Save XML Config on the File menu in the Configurator Menu Bar to save all 
changes to the Node Controller Configuration File.

Add Configuration Elements

Additional elements can be added to any category in several ways. The typical method is to 
add the new element to the end of the list of existing elements by right-clicking on the 
category and selecting Add To End.... However, new elements can be added anywhere in the 
list of elements by right-clicking on an existing element and selecting either Insert Before... 
or Insert After....

1. Expand the element list in the Configuration Tree by selecting the symbol in front of 
the category or double-clicking the category name.

The element list is expanded and displayed below the category in the Configuration 
Tree.

Table 4-1: Menu Definitions and Short-cut Keys

Menu Action Short-cut
File New XML Config Ctrl+N

Open XML Config Ctrl+O

Save XML Config Ctrl+S

Edit Insert Before Ctrl+Shift+I

Insert After Ctrl+I

Add to End Ctrl+E

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Delete Del (Delete)
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2. Right-click on the element in the list where the insertion is going to be and select 
either Insert Before... or Insert After... from the shortcut menu. Or, select the element 
where the insertion is needed, then select either Insert Before... or Insert After... on 
the Edit menu in the Configurator Menu Bar.

A new, unconfigured, element is added to the element list before or after the selected 
element depending on the menu selection and numbered with the next available 
element number in the sequence for that element.

When a new motor is inserted, the motor list is automatically renumbered, and the 
path length is updated to include the new motor.

When a new station is inserted, the station list is renumbered.

3. Configure the new element as required.

4. Select Save XML Config on the File menu in the Configurator Menu Bar to save all 
changes to the Node Controller Configuration File.

Delete Configuration Elements

Extra elements can be deleted at any time by right-clicking on them in the Configuration Tree 
and selecting Delete.

1. Expand the element list in the Configuration Tree by selecting the symbol in front of 
the category or double-clicking the category name.

The element list is expanded and displayed below the category in the Configuration 
Tree.

2. Right-click on the element to be deleted and select Delete from the shortcut menu. Or, 
select the element to be deleted and select Delete on the Edit menu in the Configurator 
Menu Bar.

The selected element is deleted from the element list.

3. Select Save XML Config on the File menu in the Configurator Menu Bar to save all 
changes to the Node Controller Configuration File.

Configure Global Settings
This section describes how to set the Global Settings in the Node Controller Configuration 
File. Global Settings control how all vehicles behave when moving through the transport 
system, how the transport system reacts to loss of communication, and startup conditions. The 
Global Settings that are specified, are used for all paths, motors, and nodes throughout the 
system, unless override values are defined for specific path, motor, or node elements.
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1. In the Configuration Tree, select Global Settings.

The Global Settings page, see Figure 4-5…Figure 4-8, is displayed in the 
Configuration Settings Pane.

2. Update the global settings for the transport system as required (see Global Settings on 
page 201 for detailed descriptions of all parameters). 

3. To access the advanced global settings, expand the Advanced Parameters dialogue 
box within the Configuration Settings Pane.

The Global Settings page that is displayed in the Configuration Settings Pane is 
updated with the advanced parameters, see Figure 4-5…Figure 4-8.

4. Update the advanced global settings for the transport system as required (see Global 
Settings on page 201 for detailed descriptions of all parameters).

5. Select Save XML Config on the File menu in the Configurator Menu Bar.

Figure 4-5: Global Settings Page with Advanced Parameters (MM Lite™)
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Figure 4-6: Global Settings Page with Advanced Parameters (QuickStick)

Figure 4-7: Global Settings Page with Advanced Parameters (QSHT)
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Set EtherNet/IP Settings
This section describes how to set the EtherNet/IP settings in the Node Controller 
Configuration File. EtherNet/IP is only used when the host controller, typically a 
ControlLogix® controller, is communicating with the transport system using the EtherNet/IP 
interface. If TCP/IP is being used for communication between the host controller and the HLC 
for the transport system, do not enable or change the EtherNet/IP settings. See EtherNet/IP 
Settings on page 208 for parameter descriptions.

1. In the Configuration Tree, select EtherNet/IP.
The EtherNet/IP Settings page, see Figure 4-8, is displayed in the Configuration 
Settings Pane.

Figure 4-8: EtherNet/IP Host Controller Settings for MagneMover Lite
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Figure 4-9: EtherNet/IP Host Controller Settings for QuickStick

Figure 4-10: EtherNet/IP Host Controller Settings and Parameters for QuickStick HT
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2. Select Use an EtherNet/IP Controller for Host Control to enable the use of 
EtherNet/IP communications.

The EtherNet /IP™ Settings page shows the default settings.

3. Update the EtherNet/IP settings as required for the transport system (see EtherNet/IP 
Settings on page 208 for detailed descriptions of all parameters). See the 
MagneMotion Host Controller TCP/IP Communication Protocol User Manual, 
publication MMI-UM003 or the MagneMotion Host Controller EtherNet/IP 
Communication Protocol User Manual, publication MMI-UM004, for descriptions of 
the tag memory.

4. Select Save XML Config on the File menu in the Configurator Menu Bar.

Defining HLC Control Groups
This section describes how to configure the HLC Control Group in the Node Controller 
Configuration File. With large or complex transport systems, it is sometimes more practical or 
necessary to divide the system into smaller subsystems. These subsystems can be linked using 
an HLC Control Group (see Figure 4-84 on page 137). In order to maintain a single pool of 
vehicle IDs and maintain the vehicle ID as it travels between subsystems. Each of these 
systems has its own HLC and host controller. The primary function of the HLC Control Group 
is to manage the Vehicle ID across a transport system with multiple HLCs. These settings 
control how the HLCs are organized and how the Vehicle ID is tracked. When an HLC 
Control Group is used, Gateway nodes must be configured at path ends between subsystems 
to enable vehicles to pass freely within the HLC Control Group. 

To support an HLC Control Group, each subsystem must have one node controller that is 
configured as an HLC. Each subsystem has its own unique Node Controller Configuration 
File, which defines all components within that subsystem and the role of that subsystem's 
HLC within the HLC Control Group. 

The Node Controller Configuration File for the system acting as the Vehicle ID Server 
includes the IP addresses of the Vehicle ID Server HLC and each Vehicle ID Client HLC in 
the HLC Control Group. The Node Controller Configuration File for each Vehicle ID Client 
HLC contains only the role of the HLC as a client within the HLC Control Group.

After the roles are established, the Vehicle ID Server HLC is responsible for the overall 
management and tracking of the Vehicle ID throughout the entire transport system. During 
operation, the Vehicle ID Server HLC periodically exchanges messages with all Vehicle ID 
Client HLCs as part of the Vehicle ID management process. 

NOTE: There is a maximum of 64 node controllers per subsystem and a maximum of 16 
HLCs in an HLC Control Group.

NOTE: Gateway nodes can be used without an HLC Control Group to manage systems with 
higher Vehicle ID counts, see Gateway Nodes without and HLC Control Group.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um003_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um004_-en-p.pdf
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Configuring an HLC Control Group

1. In the Configuration Tree, select HLC Control Group.

The HLC Control Group Settings page is displayed in the Configuration Settings 
Pane..

Figure 4-11: HLC Control Group Settings Page

2. Select Enable HLC Control Group.
The HLC Control Group Settings page shows the default settings.

3. Update the HLC Control Group settings as required for the transport system (see HLC 
Control Group Settings on page 215 for detailed descriptions of all settings).

4. Select Save XML Config on the File menu in the Configurator Menu Bar.

Example

If the configuration of the transport system contains two HLCs (the same as the configuration 
shown for the Gateway node see Figure 4-84 on page 137), the Node Controller Configuration 
File for Subsystem 1 is configured as the Vehicle ID Server HLC, see Figure 4-12 upper 



Transport System Configuration
Defining HLC Control Groups

82 Rockwell Automation Publication MMI-UM046A-EN-P - May 2023

example. The Node Controller Configuration File for Subsystem 2 is configured as a Vehicle 
ID Client HLC, see Figure 4-12 lower example..

Figure 4-12: HLC Control Group Example

Gateway Nodes with an HLC Control Group

In transport systems that utilize an HLC Control Group to manage multiple subsystems, 
Gateway nodes are configured at the path ends that make the connection between subsystems. 
This enables the host controllers to pass vehicles freely between subsystems while 
maintaining the Vehicle ID assigned to the vehicles the last time the system started up or the 
vehicles entered the system. To send a vehicle between subsystems, a host controller orders 
the vehicle to a location past the Gateway node at the end of its local path. Node controllers in 
each subsystem control the handoff of vehicles between subsystems within the HLC Control 
Group to make sure that the Vehicle ID is preserved across the adjoining subsections. For a 
graphical description, see Figure 4-84 on page 137, Gateway node.

NOTE: There is a maximum of two Gateway nodes per node controller, one upstream and 
one downstream. The Gateway nodes do not need to be on the same path.

• The upstream Gateway node in a gateway pair has a corresponding 
downstream node on another node controller belonging to another subsystem 
of the HLC Control Group. 

• The downstream Gateway node in a gateway pair has a corresponding 
upstream node on another node controller belonging to another subsystem of 
the HLC Control Group.

HLC Control Group 1 (Master)

HLC Control Group 2 (Slave)
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Gateway Nodes without an HLC Control Group

It is possible to utilize Gateway nodes to send vehicles between HLCs without the use of an 
HLC Control Group. This results in the loss and reassignment of the Vehicle ID when driving 
between subsystems. This may be desirable for large systems where the total number of 
vehicles exceeds the Transport System Limits (see MagneMotion Node Controller Hardware 
User Manual, publication MMI-UM013) or generates too much load for the HLC to Host 
communication connection under a single HLC. 

To utilize this architecture, configure they Gateway nodes as shown in Figure 4-84 on 
page 137 and described in the example in Figure 4-86 on page 138. Do not enable the HLC 
Control Group.

NOTE: There is a maximum of two Gateway nodes per node controller, one upstream and 
one downstream. The Gateway nodes do not need to be on the same path.

• The upstream Gateway node in a gateway pair has a corresponding 
downstream node on another node controller belonging to another subsystem 
of the transport system. 

• The downstream Gateway node in a gateway pair has a corresponding 
upstream node on another node controller belonging to another subsystem of 
the transport system.

Vehicle ID Management

Depending on size, track layout, and configuration, transport systems often require several 
node controllers to manage system operation. One node controller in the transport system 
must also be configured to operate as the HLC. The HLC is an application responsible for 
facilitating communication between the host controller and all other node controllers in the 
system. When using an HLC Control Group, the HLC along with all node controllers it 
communicates with are referred to as a subsystem of an HLC Control Group.

In addition to operating as a communications server, the HLC manages the assignment of 
unique Vehicle ID numbers for all vehicles in the system. The HLC assigns a Vehicle ID to 
vehicles when the transport system first starts up and whenever a vehicle enters the system via 
a Terminus node. An assigned Vehicle ID is maintained from the time a Vehicle ID is 
assigned, until one of the following occurs:

• The vehicle leaves the system.
• The path where the vehicle is located is reset.
• The host controller issues a Delete Vehicle command.

To make sure that the vehicle identification across the HLC Control Groups are unique, the 
Vehicle ID Server HLC must know the status of all vehicles in the system. The Vehicle ID 
Server HLC does not allocate a Vehicle ID until every Vehicle ID Client HLC in the system 
has reported the Vehicle ID for all vehicles under its local control. As the Vehicle ID Client 

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
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HLCs report vehicle information to the Vehicle ID Server HLC, the server updates the Vehicle 
ID status. When the Vehicle ID Server HLC has received information from every Vehicle ID 
Client HLC, each Vehicle ID is placed in one of the following states:

• Active - An HLC reports that a vehicle is already active on the system.
• Allocated - A Vehicle Client HLC reports that a Vehicle ID from an earlier 

Vehicle ID server run has been assigned, or it is available to be allocated by 
that HLC to a newly discovered vehicle (for example, during path start up).

• Available - The Vehicle ID is available to be allocated when an HLC requests 
additional vehicle identification numbers.

When an HLC starts up, other HLCs in the HLC Control Group can be in any state. During 
start up, each Vehicle ID Client HLC reports a list of all active Vehicle ID numbers to the 
Vehicle ID Server HLC. 

During operation, the Vehicle ID Client HLCs periodically request additional blocks of 
available vehicle identification numbers from the Vehicle ID Server HLC to assign to newly 
discovered vehicles. At any given time, each Vehicle ID Client HLC attempts to maintain a 
pool of at least 100 vehicle identification numbers to assign to newly discovered vehicles.

Vehicle ID Range Minimum and Maximum

When an HLC Control Group is configured, set the vehicle range defaults to: 
• minimum equals 1 
• maximum equals 65535 

Do not change these values from the defaults.

Terminus Node Vehicle ID Assignment

If Terminus nodes are used to bring vehicles into a subsystem of a HLC Control Group, all 
entry requests must use a Vehicle ID of zero. This allows the HLC of the subsystem to assign 
the Vehicle ID of the new vehicle, which helps prevent a duplicate Vehicle ID from existing 
within the HLC Control Group. The host controller can determine the assigned Vehicle ID by 
examining the node status for that Terminus node. 

Startup Considerations

The startup process for the HLC in each subsystem is independent and does not assume the 
operational state of the HLC in any other subsystem of the HLC Control Group. There are two 
start up cases, a Vehicle ID Server HLC start and a Vehicle ID Client HLC start.
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Vehicle ID Server HLC Start or Restart

The following conditions must be met for 10 seconds before the Vehicle ID Server HLC 
comes out of its initialization state and is available to allocate any Vehicle ID numbers. During 
those 10 seconds, information about previously active or allocated Vehicle ID numbers are 
reported to the Vehicle ID Server HLC.

• All Vehicle ID Client HLCs under the control of the Vehicle ID Server HLC 
must communicate with the Vehicle ID Server HLC and be in the operational 
state.

• All node controllers in the subsystem are in an operational state, which 
indicates all motors under their control have been successfully configured.

Vehicle ID Client HLC Start or Restart

If the system is operational and a Vehicle ID Client HLC is reset, the rest of the system 
continues to run. Restarting a Vehicle ID Client HLC causes the HLC to clear all vehicle 
records. The Vehicle ID Client HLC must report vehicle information to the Vehicle ID Server 
HLC before restarting to recover the Vehicle ID numbers in use. After restart, the Vehicle ID 
Client HLC reports the restart to the Vehicle ID Server HLC, which redelivers the Vehicle ID 
numbers that were allocated before the restart. The Vehicle ID Client HLC then assigns 
identifications to all active vehicles. The Vehicle ID that was assigned to a specific vehicle 
before the restart may not be reassigned to that same vehicle.

Cautions 

System Startup

During transport system startup, the Vehicle ID Server HLC remains in the initialization state 
for 10 seconds after all Vehicle ID Client HLCs are in the operational state. During this time 
Vehicle ID Client HLCs report allocated Vehicle ID status to the Vehicle ID Server.

If a client HLC is stuck in the initialization state, it cannot report its allocated Vehicle ID 
status to the server HLC. In this case, the server HLC remains in the initialization state.

When the Vehicle ID Server HLC is stuck in the initialization state, client HLCs can fail a path 
startup attempt if those clients HLCs have not been allocated vehicle identifications to use 
during startup. In this case, the startup process times out and fails. A log message is placed in 
the log for the client HLC stating that there are no vehicle records available.
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View Paths Table
Selecting Paths from the Configuration Tree displays a table of information about all paths 
that are defined in the configuration, see Figure 4-13 on page 86. The table provides a view 
only overview for the defined paths. There are links to the associated components for an 
alternate navigation through the file. The following information is defined for each path:

• Path ID: Unique ID number of the path. Click the Path ID to view the path 
parameters page.

• Path Length: Length of the path in meters.
• Upstream Node: The Node ID of the node at the upstream end of the path or 

"Not set" if a node has not been associated with the path end. Hover over the 
node to see the node type, see Figure 4-14 on page 87. Click the Upstream 
Node to view the node parameters page.

• Upstream Node: The Node ID of the node at the downstream of the path or 
"Not set" if a node has not been associated with the path end. Hover over the 
node to see the node type. Click the Downstream Node to view the node 
parameters page.

• Owning NC: The Node Controller ID of the node controller that owns the 
Upstream Node or "Not set" if the node is not owned by a node controller. 
Hover over the node controller to see the IP address of the node controller. 
Click the Owning NC to view the node controller parameters page.

Figure 4-13: Paths Table
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Figure 4-14: Paths Table - Link to Upstream Node Example

Create and Edit Path
This section describes how to create and edit paths in the Node Controller Configuration File. 
The beginning of a path is the zero point for vehicle positioning on that path and must 
originate at a node. The end of a path must terminate in a node if vehicles are going to move 
beyond the end of the path.

Typically, vehicles enter a path on the upstream end, and exit on the downstream end (this 
represents motion in the default forward direction). The motor at the upstream end of a path 
must communicate with a node controller. The downstream end of a path must communicate 
with a node controller if vehicles are going to move beyond that end of the path. See 
Figure 4-15 for an overview of a path and the nodes and motors that are associated with it.
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NOTE: There is a maximum of two nodes per path. Each path must have one node defined at 
the upstream end, all nodes must be associated with a node controller. The maximum 
quantity of nodes associated with a node controller is node controller-dependent, see 
MagneMotion Node Controller Hardware User Manual, publication MMI-UM013.

Paths must be defined before motors can be defined.

Figure 4-15: Path Overview

Create a Path

Each path in the transport system must be defined.

NOTE: The maximum quantity of paths is system-dependent, see MagneMotion Node 
Controller Hardware User Manual, publication MMI-UM013.

1. In the Configuration Tree, select Paths, see Figure 4-16.

Figure 4-16: Configuration Tree with Paths Selected

2. On the Edit menu in the Configurator Menu Bar, select Add To End... (or right-click 
on Paths and select Add To End...).

NOTE: Right-click on an existing path to open the Edit shortcut menu to insert the 
new path before or after the selected path.

Node at
Beginning

of Path

Upstream End
of Path

Guideway Downstream End
of Path

Forward Motion
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https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
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The list of paths is expanded and displayed below Paths in the Configuration Tree, see 
Figure 4-17 with the new path added to the list. The path is automatically numbered 
with the next available Path ID.

Figure 4-17: Configuration Tree Showing Path Added

Edit a Path

1. Expand the list of paths in the Configuration Tree by selecting the symbol in front of 
Paths or double-clicking Paths.

The list of paths is expanded and displayed below Paths in the Configuration Tree.

2. Open the path to be edited by selecting the Path ID.

The selected path is highlighted and the Path Details page, see Figure 4-18, is 
displayed in the Configuration Settings Pane.

Figure 4-18: Path Parameters Page

3. Update the path parameters as required (see Paths on page 217 for detailed 
descriptions of all parameters).

4. To access the advanced path parameters, expand the Advanced Parameters panel 
within the Configuration Settings Pane.
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The Path Details page that is displayed in the Configuration Settings Pane is updated 
with the advanced parameters, see Figure 4-19.

Figure 4-19: Path Parameters Page with Advanced Parameters

5. Update the advanced parameters for the path as required (see Paths on page 217 for 
detailed descriptions of all parameters).

6. Select Save XML Config on the File menu in the Configurator Menu Bar.
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Define and Edit Motors and Vehicle Parameters
This section describes how to define and edit motors in the Node Controller Configuration 
File. Motors are used to move the vehicles on the transport system. A motor must be defined 
in the Node Controller Configuration File for each motor in the transport system. All 
MagneMover Lite straight and curve motor modules have one motor, switch modules have 
two motors (one curve and one straight).

View or Edit Motor Defaults and Parameters

The default motor parameters for a path define the initial parameter values that are applied to 
all motors as they are added to a path. Change the motor parameters that apply to all motors in 
the Motor Defaults section. After motors are added to a path, changes to the Motor Defaults 
for that path are reflected in the parameters for all motors.

NOTE: Any parameter that has been changed for a specific motor is not affected if changes 
are made to the Motor Defaults.

Defaults are automatically added when you add the first motor. Any updates to the 
Motor Defaults must be completed through the parameter pages.

Unless the motor is different than the type of motor that is specified in the Motor 
Defaults, or the motor type is being used in a special way, there is no need to change 
the configuration from the assigned defaults.

1. Expand the list of paths in the Configuration Tree by selecting the symbol in front of 
Paths or double-clicking Paths.
The list of paths is expanded and displayed below Paths in the Configuration Tree.

2. Expand the path where the motors are located by selecting the symbol in front of the 
Path ID or double-clicking the Path ID.
The selected path is highlighted and expands to show Motors, Stations, and other 
items related to that path.

3. Expand the motors section by selecting the symbol in front of Motors or 
double-clicking Motors.
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The list of motors is expanded to show the Motor Defaults, and any configured motors, 
see Figure 4-20.

Figure 4-20: Configuration Tree Expanded with Motors Selected

4. Select Motor Defaults, see Figure 4-21.

The Motor Defaults page, see Figure 4-22, is displayed in the Configuration Settings 
Pane. This page identifies the path that the motor defaults are associated with at the 
top of the page. The defaults that are shown are applied to all motors when they are 
initially defined in the path indicated.

Figure 4-21: Configuration Tree Expanded with Motor Defaults Selected

Figure 4-22: Motor Defaults Page - MagneMover Lite
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Figure 4-23: Motor Defaults Page - QuickStick 100
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Figure 4-24: Motor Defaults Page - QuickStick HT
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5. Update the default motor parameters as required for the transport system (see Motors 
on page 220 for detailed descriptions of all parameters).
• To define the vehicles, magnet arrays, motors, and vehicle motion parameters 

that are used on the path, see Vehicle and Motor Parameters on page 227.
• Update the parameters that are related to the Control Loops, including the PID 

settings and the PID integrator, as required (see Control Loop Parameters on 
page 241 for detailed descriptions of all parameters).

• To access the advanced motor parameters, expand the Advanced Parameters 
dialogue box within the Configuration Settings Page. Update the advanced 
parameters for the motor as required (see Table 5-8 on page 243 for detailed 
descriptions of all parameters).

• Update the parameters that are related to Keepout Areas as required (see 
Keepout Area Parameters on page 247 for detailed descriptions of all 
parameters).

6. Select Save XML Config on the File menu in the Configurator Menu Bar.

Define Vehicle Defaults for MM Lite™

The vehicle parameters in the Motor Defaults for a path define the vehicle and the magnet 
array that is used on the path. These parameters are applied to all motors as they are added to 
the path. Typically, all paths in the transport system use the same vehicle.

NOTE: The vehicle parameters, except for vehicle length, are not available on the individual 
motor pages because the vehicle definition must be the same for the entire path.

1. For MagneMover Lite, the magnet array type must be ML_Halbach and the magnet 
array length must be 1 cycle, 3 poles. To convert cycles to millimeters use the 
following formula.

High flux magnet array: MagnetArrayLength = (Cycles x 54.5) + 7.7 mm

2. From the Number of Bogies drop-down list, select the quantity of magnet arrays on 
the vehicle. Use 1 bogie for single arrays, or 2 bogies for tandem arrays.

3. Update the vehicle settings for the transport system (see Vehicle and Motor 
Parameters on page 227 for detailed descriptions of all parameters) by selecting the 
vehicle type from the Vehicle shape drop-down list.

A. When the vehicle shape is set to Linear, configure the Vehicle Length and the 
Magnet Array Center Offset.
NOTE: The Vehicle Length is used to calculate the amount of space that is 

required between vehicles. To make sure that vehicles do not contact 
each other while moving, the vehicle length in the configuration must 
be based on the longest dimension of the vehicle, see Figure 4-25.
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Figure 4-25: Vehicle Length in Curves

• In the Magnet Array Center Offset field, enter the distance from the physical 
center of the vehicle to the physical center of the magnet array.

• For a vehicle with a standard payload that is centered on either a single 
vehicle or a tandem vehicle this distance is zero. 

• For a vehicle with a non-standard payload that the vehicle can support 
without tipping, see Figure 4-26, this distance is the offset from the 
center of the vehicle to the center of the magnet array. 

• When a tandem vehicle is being used, this is the distance from the 
center of the vehicle to the mid-point between the two magnet arrays. A 
positive value specifies the magnet array is downstream from the center 
of the vehicle (that is, at the vehicle front). A negative value specifies 
the magnet array is upstream from the center of the vehicle (that is, at 
the vehicle rear).

• If the payload is large enough to cause the vehicle to tip, a second 
vehicle without a magnet array can be added to the vehicle to provide 
additional support for the vehicle, see Figure 4-27 and Figure 4-28. 

• When adding a second vehicle to the vehicle, both vehicles must be the 
same style and be connected to the vehicle through pivots to allow each 
vehicle to rotate independently under the vehicle while moving through 
curves.

NOTE: Make sure that the supporting vehicle does not have a magnet array.

Curve MM Motor

Straight MM MotorVehicle

Actual Vehicle
Virtual Vehicle
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Figure 4-26: Magnet Array Center Offset, Single Vehicles

Figure 4-27: Magnet Array Center Offset, Two Single Vehicles

Figure 4-28: Magnet Array Center Offset, Two Tandem Vehicles

MagnetVehicle

Magnet Array

TandemVehicle

Magnet Array
Center Offset

Array
CenterCenterArray

Center

Center Offset

Center

MagnetVehicle

Magnet Array
Center Offset

Array
CenterCenter

Magnet ArrayNo Magnet Array

TandemVehicle

Magnet Array
Center Offset

Array
CenterCenter

Magnet ArraysNo Magnet Arrays



Transport System Configuration
Define and Edit Motors and Vehicle Parameters

98 Rockwell Automation Publication MMI-UM046A-EN-P - May 2023

B. When the vehicle shape is set to Rectangular, configure the following items 
(see Figure 4-29 for definition of terms).

Figure 4-29: Rectangular Vehicle Sizing

• In the Fore Length field, enter the distance from the center of the magnet array 
to the front of the vehicle and any additional overhang that is attributed to the 
payload the vehicle is transporting.

• In the Aft Length field, enter the distance from the center of the magnet array 
to the back of the vehicle and any additional overhang that is attributed to the 
payload the vehicle is transporting.

• In the Starboard Width field, enter the distance from the center of the magnet 
array to the right side of the vehicle and any additional overhang that is 
attributed to the payload the vehicle is transporting.

If the value entered is larger than the radius of a curve motor, the Configurator 
displays a warning similar to Figure 4-30. This notice is displayed as a 
reminder to verify the spacing of parallel paths to make sure that vehicles do 
not collide.

Figure 4-30: Vehicle Width Warning Alert
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• In the Port Width field, enter the distance from the center of the magnet array 
to the left side of the vehicle and any additional overhang that is attributed to 
the payload the vehicle is transporting.

If the value entered is larger than the radius of a curve motor, the Configurator 
displays a warning similar to the one that is shown in Figure 4-30. 

4. Select Save XML Config on the File menu in the Configurator Menu Bar.

Define Vehicle Defaults for QuickStick and QSHT

The vehicle parameters in the Motor Defaults for a path define the vehicle and the magnet 
arrays as they are added to the path. Typically, all paths in the transport system use the same 
vehicle.

NOTE: The vehicle parameters, except for vehicle length, are not available on the individual 
motor pages because the vehicle definition must be the same for the entire path.

1. Update the vehicle magnet array settings as required for the transport system (see 
Vehicle and Motor Parameters on page 227 for detailed descriptions of all 
parameters).

2. From the Magnet Array Length drop-down list, select the length of the magnet array 
that is attached to the vehicles (the default is 3 cycle, 7 poles). The length is described 
in cycles – to convert to millimeters use the following formula. 
QuickStick: Standard magnet array: MagnetArrayLength = (Cycles x 48)
QuickStick HT: High flux magnet array: MagnetArrayLength = (Cycles x 120)-2 mm

Figure 4-31: Vehicle and Magnet Array Length

3. In the Vehicle Length field, enter the length of the vehicle. Included in the vehicle 
length should be any corrections for vehicle geometry and any additional overhang 
that is attributed to the payload the vehicle is transporting.

If the track has curves in it, the vehicle length should be configured so that it is 
equal to the longest dimension of the vehicle. This helps prevent vehicles from 
hitting each other when moving through curves (see to Figure 4-32).
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NOTE: Only the Vehicle Length is used to calculate the amount of space required 
between vehicles. To help ensure that vehicles do not contact each other 
while moving, the Vehicle Length in the configuration should be based on 
the vehicle’s longest dimension.

Figure 4-32: Vehicle Length in Curves

4. From the Number of Bogies drop-down list, choose the quantity of bogies. Single 
bogie vehicles contain one fixed magnet array. Double bogie vehicles contain two 
magnet arrays. Typically each magnet array is fixed to a pivoting vehicle section with 
a linkage that connects those vehicles to each other. Double bogies are used to provide 
additional thrust or movement of larger loads.

NOTE: If the quantity of bogies chosen = 2, the Propulsion Array Offset, Gap 
Between Bogies, and Interbogie Position Correction also need to be set. 
See Vehicle and Motor Parameters on page 227 for parameter descriptions.

5. Select Save XML Config on the File menu in the Configurator Menu Bar.
See Define Motor Defaults on page 100 for additional configuration information.

Define Motor Defaults

The motor parameters in the Motor Defaults for a path define the default motor parameters 
that are applied to all motors as they are added to the path. After a motor is added, the settings 
for that specific motor can be edited as required.

NOTE: The parameters for specific motors can be updated as required after the individual 
motors are added.
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Figure 4-33: Motor Types MM Lite

Figure 4-34: Motor Types QuickStick
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Figure 4-35: Motor Types QSHT

1. Update the motor default settings as required for the path (see Vehicle and Motor 
Parameters on page 227 for detailed descriptions of all parameters).

2. From the Motor Type drop-down list, select the motor type that is most common on 
this path (see Figure 4-33). The Motor Defaults automatically populate.

Table 4-2: Motor Types

Motor Type Description

MagneMover Lite Motors see Figure 4-33 on page 101

ML_G4_1000
ML_G4_ENET_1000

A 1m (one meter) MM Lite motor.

ML_G4_250
ML_G4_ENET_250

A 0.25 m (quarter meter) MM Lite motor.

ML_G4_CURVE_LEFT
ML_G4_ENET_CURVE_LEFT

A 90° Curve MM Lite motor. A 
“left” curve indicates that when 
traveling in the forward direction 
along the path, this curve creates a 
left turn.

ML_G4_CURVE_RIGHT
ML_G4_ENET_CURVE_RIGHT

A 90° Curve MM Lite motor. A 
“right” curve indicates that when 
traveling in the forward direction 
along the path, this curve creates a 
right turn.

QSHT Motor 1 m 

QSHT Dual Motor 0.5 m 

QSHT Motor 0.5 m

QSHT Double-wide Motor 0.5 m 
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ML_G4_SWITCH_CURVE_LEFT
ML_G4_ENET_SWITCH_CURVE_LEFT
ML_G4_ENET_HIGH_PAYLOAD_
SWITCH_CURVE_LEFT

A Left Switch MM Lite motor. MM 
Lite switch motors can be treated as a 
curve motor and a quarter meter 
motor overlaid. The curve part of the 
switch is defined on one path, while 
the quarter meter part of the switch is 
defined on another path. The “Switch 
Curve Left” should be defined on the 
path where a curved part of a Left 
Switch is present. A way to 
distinguish between Left Switches 
and Right Switches is the curve part 
of a Left Switch diverts to the left.

ML_G4_SWITCH_250_LEFT
ML_G4_ENET_SWITCH_250_LEFT
ML_G4_ENET_HIGH_PAYLOAD_
SWITCH_250_LEFT

A Left Switch MM Lite motor. MM 
Lite switch motors can be treated as a 
curve motor and a quarter meter 
motor overlaid. The curve part of the 
switch is defined on one path, while 
the quarter meter part of the switch is 
defined on another path. The “Switch 
250 Left” should be defined on the 
path where a quarter meter part of a 
Left Switch is present. A way to 
distinguish between Left Switches 
and Right Switches is the curve part 
of a Left Switch diverts to the left.

ML_G4_SWITCH_CURVE_RIGHT
ML_G4_ENET_SWITCH_CURVE_
RIGHT
ML_G4_ENET_HIGH_PAYLOAD_
SWITCH_CURVE_RIGHT

A Right Switch MM Lite motor. MM 
Lite switch motors can be treated as a 
curve motor and a quarter meter 
motor overlaid. The curve part of the 
switch is defined on one path, while 
the quarter meter part of the switch is 
defined on another path. The “Switch 
Curve Right” should be defined on 
the path where a curved part of a 
Right Switch is present. A way to 
distinguish between Right Switches 
and Left Switches is the curve part of 
a Right Switch diverts to the right.

Table 4-2: Motor Types (Continued)

Motor Type Description
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ML_G4_SWITCH_250_RIGHT
ML_G4_ENET_SWITCH_250_RIGHT
ML_G4_ENET_HIGH_PAYLOAD_
SWITCH_250_RIGHT

A Right Switch MM Lite motor. MM 
Lite switch motors can be treated as a 
curve motor and a quarter meter 
motor overlaid. The curve part of the 
switch is defined on one path, while 
the quarter meter part of the switch is 
defined on another path. The “Switch 
250 Right” should be defined on the 
path where a quarter meter part of a 
Right Switch is present. A way to 
distinguish between Left Switches 
and Right Switches is the curve part 
of a Right Switch diverts to the right.

QuickStick Motors see Figure 4-34 on page 101

QS_G2_100
QS_G2_100_PLUS

1 m QuickStick 100 A linear synchronous motor

QS_150_1000 1 m QuickStick 150 linear synchronous motor

QS_G2_100_HALF
QS_G2_100_PLUS_HALF

0.5 m QuickStick 100 A linear synchronous motor

QS_150_500 0.5 m QuickStick 150 linear synchronous motor

QS_150_300 0.3 m QuickStick 150 linear synchronous motor

QuickStick HT Motors see Figure 4-35 on page 102

QS_G2_HT 1 m QuickStick High Thrust linear synchronous motor 
(standard and submersible). One motor that is connected to 
one QSMC motor controller.

QS_G2_HT_5700 1 m QuickStick High Thrust linear synchronous motor 
(standard and submersible). One motor that is connected to 
one QuickStick HT 5700 Inverter.

QS_G2_HT_HALF 0.5 m QuickStick High Thrust linear synchronous motor 
(standard and submersible). One motor that is connected to 
one QSMC-2 motor controller.

QS_G2_HT_5700_HALF 0.5 m QuickStick High Thrust linear synchronous motor 
(standard and submersible). One motor that is connected to 
one QuickStick HT 5700 Inverter.

Table 4-2: Motor Types (Continued)

Motor Type Description
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3. Select Save XML Config on the File menu in the Configurator Menu Bar.

Define Downstream Gaps for QuickStick and QSHT

QuickStick and QuickStick HT systems use the Downstream Gap motor parameter to define 
the physical space between motors. This is used by the collision avoidance system to confirm 
that vehicles do not collide over the motor gaps. The Downstream Gap #1 and Downstream 
Gap #2 parameters are used to enter the downstream gaps of different motor types, see 
Figure 4-36. 

QS_G2_HT_DUAL_HALF Two 0.5 m QuickStick High Thrust linear synchronous 
motors (standard and submersible). Two contiguous motors 
that are connected to one QSMC-2 motor controller.

QS_G2_HT_5700_DUAL_HALF Two 0.5 m QuickStick High Thrust linear synchronous 
motors (standard and submersible). Two contiguous motors 
that are connected to one QuickStick HT 5700 Inverter.

QS_G2_HT_HALF_DW 0.5 m QuickStick High Thrust double wide linear 
synchronous motor (standard and submersible). One motor 
that is connected to one QSMC motor controller.

QS_G2_HT_5700_DW 0.5 m QuickStick High Thrust double wide linear 
synchronous motor (standard and submersible). One motor 
that is connected to one QuickStick HT 5700 Inverter.

Table 4-2: Motor Types (Continued)

Motor Type Description
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Figure 4-36: QuickStick Gap Definitions for Downstream Gap #1 and Downstream Gap #2

When entering the downstream gaps, use the measured distance between the motor casings. 
The internal gaps are added by the Configurator automatically based on the defined motor 
types. See Internal Motor Gaps on page 159 for more information.

The Node Controller Web Interface can be used to detect precise motor gaps in a running 
QuickStick or QSHT system. It is advised to include the gap errors that are detected as the 
level of precision that is provided by the Web Interface can improve vehicle motion across 
gaps. See the MagneMotion Node Controller Interface User Manual, publication 
MMI-UM001 Motor Gap Information section for details on how to access the Motor Gap 
Information page.
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https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
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Downstream Gap Error Adjustment

To input the gap errors for a Downstream Gaps:

1. Create and upload the complete Node Configuration File for the system layout using 
the physical measured gaps for all Downstream Gaps in the system.

2. Command a vehicle to drive over all motor gaps in the system.

3. See the MagneMotion Node Controller Interface User Manual, publication 
MMI-UM001 Motor Gap Information section, to obtain the detected Gap Errors.
The Motor Gap Information page is shown in Figure 4-37.

Figure 4-37: Node Controller Web Interface - Motor Gap Information Page

4. From any motor page, select the Input Gap Errors button on the top-right, see 
Figure 4-38.
The Downstream Gap Error Adjustment window that is shown in Figure 4-39 appears. 
The Downstream Gaps for all motors on the path are displayed. 

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
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Figure 4-38: Motor Page - Input Gap Errors

5. Input the Gap Errors from the Motor Gap Information page into the appropriate Gap 
Error field for each motor on the path. The Gap # is populated based on the motor 
types, see Figure 4-36 on page 106. 

Figure 4-39: Downstream Gap Error Adjustment Window

6. Select Apply to apply all Gap Errors.

7. Repeat for all Paths in the system.

8. Select Save XML Config on the File menu in the Configurator Menu Bar.
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Define Control Loop Parameters

1. Update the control loop default settings of each PID Set as required for the path (see 
Control Loop Parameters on page 240 for detailed descriptions of all parameters).

2. To access the Per Motor Control Loop Parameters, see Show Per Motor Control Loop 
Parameters.

3. Select Save XML Config on the File menu in the Configurator Menu Bar.

Show Per Motor Control Loop Parameters

This section describes how to show/hide the motor Control Loop parameters for individual 
motor pages. This is typically used if one or two motors on a path require different PID 
settings to control vehicle motion that is based on some action being taken while the vehicle is 
on those specific motors.

1. Enable the Per Motor Control Loop Parameters option by selecting the Show Per 
Motor Control Loop Parameters option in the View menu in the Configurator Menu 
Bar.
The Motor Details page that is displayed in the Configuration Settings Pane is 
updated with the control loop parameters, see Figure 4-1 on page 71.

A check mark is displayed before the Show Per Motor Control Loop Parameters, see 
Figure 4-40, to indicate it is selected.

Figure 4-40: Show Per Motor Control Loop Parameters Option Selected

2. Edit the Control Loop parameters for specific motors as required.

3. Select Save XML Config on the File menu in the Configurator Menu Bar.

NOTE: The Show Per Motor Control Loop Parameters selection is not saved in the Node 
Controller Configuration File and always defaults to cleared (unchecked) when the 
Configurator is started.
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Configure Keepout Areas

The Keepout Area allows the definition of certain areas on a path where the motors can help 
prevent vehicles from entering unless they have permission to pass completely through the 
area. 

NOTE: These are no longer default values and must be configured on each individual motor 
page. Keepout Areas can start anywhere on a motor but must always end at the end 
of a motor.

• A vehicle with a final destination beyond the Keepout Area moving in the direction of 
the Keepout Area is not allowed to enter the area until it has acquired movement 
permission beyond the Keepout Area.

• A vehicle with a final destination in the Keepout Area moving in the direction of the 
Keepout Area is not allowed to enter and stop in the area until it has acquired 
movement permission beyond the area. That is, there are no vehicles between it and 
the area just past the Keepout Area.

• A vehicle entering a Keepout Area in the direction of the Keepout Area takes 
ownership of all motor blocks inside the Keepout Area.

• A Keepout Area in one direction does not affect the motion of vehicles moving in the 
other direction unless there is a vehicle inside the Keepout Area moving in the 
direction of the Keepout Area.

4. If vehicle movement is suspended, meaning an E-Stop, interlock, Suspend, or FastStop 
command is issued:
• Any vehicle in the Keepout Area moving in the direction of the Keepout Area 

moves beyond the Keepout Area and then decelerates to a stop.
• Any vehicle in the Keepout Area moving in the opposite direction of the 

Keepout Area immediately decelerates to a stop.
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Examples

For vehicle motion downstream, if the configuration of the Keepout Area is the same as the 
configuration shown in Figure 4-41, set the No Move Permission After values for the motors 
as shown in Figure 4-41. See Keepout Areas on page 247 for detailed descriptions of the 
parameters.

Figure 4-41: Keepout Area, Downstream Vehicle Motion

For vehicle motion upstream, if the configuration of the Keepout Area is the same as the 
configuration shown in Figure 4-42, set the No Move Permission Before values for the 
motors as shown in Figure 4-42. See Keepout Areas on page 247 for detailed descriptions of 
the parameters.

Figure 4-42: Keepout Area, Upstream Vehicle Motion
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Define Keepout Areas

1. Update the Keepout Area settings as required for the path (see Keepout Areas on 
page 247 for detailed descriptions of all parameters).

2. Select Save XML Config on the File menu in the Configurator Menu Bar.

Copy Motor Defaults

For many system configurations, it is desirable to use the same Motor Defaults parameters on 
multiple paths in the system. For example, it is common to use the same Vehicle Parameters 
for all paths in a system. The Selective Copy and Copy to All Paths options are available on 
the Motor Defaults page of every path. This allows easy configuration of the Motor Defaults 
in one place and distribute them to the rest of the paths in the configuration.

Copy to All Paths

The Copy to All Paths button copies all motor default parameters to all paths defined in the 
configuration.

1. Navigate to the Motor Defaults page of any path.

2. Define the motor default parameters as desired for all paths.

3. Select Copy to All Paths. See the second button along the top of the Configuration 
Settings Pane in Figure 4-43.
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Figure 4-43: Copy to All Paths

4. Select OK to copy all motor default parameters to all Paths. Select Cancel to cancel.

Figure 4-44: Copy to All Paths Confirmation

5. Select OK on Copy Complete.
All parameters from the starting path have been copied to all paths.



Transport System Configuration
Define and Edit Motors and Vehicle Parameters

114 Rockwell Automation Publication MMI-UM046A-EN-P - May 2023

Figure 4-45: Copy Motor Defaults Complete

6.  Select Save XML Config on the File menu in the Configurator Menu Bar.

Selective Copy

The Selective Copy button displays a window, that allows the selection of which motor 
default parameters to copy and specify which paths to copy to.

1. Navigate to the Motor Defaults page of a path where parameters need to be changed.

2. Define the motor default parameters as desired.

3. Select Selective Copy. See the first button along the top of the Configuration Settings 
Pane in Figure 4-46.
The Copy Motor Defaults window (Figure 4-47) appears.
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Figure 4-46: Motor Defaults Page - Selective Copy Button

Figure 4-47: Copy Motor Defaults
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4. In the Copy Motor Defaults window, check the boxes individually or use the row or 
column headers to select which parameter groups and paths to copy to.
In this example, the Vehicle column header checkbox was used to select the vehicle 
parameters for all paths.

Figure 4-48: Copy Motor Defaults Window - Copy Vehicle Parameters

5. Select Apply Settings to copy the selected parameters. Select Cancel to cancel.

6. Select OK on Copy Complete.
The selected parameters have been copied to the selected paths.

Figure 4-49: Copy Motor Defaults Complete

7. Select Save XML Config on the File menu in the Configurator Menu Bar.
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Create and Edit Nodes
This section describes how to create and edit all node types in the Node Controller 
Configuration File. Nodes define the beginning, end, and intersection of paths and are an 
important element of a transport system configuration.

NOTE: There is a maximum of two nodes per path. The maximum quantity of paths per 
transport system is system-dependent, see MagneMotion Node Controller Hardware 
User Manual, publication MMI-UM013.

The maximum quantity of paths per node is dependent on the node type. The ends of 
all paths that meet in a node must be connected to the same node controller.

Node Types

The transport systems support the following types of nodes. All node types that support 
motion through the node, support bidirectional motion. Not all systems support all node types. 
See Node Parameters on page 249 for parameters descriptions.

• Simple Node on page 119
• Relay Node on page 121
• Terminus Node on page 122
• Merge Node on page 124
• Diverge Node on page 128
• Merge-Diverge Node on page 132
• Gateway Node on page 136

Table 4-3: Menu Definitions and Short-cut Keys

Menu Action Short-cut
File New XML Config Ctrl+N

Open XML Config Ctrl+O

Save XML Config Ctrl+S

Edit Insert Before Ctrl+Shift+I

Insert After Ctrl+I

Add to End Ctrl+E

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Delete Del (Delete)

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
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• Overtravel Node on page 138
• Moving Path Node on page 141

See the MagneMotion Node Controller Hardware User Manual, publication MMI-UM013 for 
information on how to install and maintain the node controllers that are used with the 
transport systems. Node controllers are used to monitor vehicles and control the motors of a 
transport system based on the commands from the host controller.

Create a Node

Each node in the transport system must be defined.

1. In the Configuration Tree, select Nodes, see Figure 4-50.

Figure 4-50: Configuration Tree with Nodes Selected

2. On the Edit menu in the Configurator Menu Bar, select Add To End... (or right-click 
on Nodes and select Add To End...).

NOTE: Right-click on an existing node to open the Edit shortcut menu insert a node 
before or after the selected node.

The list of nodes is expanded and displayed below Nodes in the Configuration Tree, 
see Figure 4-51 with the new node added to the list. The node is automatically 
numbered with the next available Node ID.

Figure 4-51: Configuration Tree Showing Node Added

Edit a Node

1. Expand the list of nodes in the Configuration Tree by selecting the symbol in front of 
Nodes or double-clicking Nodes.
The list of nodes is expanded and displayed below Nodes in the Configuration Tree.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
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2. Open the node to be edited by selecting the Node ID for that node.
The Node Details page for the selected node, see Figure 4-52, is displayed in the 
Configuration Settings Pane.

Figure 4-52: New (Undefined) Node Page

3. Update the node parameters as required (see Nodes on page 248 for detailed 
descriptions of all parameters).

4. Select Save XML Config on the File menu in the Configurator Menu Bar.

Simple Node

A Simple node is used to begin a path that is not connected to anything else at the upstream 
end. No vehicles can be commanded to enter or exit the path through a Simple node. The 
upstream end of the path where the node is located requires one connection to the node 
controller. See Figure 4-53, where the shaded circle represents the Simple node. Paths can 
begin at other node types.

Figure 4-53: Simple Node

1. Open the node to be edited by selecting the Node ID for that node in the Configuration 
Tree.

2. From the Node Type drop-down list, select Simple.

The Node Details page is updated to show the Simple node parameters, see 
Figure 4-54.

Simple Node Exit Path
(Path 1)

MM Motor

Forward
(Downstream)
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Figure 4-54: Simple Node Parameters

3. Update the node parameters as required (see Simple Node on page 250 for detailed 
descriptions of all parameters).

4. Select Save XML Config on the File menu in the Configurator Menu Bar.

Example

If the configuration of the node is the same as the configuration shown in Figure 4-53, set Exit 
Path ID to 1, see Figure 4-55.

Figure 4-55: Simple Node Example
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Relay Node

A Relay node is used to connect the downstream end of a path and the upstream end of a path. 
Relay nodes are used to connect two paths when the maximum quantity of motors on the first 
path is reached. Relay nodes are also used to join the downstream and upstream ends of the 
same path, which creates a simple loop. See Figure 4-56, where the shaded circle represents 
the Relay node.

Figure 4-56: Relay Node

1. Open the node to be edited by selecting the Node ID for that node in the Configuration 
Tree.

2. From the Node Type drop-down list, select Relay.

The Node Details page is updated to show the Relay node parameters, see 
Figure 4-57.

Figure 4-57: Relay Node Parameters

3. Update the node parameters as required (see Relay Node on page 251 for detailed 
descriptions of all parameters).

4. Select Save XML Config on the File menu in the Configurator Menu Bar.

Forward
(Downstream)

MM Motor

Relay Node
Entry Path Ends Exit Path Begins

(Path 1) (Path 2)
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Example

If the configuration of this node is the same as the configuration shown in Figure 4-56, set 
Entry Path ID to 1 and Exit Path ID to 2, see Figure 4-58.

Figure 4-58: Relay Node Example

Terminus Node

A Terminus node is used on a path where vehicles move to or from remote equipment. 
Terminus nodes can be placed at either the upstream or downstream end of the path. The 
upstream end of the path where the node is located requires one connection to the node 
controller. See Figure 4-59, where the shaded circle represents the Terminus node at the 
downstream end of the path.

Figure 4-59: Terminus Node

1. Open the node to be edited by selecting the Node ID for that node in the Configuration 
Tree.

2. From the Node Type drop-down list, select Terminus.

Terminus Node
Forward

(Downstream) Path Ends

MM Motor

Transport System Remote Equipment

Guideway

(Path 3)
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The Node Details page is updated to show the Terminus node parameters, see 
Figure 4-60.

Figure 4-60: Terminus Node Parameters

3. Update the node parameters as required (see Terminus Node on page 251 for detailed 
descriptions of all parameters).

4. Select Save XML Config on the File menu in the Configurator Menu Bar.

Example

If the configuration of this node is the same as the configuration shown in Figure 4-59, set 
Path to 3 and Path End to Downstream, see Figure 4-61.

Figure 4-61: Terminus Node Example
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Merge Node

A Merge node is used where the downstream ends of two paths connect to the upstream end of 
a third path. A merge can be created using either a Right Switch or a Left Switch. See 
Figure 4-62, where the shaded circle represents the Merge node that uses a Left Switch.

NOTE: Merge nodes are only available for MagneMover Lite.

Figure 4-62: Merge Node

1. Open the node to be edited by selecting the Node ID for that node in the Configuration 
Tree.

2. From the Node Type drop-down list, select Merge.

The Node Details page is updated to show the Merge node parameters, see 
Figure 4-63.

Figure 4-63: Merge Node Parameters - No Path Selected

3. For each entry or exit path that is identified under Entry/Exits, select the number of 
the path that is connected to this node from the appropriate Path drop-down list.

Default values are entered in the Clearance Distance, Entry Gate ID, Entry 
Gate Distance, and Consecutive Vehicle Limit fields.

Merge Node Forward
(Downstream)

Straight Entry Path Ends

MM MotorMerged Exit Path Begins

(Path 1)

(Path 3)

Curve Entry Path Ends
(Path 2)

(Left Switch Shown)

MM Switch
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A. If the Vehicle Shape in the Motor Defaults for all paths in the node is Linear, 
the Merge node page displays, see Figure 4-64.

Figure 4-64: Merge Node Parameters - Linear Vehicle Shape on Paths

B. If the Vehicle Shape in the Motor Defaults for all paths in the node is 
Rectangular, the Merge node page displays, see Figure 4-65.

Figure 4-65: Merge Node Parameters - Rectangular Vehicle Shape

C. If the Vehicle Shape in the Motor Defaults is not the same for all paths in the 
node, the Merge node page displays, see Figure 4-66. A Path Vehicle Shape 
Mismatch error (Figure 4-67) notifies you of a vehicle shape mismatch within 
a node. This is an invalid configuration as all paths in a node must use the same 
vehicle shape. Use the Vehicle Shape column to determine which paths need 
to be corrected.
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Figure 4-66: Merge Node Parameters - Vehicle Shape Mismatch

Figure 4-67: Vehicle Shape Mismatch Error

4. For each entry or exit path that is identified under Entry/Exits, adjust the node 
parameters if necessary (see Merge Node on page 254 for detailed descriptions of all 
parameters; see Node Gates and Clearances on page 147).

A. For a Merge node with a Linear Vehicle Shape, select the Use Gates and 
Clearances checkbox to enable the use of the Gate Position and Clearance 
Position. The use of gates and clearances is not required for systems using 
linear vehicles.

NOTE: Once the Use Gates and Clearances checkbox is checked, data 
validation runs on the Gate Position and Clearance Position fields. 
Update the values position to be the minimum distance from the node 
to confirm a valid configuration.
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Figure 4-68: Merge Node Parameters – Use Linear Gates and Clearances

B. For a Merge node with a Rectangular Vehicle Shape, the Gate Distance and 
Clearance Distance are displayed, see Figure 4-65. These values are 
calculated based on the system layout and vehicle dimensions. There is no 
need to modify these values when using the rectangular vehicle option. The use 
of gates and clearances is required for systems using rectangular vehicles.

C. Both linear and rectangular style Merge nodes use the Consecutive Vehicle 
Limit parameter to manage traffic through the switch.

5. Select Save XML Config on the File menu in the Configurator Menu Bar.

Linear Example

If the configuration of this node is the same as the configuration shown in Figure 4-62, set 
Straight Entry to 1, Curve Entry to 2, and Merged Exit to 3, see Figure 4-69.

Figure 4-69: Merge Node Example — Linear
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Diverge Node

A Diverge node is used where the downstream end of one path connects to the upstream ends 
of two paths. A diverge can be created using either a Right Switch or a Left Switch. See 
Figure 4-70, where the shaded circle represents the Diverge node that uses a Right Switch.

NOTE: Diverge nodes are only available for MagneMover Lite.

Figure 4-70: Diverge Node

1. Open the node to be edited by selecting the Node ID for that node in the Configuration 
Tree.

Forward
(Downstream)

Straight Exit Path Begins

MM Motor Single Entry Path Ends

Curve Exit Path Begins

(Path 2)

(Path 3)

(Path 1)

Diverge Node
(Right Switch Shown)

MM Switch
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2. From the Node Type drop-down list, select Diverge.

The Node Details page is updated to show the Diverge node parameters, see 
Figure 4-71.

Figure 4-71: Diverge Node Parameters - No Paths Selected

3. For each entry or exit path that is identified under Entry/Exit, select the Path ID of the 
path that is connected to this node from the appropriate Path drop-down list.

A. If the Vehicle Shape in the Motor Defaults for all paths in the node is Linear, 
the Diverge node page displays, see Figure 4-72.

Figure 4-72: Diverge Node Parameters - Linear Vehicle Shape

B. If the Vehicle Shape in the Motor Defaults for all paths in the node is 
Rectangular, the Diverge node page displays, see Figure 4-73.
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Figure 4-73: Diverge Node Parameters - Rectangular Vehicle Shape

C. If the Vehicle Shape in the Motor Defaults is not the same for all paths in the 
node, the Diverge node page displays, see Figure 4-74. A vehicle shape 
mismatch error (Figure 4-67) notifies you of a vehicle shape mismatch within a 
node. This is an invalid configuration as all paths in a node must use the same 
vehicle shape. Use the Vehicle Shape column to determine which paths need 
to be corrected.

Figure 4-74: Diverge Node Parameters - Vehicle Shape Mismatch

4. For each entry or exit path that is identified under Entry/Exits, adjust the node 
parameters if necessary (see Diverge Node on page 256 for detailed descriptions of all 
parameters, see Node Gates and Clearances on page 147 for additional information 
about gates and clearances).

A. For a Diverge node with a Linear Vehicle Shape, select the Use Gates and 
Clearances checkbox to enable the use of the Gate Position and Clearance 
Position. The use of gates and clearances is not required for systems using 
linear vehicles.



Transport System Configuration
Create and Edit Nodes

Rockwell Automation Publication MMI-UM046A-EN-P - May 2023 131

NOTE: Once the Use Gates and Clearances checkbox is checked, data 
validation is run on the Gate Position and Clearance Position fields. 
Update the values position to the minimum distance from the node to 
confirm a valid configuration. For each entry or exit path that is 
identified under Entries and Exits, select the number of the path that 
is connected to this node from the appropriate Path drop-down list.

Figure 4-75: Diverge Node Parameters - Use Linear Gates and Clearances

B. For a Diverge node with a Rectangular Vehicle Shape, the Gate Distance and 
Clearance Distance are displayed, see Figure 4-65. These values are 
calculated based on the system layout and vehicle dimensions. There is no 
need to modify these values when using the rectangular vehicle option. The use 
of gates and clearances is required for systems using rectangular vehicles.

C. Both linear and rectangular style Diverge nodes use the Consecutive Vehicle 
Limit parameter to manage traffic through the switch.

5. Select Save XML Config on the File menu in the Configurator Menu Bar.

Linear Example

If the configuration of this node is the same as the configuration shown in Figure 4-70, set 
Straight Exit to 2, Curve Exit to 3, and Single Entry to 1, see Figure 4-76.



Transport System Configuration
Create and Edit Nodes

132 Rockwell Automation Publication MMI-UM046A-EN-P - May 2023

Figure 4-76: Diverge Node Example - Linear

Merge-Diverge Node

A Merge-Diverge node is used where the downstream ends of two paths connect to the 
upstream ends of two other paths. A merge-diverge is created using a Right Switch and a Left 
Switch. See Figure 4-77, where the shaded circle represents the Merge-Diverge node.

NOTE: Merge-Diverge nodes are only available for MagneMover Lite.

Figure 4-77: Merge-Diverge Node

1. Open the node to be edited by selecting the Node ID for that node in the Configuration 
Tree.

2. From the Node Type drop-down list, select Merge-Diverge.

Forward
(Downstream)

Straight Exit Path Begins

MM Motor

Straight Entry Path Ends
(Path 3)(Path 1)

Merge-Diverge Node

Curve Entry Path Ends
(Path 2)

Curve Exit Path Begins
(Path 4)

Forward
(Downstream)

MM Switch
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The Node Details page is updated to show the Merge-Diverge node parameters, see 
Figure 4-78.

Figure 4-78: Merge-Diverge Node Parameters - No Paths Selected

3. For each entry or exit path that is identified under Entry/Exits, select the Path ID that 
is connected to this node from the appropriate Path drop-down list.

A. If the Vehicle Shape in the Motor Defaults for all paths in the node is Linear, 
the Merge-Diverge node page displays, see Figure 4-79.

Figure 4-79: Merge-Diverge Node Parameters - Linear Vehicle Shape

B. If the Vehicle Shape in the Motor Defaults for all paths in the node is 
Rectangular, the Merge-Diverge node page displays, see Figure 4-80.
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Figure 4-80: Merge-Diverge Node Parameters - Rectangular Vehicle Shape

C. If the Vehicle Shape in the Motor Defaults is not the same for all paths in the 
node, the Merge-Diverge node page displays, see Figure 4-81. A vehicle shape 
mismatch error (Figure 4-67) notifies you of a vehicle shape mismatch within a 
node. This is an invalid configuration as all paths in a node must use the same 
vehicle shape. Use the Vehicle Shape column to determine which paths need 
to be corrected.

Figure 4-81: Merge-Diverge Node Parameters - Vehicle Shape Mismatch

4. For each entry or exit path that is identified under Entry/Exits, adjust the node 
parameters if necessary (see Merge-Diverge Node on page 259 for detailed 
descriptions of all parameters, see Node Gates and Clearances on page 147 for 
additional information about gates and clearances).

A. For a Merge-Diverge node with a Linear Vehicle Shape, select the Use Gates 
and Clearances checkbox to enable the use of the Gate Position and 
Clearance Position. The use of gates and clearances is not required for 
systems using linear vehicles.
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NOTE: Once the Use Gates and Clearances checkbox is checked, data 
validation is run on the Gate Position and Clearance Position fields. 
Update the values position to be the minimum distance from the node 
to confirm a valid configuration.

Figure 4-82: Merge-Diverge Node Parameters - Use Linear Gates and Clearances

B. For a Merge-Diverge node with a Rectangular Vehicle Shape, the Gate 
Distance and Clearance Distance are displayed, see Figure 4-82. These 
values are calculated based on the system layout and vehicle dimensions. 
There is no need to modify these values when using the rectangular vehicle 
option. The use of gates and clearances is required for systems using 
rectangular vehicles.

C. Both linear and rectangular style Merge-Diverge nodes use the Consecutive 
Vehicle Limit parameter to manage traffic through the switch.

5. Select Save XML Config on the File menu in the Configurator Menu Bar.

Linear Example

If the configuration of this node is the same as the configuration shown in Figure 4-77, set 
Straight Exit to 2, Curve Exit to 3, and Single Entry to 1, see Figure 4-83. 
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Figure 4-83: Merge-Diverge Node Example — Linear

Gateway Node

A Gateway node is used to connect a path end on one transport system to a path end on 
another transport system. Gateway nodes can be used either with or without the use of an HLC 
Control Group to manage vehicle IDs across subsystems of a larger transport system. See 
Figure 4-84, where the shaded circles represent the Gateway nodes. Each transport system has 
its own HLC and Node Controller Configuration File. If using an HLC Control Group, the 
HLC Control Group Settings must be configured in each Node Controller Configuration File 
(see Defining HLC Control Groups on page 80).

NOTE: There is a maximum of two Gateway nodes per node controller, one upstream and 
one downstream. The Gateway nodes do not need to be on the same path.

• The upstream Gateway node in a gateway pair has a corresponding 
downstream node on another node controller belonging to another subsystem 
of the HLC Control Group. 

• The downstream Gateway node in a gateway pair has a corresponding 
upstream node on another node controller belonging to another subsystem of 
the HLC Control Group.
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Figure 4-84: Gateway Node

1. Open the node to be edited by selecting the Node ID for that node in the Configuration 
Tree.

2. From the Node Type drop-down list, select Gateway.

The Node Details page is updated to show the Gateway node parameters, see 
Figure 4-85.

Figure 4-85: Gateway Node Parameters

3. Update the required node parameters in the Node Controller Configuration Files for 
each transport system (see Gateway Node on page 252 for detailed descriptions of all 
parameters).

4. Select Save XML Config on the File menu in the Configurator Menu Bar.

Gateway Node

Subsystem 2

Exit Path Entry Path

MM Motor

Ethernet

Network

Subsystem 1

(Path 3) (Path 1)

Forward
(Downstream)

Forward
(Downstream)

Gateway Node
(Node 1) (Node 2)

Host Controller
192.168.110.100

Host Controller
192.168.110.200

HLC
192.168.110.101

NC
192.168.110.111

HLC/NC
192.168.110.201

5.0 m 1.0 m

Switch

(Vehicle ID Server) (Vehicle ID Client)



Transport System Configuration
Create and Edit Nodes

138 Rockwell Automation Publication MMI-UM046A-EN-P - May 2023

Example

If the configuration of this node is the same as the configuration shown in Figure 4-84, the 
Node Controller Configuration File for HLC Control Subsystem 1 contains the Gateway node 
definition that is shown in the upper example of Figure 4-86. The Node Controller 
Configuration File for HLC Control Subsystem 2 contains the Gateway node definition that is 
shown in the lower example of Figure 4-86. If using an HLC Control Group, it must be 
configured as shown in Figure 4-12 on page 82 for this example.

Figure 4-86: Gateway Node Example

Overtravel Node

NOTE: Overtravel nodes are only available for QuickStick and QuickStick HT.

An Overtravel node is used to permit part of a vehicle to move past the end of the motor at the 
end of a path. Additional support structure (guideway) for the vehicle must be provided, or the 
vehicle’s supports (wheels) must not be allowed to move past the end of the path. See 
Figure 4-87 and Figure 4-88, where the shaded area represents Overtravel nodes.

NOTE: There is only a certain amount of thrust and attractive force available per magnet 
array cycle. Make sure the magnet array on the vehicle covers enough of the motor 
to allow the motor to exert force on the vehicle to move it.

NOTICE If appropriate cautions are not taken for the vehicle, it
can fall off of the guideway or get caught on the end of the
guideway preventing further movement.

Gateway Node in HLC Control Group 1 (Master)

Gateway Node in HLC Control Group 2 (Slave)
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The overtravel feature can be used for the following applications:

• Providing space for vehicle movement during startup (Figure 4-87).

• Allowing movement of a vehicle that is longer than the motor(s) on the path 
(Figure 4-88).

Figure 4-87: Overtravel Node, Startup Top View

Figure 4-88: Overtravel Node, Extended Vehicle Top View

1. Open the node to be edited by selecting the Node ID for that node in the Configuration 
Tree.

2. From the Node Type drop-down list, select Overtravel.
The Node Details page is updated to show the Overtravel node properties, see 
Figure 4-89.

Figure 4-89: Overtravel Node Properties

3. Update the node properties as required (see Overtravel Node Parameters on page 262 
for detailed descriptions of all properties).
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4. Select Save XML Config on the File menu in the Configurator Menu Bar.

Examples

If the configuration of this node is the same as the configuration shown in Figure 4-87, 
configure the node, see Figure 4-90.

Figure 4-90: Overtravel Node Example, Startup

If the configuration of this node is the same as the configuration shown in Figure 4-88, two 
Overtravel nodes are required. Configure the nodes, see Figure 4-91.

Figure 4-91: Overtravel Node Example, Extended Vehicle

Upstream Overtravel Node

Downstream Overtravel Node
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Moving Path Node

NOTE: Moving Path nodes are only available for QuickStick and QuickStick HT.

A Moving Path node is used to connect the ends of multiple paths using a path being moved 
by a Host-controlled mechanism. This mechanism may be any user-supplied mechanism, 
including a QuickStick path. The Moving Path node enables vehicles to move between 
multiple guideways. The paths in the Moving Path node are called entry and exit paths. Either 
type of path may be moved but the connecting paths must all be of the other type (that is, entry 
paths move and all exit paths are fixed). Up to 12 paths can be configured as either entry paths 
or exit paths. See Figure 4-92, where the shaded area represents the Moving Path node.

Use of the Moving Path node requires the host controller to command the drive mechanism to 
position one of the moving paths so that it aligns with one of the fixed paths. The host 
controller must then issue a Link command (see the MagneMotion Host Controller TCP/IP 
Communication Protocol User Manual, publication MMI-UM003 or the MagneMotion Host 
Controller EtherNet/IP Communication Protocol User Manual, publication MMI-UM004.) to 
connect the two paths to allow vehicle movement. After the vehicle has moved beyond the 
node, the host controller must issue an Unlink command before the Moving Path may be 
moved to a new position.

Figure 4-92 shows a single Moving Path node configuration where vehicles can move 
between the three exit paths using either of the two entry Moving Paths.

Figure 4-92: Moving Path Node Single Node
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Figure 4-93 shows a dual Moving Path node configuration where vehicles can move from 
either of the two entry paths in Moving Path Node 1 to any of the exit paths in Moving Path 
Node 2 using either of the two Moving Paths. In this type of configuration, the Moving Paths 
are associated with both Moving Path nodes. For Moving Path Node 1, these paths are exit 
paths. For Moving Path Node 2, these paths are entry paths.

In Figure 4-93 if the vehicle is moving from Moving Path Node 1 Entry Path 1 to Moving 
Path Node 2 Exit Path 5 the Moving Path does not need to move.

Figure 4-93: Moving Path Node Dual Nodes

1. Open the node to be edited by selecting the Node ID for that node in the Configuration 
Tree.

2. From the Node Type drop-down list, select Moving Path.
The Node Details page is updated to show the Moving Path Node properties, see 
Figure 4-94.
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Figure 4-94: Moving Path Node Properties

3. Select the appropriate route type for the Entry Paths Route Type and Exit Paths 
Route Type from the drop-down list. Select Specific-route if a specific Moving Path 
in the node is used to satisfy the route (specified by the HLC), see Figure 4-92 or 
Equivalent-route if any Moving Path in the node can satisfy the route (specified by 
the host controller), see Figure 4-93.

4. For each entry or exit path that is involved in the Moving Path node, select the path 
direction under Entry/Exit.

5. For each entry or exit path that is identified select the Path ID of the path that is 
connected to this node from the appropriate Path drop-down list.

6. For each entry or exit path that is identified under Entry/Exits, adjust the node 
parameters if necessary. See Moving Path Node Parameters on page 263 for detailed 
descriptions of all properties. See Node Gates and Clearances on page 147 for a 
detailed description of the gate and clearance parameters. Select the info button next 
too Moving Path Node Entry and Exit Parameters in Figure 4-94 for additional 
help with gates, clearances, and gap deltas.

A. For a Moving Path node where the Gate Position or Clearance Position of the 
Entry/Exits is on a neighboring path, uncheck Sync Clearance & Gate Path 
ID with Entry/Exit Path ID (see Figure 4-95). Unsyncing the Path ID 
provides the option to specify a gate or clearance position on a different path. 
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Figure 4-95: Moving Path Node Properties, Unsync Paths

B. After a configuration file has been created and the system has ran, the Input 
Gap Delta Errors button can be used to adjust the Gap Deltas by the Gap 
Errors detected by the system. These Gap Errors can be found in the Node 
Controller Web Interface. See Define Downstream Gaps for QuickStick and 
QSHT on page 105 for more information.

7. Select Save XML Config on the File menu in the Configurator Menu Bar.
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Examples

If the configuration of this node is the same as the configuration shown in Figure 4-92, 
configure the node, see Figure 4-96.

Figure 4-96: Moving Path Node, Single Node Example
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If the configuration of this node is the same as the configuration shown in Figure 4-93, 
configure the nodes, see Figure 4-97.

Figure 4-97: Moving Path Node, Dual Nodes Example

Node Parameters
Nodes are used to define the connections between paths. The Node page is accessed by 
expanding the Nodes List in the Configuration Tree and selecting the appropriate node. 

Moving Path Node 1

Moving Path Node 2
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Node Gates and Clearances

This section discusses the common traits and differences that are used between all kinds of 
gates and clearances. Node gates and clearances are used with switching nodes (Merge, 
Diverge, and Merge-Diverge) on MM Lite and Moving Path nodes on QuickStick and QSHT. 
These are anti-collision parameters that define where vehicles enter and exit the node.

For MM Lite switching nodes using rectangular vehicles, the following parameters are 
used:
• Gate Distance
• Clearance Distance
For MM Lite switching nodes using linear vehicles, the following parameters are used:
• Gate Position
• Clearance Position
For QuickStick and QSHT systems using Moving Path nodes, the following 
parameters are used:
• Gate Path ID
• Gate Position
• Clearance Path ID
• Clearance Position

The Gate Distance, Gate Position, and Gate Path ID & Gate Position are referred to as the 
"gate location". 

The gate is used to hold vehicles before the node until the node is available for the next 
vehicle to enter. The gate location defines a location on an entry or exit path that is associated 
with a node where the vehicle (single or tandem) can safely avoid vehicles on other paths. 
This location is such that the leading edge of the vehicle (including payload), regardless of 
vehicle movement direction, is safely located to avoid collisions with vehicles on adjoining 
paths.
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Figure 4-98: Gate Location

The Clearance Distance, Clearance Position, and Clearance Path ID & Clearance Position, are 
referred to as the "clearance location". 

The clearance location is the safety zone which queues vehicles until the vehicle in the node 
has reached a location where it avoids collisions with other vehicles on adjoining paths or 
with any mechanisms that are related to the node. The clearance location defines a location on 
an entry or exit path that is associated with a node where the vehicle (single or tandem) can 
safely avoid vehicles on other paths. This location has the trailing edge of the vehicle 
(including payload), regardless of vehicle movement direction, safely located to avoid 
collisions with vehicles on adjoining paths. 

 

Figure 4-99: Clearance Location
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Gate and clearance locations must be defined for both forward and backward motion through 
the node. Figure 4-100 shows for forward motion through a Diverge node, that the following 
values are used:

• Single Entry Path (Path 1): Gate Location
• Curve Exit Path (Path 2): Clearance Location
• Straight Exit Path (Path 3): Clearance Location

A vehicle transiting the Diverge node in Figure 4-100 in the forward direction queues up at 
the gate on Path 1 until the node is available for entry. The vehicle in the node owns the node 
until it passes the clearance distance on either Path 2 or Path 3, allowing the next vehicle 
waiting at the gate to enter.

 

Figure 4-100: Gate and Clearance Locations - Forward

Figure 4-101 shows for backward motion through a Diverge node, that the following values 
are used:

• Single Entry Path (Path 1): Clearance Location
• Curve Exit Path (Path 2): Gate Location
• Straight Exit Path (Path 3): Gate Location

Vehicles transiting the Diverge node in Figure 4-101 in the backward direction queues up at 
the gates on Paths 2 and 3 until the node is available for entry. The vehicle in the node owns 
the node until it passes the clearance distance on Path 1, allowing the next vehicle waiting at 
the gate to enter.
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Figure 4-101: Gate and Clearance Locations - Backward

The gate and clearance locations on a path should not be in the same location, see 
Figure 4-102. The clearance should be farther from the node than the gate. If these positions 
are set the same or if the clearance location is set closer than the gate in the Configurator, then 
the node controller recalculates the clearance location, so it is valid. 
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Figure 4-102: Gate and Clearance Locations

MM Lite Rectangular Gates and Clearances

For MM Lite systems using a Rectangular Vehicle Shape (see Vehicle and Motor Parameters 
on page 227) the gates and clearances are defined using the Gate Distance and Clearance 
Distance.

When using MM Lite rectangular vehicles, the gate location (see Figure 4-98) is defined as 
the distance in meters from the end of the motor closest to the node to the center of the 
vehicle, called the Gate Distance. The clearance location (see Figure 4-99) is defined as the 
distance in meters from the end of the motor closest to the node to the center of the vehicle, 
called the Clearance Distance.

Figure 4-103 shows a Diverge node using a Rectangular Vehicle Shape. In this transport 
system, the entry is Path 1 and the exit is Path 2 and Path 3. 

When using MM Lite rectangular vehicles, the MagneMotion Configurator automatically 
generates the Gate Distance and Clearance Distance for Merge, Diverge, and Merge-Diverge 
nodes. These distances are generated based on the defined vehicle parameters (Fore Length, 
Aft Length, Port Length, and Starboard Length see Vehicle and Motor Parameters on 
page 227 for details) and the configuration the motors around the node. 
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Large gate and clearance distances may be needed for wide vehicles or layouts with many 
curves and switches. The automatically generated values should not be modified for 
rectangular gates and clearances.

 

Figure 4-103: Diverge Node (Rectangular) with Auto-generated Gate and Clearance 
Distances

MM Lite Linear Gates and Clearances

For MM Lite systems using a Linear Vehicle Shape (see Vehicle and Motor Parameters on 
page 227) the gates and clearances are defined using the Gate Position and Clearance 
Position.

When using MM Lite linear vehicles, the gate location (see Figure 4-98) is defined as the 
position of the center of the vehicle (in meters) from the start of the entry or exit path, called 
the Gate Position. The Gate Position cannot be defined on a neighboring path; it must be 
defined as a position on the entry or exit path. For the system in Figure 4-100 if Path 1 is 3 
meters long, the Gate Position would be somewhere near the end of the path, like position 
2.8 meters on Path 1.

The clearance location (see Figure 4-99) is defined as the position on the center of the vehicle 
(in meters) from the start of the entry or exit path, called the Clearance Position. The 
Clearance Position cannot be defined on a neighboring path; it must be defined as a position 
on the entry or exit path. For the system in Figure 4-101, if Path 1 is 3 meters long, the Gate 
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Position would be somewhere near the beginning of the path, like position 0.2 meters on 
Path 1.

Vehicle Length

When using linear MM Lite vehicles, it is advised to set the Vehicle Length as the length of 
the longest diagonal of the vehicle to confirm that vehicles do not collide through curves and 
switches. Measure the payload width from the front left corner of the payload to the rear right 
corner of the payload to account for vehicle movement around curves and corners.

How to Find Positions

For best results when defining the gates and clearances:

1. With the system in a Reset state, position one vehicle with its payload on each of the 
paths in the node at the Clearance Position and Gate Position. 

2. Adjust the vehicle locations if necessary to obtain satisfactory clearance distances and 
gate distances between the vehicles on each path. 

3. Startup the system to capture the vehicle positions at the Clearance Position and the 
Gate Position for each path. 

4. Enter the measured values in the corresponding fields in the node configuration page.

MM Lite Protected Area

The protected area around an MM Lite switch is the area where a vehicle on one switch path 
may collide with a vehicle on the other path of the switch, or collide with the switch flipper 
mechanism. The protected area sizer differs for standard versus high payload switches. 
Minimum values for gate and clearance locations are set to confirm that gate and clearance 
locations are outside of the protected areas.

QuickStick and QSHT Gates and Clearances

For QuickStick and QSHT systems using Moving Path nodes, the gates and clearances are 
defined using the Gate Path ID, Gate Position, Clearance Path ID, and Clearance Position.

When using QuickStick and QSHT Moving Path nodes, the gate location (see Figure 4-98) is 
defined as the position on the center of the vehicle (in meters) from the start of the Gate Path 
ID at the Gate Position. If Sync Clearance and Gate Path ID with Entry/Exit Path ID is 
checked, then the Gate Path ID is not displayed, and sets to the Entry/Exit Path ID, see 
Figure 4-104.

The clearance location (see Figure 4-98) is defined as the position on the center of the vehicle 
(in meters) from the start of the Clearance Path ID at the Gate Clearance. If Sync Clearance 
and Gate Path ID with Entry/Exit Path ID is checked, then the Clearance Path ID is not 
displayed, and sets to the Entry/Exit Path ID, see Figure 4-104.
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Figure 4-104:  Gate and Clearance Synced Path IDs

In the Moving Path node example that is shown in Figure 4-105, all gate and clearance 
locations are on the specified Entry/Exit Path IDs. This is when Sync Clearance and Gate Path 
ID with Entry/Exit Path ID should be checked (see Figure 4-104) since no neighboring paths 
are involved in the gate and clearance locations for the node.

 

Figure 4-105: Moving Path Node

In the Moving Path node example shown in Figure 4-106, a Relay node has been added to the 
upstream end of Path 2 and the gate and clearance locations are much farther from the node. 
The gate and clearance locations may need to be farther from the node if the vehicle size is 
large or if there are any mechanisms that are related to the node that must be avoided. 
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Figure 4-106: Moving Path Node - Unsynced Paths

For this example, the gate and clearance locations on the entry path are on a neighboring path, 
and the Sync Clearance and Gate Path ID with Entry/Exit Path ID option should be 
unchecked. The Gate Path ID and Clearance Path ID for Entry/Exit 2 onto Path ID 2 should be 
on Path 6, see Figure 4-107. The Gate Position and Clearance Position should be adjusted to 
reflect the correct positions at the downstream end of Path 6.

 

Figure 4-107: Gate and Clearance Unsynced Path IDs

Gap Delta

The Gap Delta is used to correct for the difference in the motor downstream gaps between the 
exit Paths in Moving Path nodes. The last motor in each entry Path is configured with its 
Downstream Gap (from the motor's downstream end) set to a common reference. 

Previous Gap Delta Guidance

In previous guidance, the common reference was typically the end of the motor extending 
farthest into the Node or the end of the entry Path guideway. The distance from that point to 
the upstream end of the motor on each exit Path is the Gap Delta and is entered into the Gap 
Delta field for that exit Path.
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Figure 4-108 shows a Moving Path node, the measurements for each of the Entry Path motors, 
which are entered as the downstream gap in the motor configuration, and the measurements 
for each of the Exit Path motors. Note that the common point for all measurements is the end 
of the guideways where the moving motors are mounted.

The Gap Delta for each of the Exit Paths is shown in Figure 4-108. This value is then entered 
into the configuration for that Path in the node configuration. The Downstream Gaps for the 
Node would be configured, see Figure 4-109.

 

Figure 4-108: Moving Path Node Gap Delta - Previous Guidance
 

Figure 4-109: Moving Path Node Gap Delta Example - Previous Guidance
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Updated Gap Delta Guidance

The common reference for Downstream Gaps is the measured distance between the 
downstream end of the last motor on the entry path and the upstream end of the first motor on 
the closest exit path in the node. This is shown in the red dashed line in Figure 4-110, where 
Path 3 is the closest exit path to the node. 

The Gap Delta for each Exit Path is then defined as the additional measured distance between 
the Downstream Gap and the upstream end of the first motor on the Exit Path. The Gap Delta 
for the closest path (Path 3 in Figure 4-110) should be equal to 0. All other gap deltas should 
be positive values.

 

Figure 4-110: Moving Path Node Gap Delta

Input Gap Delta Errors

The Node Controller Web Interface can be used to detect precise motor gaps in a running 
QuickStick or QSHT system. It is advised to include the Gap Errors that are detected, as the 
level of precision that is provided by the Web Interface can improve vehicle motion across 
gaps. See the MagneMotion Node Controller Interface User Manual, publication 
MMI-UM001 for details on how to access the Motor Gap Information page.

To input the Gap Errors for a Moving Path node:

1. Create and upload the complete Node Configuration File for the system layout using 
the physical measured gaps for all Downstream Gaps and Gap Deltas in the system.

2. Command a vehicle to drive over all motor gaps in the system.

3. See Motor Gap Information in the MagneMotion Node Controller Interface User 
Manual, publication MMI-UM001 to obtain the detected Gap Errors. The Motor 
Gap Information page is shown in Figure 4-111.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
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Figure 4-111: Node Controller Web Interface - Motor Gap Information Page

4. From the Moving Path node page, select Input Gap Delta Errors.

The Moving Path node Gap Error Adjustment window (see Figure 4-112) appears. The 
Downstream Gap of the last motor on all entry paths is displayed. The Gap Delta for each exit 
path is displayed.
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Figure 4-112: Moving Path Node Gap Error Adjustment Window

5. Input the Gap Errors from the Motor Gap Information page into the appropriate 
Downstream Gap and Gap Delta fields for each path in the node. Keep in mind the 
common reference point selected for the node.

6. Select Apply to apply all Gap Errors.

7. Repeat for each Moving Path node in the system.

8. Select Save NDX Layout on the File menu in the Configurator Menu Bar.

Internal Motor Gaps

QuickStick and QSHT motors contain an internal motor gap between the end of the internal 
stator and the outside of the motor housing. For motors along a path (not at a node), the 
internal gap for both ends of abutting motors is automatically added to the Downstream Gap 
of the previous motor. For internal gap details and information on Downstream Gaps see:
• QuickStick 100 User Manual, publication MMI-UM006
• QuickStick 150 User Manual, publication MMI-UM047
• QuickStick HT User Manual, publication MMI-UM007

Using the Updated Gap Delta Guidance, the Downstream Gap and the Gap Delta split the 
downstream gaps, see Figure 4-113. 

For all entry paths, the Downstream Gap of the last motor on the path includes the internal gap 
of that motor and the physical measured gap to the node centerline.

For all exit paths, the Gap Delta includes the physical measured gap from the node centerline 
to the upstream end of the first motor on the path and the internal gap of the first motor on the 
path.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um006_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um007_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um002_-en-p.pdf
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Figure 4-113: Gap Delta with Internal Gaps Shown

These internal gap values are all calculated automatically by the MagneMotion Configurator 
so that only physical measured gaps or detected gap errors need to be used as inputs. 

Define and Edit Node Controllers
This section describes how to define and edit a node controller in the Node Controller 
Configuration File. Node controllers communicate vehicle information between motor 
controllers (internal to the MagneMover Lite and QuickStick motors, external to the QSHT 
motors) and the high-level controller. Each node controller in the transport system and the 
motors it is responsible for must be defined in the Node Controller Configuration File.

The node controller coordinates vehicle movements along the paths of motors, and is 
responsible for the motion for all motors on all paths that originate from nodes that the node 
controller owns.

The motor at the upstream end of each path, which is designated by a node, must 
communicate with a node controller. The motor at the downstream end of a path that connects 
to other paths through a node must also communicate with a node controller. The 
communication lines from all motors that are associated with a specific node must all connect 
to the same node controller.

There can be multiple node controllers in a transport system, each responsible for a subset of 
the nodes in the transport system. Any node controller in the transport system can also 
function as the HLC (see the MagneMotion Node Controller Interface User Manual, 
publication MMI-UM001).

NOTE: The maximum quantity of node controllers per transport system is 
system-dependent, see MagneMotion Node Controller Hardware User Manual, 
publication MMI-UM013.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
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Node Ownership

In transport systems, paths are defined as an uninterrupted string of motors placed end to end. 
Nodes are used to manage the interactions between paths. Each node has a set of connections 
from the motors at the path end(s) to a node controller. These connections may be physical for 
a serial based system or over a network for Ethernet based systems. The quantity of 
connections per node is equal to the quantity of paths involved in the node, and all 
connections from a node must go to the same node controller. Each path end must be 
associated with a communication port on the node controller. 

• For serial motors (RS-422), a Comm Port number must be specified. The 
quantity of serial ports available on the node controller limits the quantity and 
type of nodes that can be owned.

• For Ethernet motors, use a Comm Port of Ethernet. See the MagneMotion 
Node Controller Hardware User Manual, publication MMI-UM013 for 
limitations on the quantity of nodes per node controller on Ethernet systems.

When a node controller owns a node, it means all connections from that node are associated 
with the node controller. A singular node controller can own multiple nodes.

Use the Take Ownership and Remove Ownership buttons to associate nodes with node 
controllers on the system as desired.

Define a Node Controller

1. In the Configuration Tree, select Node Controllers, see Figure 4-114.

Figure 4-114: Configuration Tree with Node Controllers Selected

2. On the Edit menu in the Configurator Menu Bar, select Add To End... (or right-click 
on Node Controllers and select Add To End...).

NOTE: Right-click on an existing node controller to open the Edit shortcut menu to 
insert a new node controller before or after the selected node controller.

The list of node controllers is expanded and displayed below Node Controllers in the 
Configuration Tree, see Figure 4-115 with the new node controller added to the list. 

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
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The node controller is automatically numbered with the next available Node 
Controller ID.

Figure 4-115: Configuration Tree Showing Node Controller Added

Edit a Node Controller

1. Expand the node controllers list in the Configuration Tree by selecting the symbol in 
front of Node Controllers or double-clicking Node Controllers.

The list of node controllers is expanded and displayed below Node Controllers in the 
Configuration Tree.

2. Open the node controller to be edited by selecting the Node Controller ID for that 
node controller.

The Node Controller Details page for the selected node controller, see Figure 4-116, is 
displayed in the Configuration Settings Pane.

Figure 4-116: New (Undefined) Node Controller Page
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3. Update the parameters for the node controller as required (see Node Controllers on 
page 267 for detailed descriptions of all parameters).

4. From the Node ID drop-down list under Node Ownership, select a node for the node 
controller to monitor and control, then select Take Ownership.

The Node Ownership List is updated with the Node ID, Node Type, and the 
Name. The Path End Ownership List is updated with the IDs of all paths that 
are connected to the node, the end of the path (upstream or downstream) 
connected, and the node membership (enter or exit).

5. From the Comm Port drop-down list, for the upstream or downstream end of each 
path that is listed, select the port that is used for the physical connection from the node 
controller to that end of the motor. For serial motors (RS-422), select the RS-422 port 
that is connected to the path. For Ethernet motors, select Ethernet.

The communication ports that are selected here are displayed in the 
parameters for each path, see Create and Edit Path on page 87.

NOTE: Make sure that all connections for a node use the same node controller.

6. Select Save XML Config on the File menu in the Configurator Menu Bar.

Examples

Figure 4-117 shows an NC-S node controller that is configured with one Merge-Diverge node 
that uses configured serial motors, see Figure 4-77. The node is not named and all four 
RS-422 communications lines that are associated with the Merge-Diverge node connect to this 
node controller. The NC-S does not have a Digital I/O board, so the type is set to ‘None’.
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Figure 4-117: Node Controller (Defined) Example using Serial Communication



Transport System Configuration
Create and Edit Stations

Rockwell Automation Publication MMI-UM046A-EN-P - May 2023 165

Figure 4-118 shows an NC-S node controller that is configured with one Merge-Diverge node 
that uses configured Ethernet motors, see Figure 4-77. The node is not named and all four 
Ethernet communications lines that are associated with the Merge-Diverge node connect to 
this node controller.

Figure 4-118: Node Controller Example using Ethernet Communication

Create and Edit Stations
This section describes how to create and edit stations in the Node Controller Configuration 
File. Stations are specific, designated positions on a Path, which is measured as the distance in 
meters from the start of the Path. Stations are used to command vehicles from the Host 
Controller to a predefined location, instead of having to provide the destination position for 
each vehicle command. Depending on the transport system, a station can be a more 
convenient reference point than a position, which is simply a physical position that is 
referenced from the beginning of a path.

Stations are one of two methods for identifying specific positions in the transport system. The 
other method is to provide the specific position on a path that is measured from the beginning 
of the path, such as 0.25 meters or 1.5 meters.

NOTE: The maximum quantity of stations per transport system is system-dependent, see 
MagneMotion Node Controller Hardware User Manual, publication MMI-UM013.
Do not position stations in the gap between motors.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
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NOTE: Configuration defined stations are for use only when host defined stations are not an 
option. It is highly advised that stations are assigned and managed in the host 
controller rather than defined here.

Show Stations

1. Enable the show stations option by selecting the Show Stations option in the View 
menu in the Configurator Menu Bar. 
A check mark is displayed before the Show Stations, see Figure 4-119, to indicate it is 
selected. When a path is expanded, the Show Stations element is listed.

Figure 4-119: Show Stations Menu View Option

NOTE: The Show Stations selection is not saved in the Node Controller Configuration File 
and always defaults to cleared (unchecked) when the Configurator is started. 
However, if there are simulated vehicles in a Node Controller Configuration File it 
defaults to selected (checked) after the Configuration File is loaded.

Create a Station

1. Expand the list of paths in the Configuration Tree by selecting the symbol in front of 
Paths or double-clicking Paths.
The list of paths is expanded and displayed below Paths in the Configuration Tree.

2. Expand the path where the station is going to be added by selecting the symbol in front 
of its Station ID or double-clicking the Station ID.
The path expands to show Motors, Stations, and other items related to the path.
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3. In the Configuration Tree, select Stations, see Figure 4-120.

Figure 4-120: Configuration Tree with Stations Selected

4. On the Edit menu in the Configurator Menu Bar, select Add To End... (or right-click 
on Stations and select Add To End...).
NOTE: Right-click on an existing station to open the Edit shortcut menu inserts a 

new station before or after the selected station.

The list of stations is expanded and displayed below Stations in the Configuration 
Tree, see Figure 4-121 with the new station added to the list. The station is 
automatically numbered with a Station ID based on the setting of the Station Insert 
Mode option.

NOTE: The Station ID is unique and can only be used once per configuration.

Figure 4-121: Configuration Tree Showing Station Added

Edit a Station

1. Expand the list of paths in the Configuration Tree by selecting the symbol in front of 
Paths or double-clicking Paths.

The list of paths is expanded and displayed below Paths in the Configuration Tree.

2. Expand the path where the station to be edited is located by selecting the symbol in 
front of its Station ID or double-clicking the Station ID.

The path expands to show Motors, Stations, and other items related to the path.

3. Expand the list of stations by selecting the symbol in front of Stations or 
double-clicking Stations.

Stations is highlighted and the list of Stations is expanded to show all stations on the 
path.

4. Open the station to be edited (in this case Station 1) by selecting the Station ID for 
that station.
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The Station Details page for the selected station, see Figure 4-122, is displayed in the 
Configuration Settings Pane. This page identifies the path that the station is 
associated with at the top of the page.

Figure 4-122: Station Page

5. Update the parameters for the station as required (see Stations on page 270 for detailed 
descriptions of all parameters).

6. Select Save XML Config on the File menu in the Configurator Menu Bar.

Example

Figure 4-123 shows a typical station located 2.5 meters from the beginning of Path 1.

Figure 4-123: Station Example

View All Stations

After stations have been created, any station can be accessed for editing or viewing by Station 
ID instead of having to open each path to access the stations that are associated with that path.

NOTE: Accessing a station through the All Stations list provides the same functionality as 
accessing a station through the path that it is associated with.

1. Expand the list of all stations in the Configuration Tree by selecting the symbol in 
front of All Stations or double-clicking All Stations.
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The list of all stations is expanded and displayed below All Stations in the 
Configuration Tree, see Figure 4-124.

Figure 4-124: All Stations List

2. Open the station to be viewed or edited by selecting it.
The Station Details page for the selected station is displayed in the Configuration 
Settings Pane. The path that the station is associated with is displayed at the top of the 
page.

3. Update the parameters for the station if necessary (see Nodes on page 248 for detailed 
descriptions of all parameters).

4. Select Save XML Config on the File menu in the Configurator Menu Bar.

Create and Edit Single Vehicle Areas
This section describes how to define and edit Single Vehicle Areas (SVA) in the Node 
Controller Configuration File. In the transport system, this is a unidirectional area of a path 
where only one vehicle moving in the direction of the area is allowed to move at any time. 
Other vehicles on the path moving in the same direction as the initial vehicle in the SVA must 
wait before entering this area until the previous vehicle leaves the area. This queueing allows 
one vehicle to move backward and forward along a portion of a path without interfering with 
any other vehicles.

Single Vehicle Areas do not apply to vehicles moving in the opposite direction. That is, a 
downstream SVA only keeps vehicles moving downstream from entering it while a vehicle 
inside it entered when moving downstream. If a vehicle entered the SVA moving downstream, 
it does not keep vehicles moving upstream from entering it. If a vehicle entered the SVA 
moving upstream, it does not keep vehicles moving downstream from entering it.

NOTE: Single Vehicle Areas cannot overlap.

Single Vehicle Areas cannot be defined in switches.

Single Vehicle Areas cannot be defined for the full-length of the path.

Multiple Single Vehicle Areas cannot begin on the same motor.
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Figure 4-125: Show Single Vehicle Areas Menu View Option

Figure 4-126: Single Vehicle Area

Show Single Vehicle Areas

1. Enable the stations option by selecting the Show Single Vehicle Areas option in the 
View menu in the Configurator Menu Bar.
A check mark is displayed before the Show Single Vehicle Areas, see Figure 4-127, to 
indicate it is selected. When a path is expanded, the Single Vehicle Areas element is 
listed.

Figure 4-127: Show Single Vehicle Areas Option Selected

NOTE: The Show Single Vehicle Areas selection is not saved in the Node 
Controller Configuration File and always defaults to cleared (unchecked) 

Forward
(Downstream)

MM MotorVehicle in Single

Upstream End Single Vehicle Area

Vehicle Area
Vehicles Waiting to Enter

Single Vehicle Area

of Path

(3.125 m) (4.500 m)
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when the Configurator is started. However, if there are Simulated Vehicles 
in a Node Controller Configuration File it defaults to selected (checked) after 
the Configuration File is loaded.

NOTE: Single Vehicle Areas are hidden by default. Use the View menu in the 
Configuration Menu Bar, select Show Single Vehicle Areas to display them.

Create a Single Vehicle Area

1. Expand the list of paths in the Configuration Tree by selecting the symbol in front of 
Paths or double-clicking Paths.

The list of paths is expanded and displayed below Paths in the Configuration Tree.

2. Expand the path where the Single Vehicle Area is going to be added by selecting the 
symbol in front of its Single Vehicle Area ID.

The path is highlighted and expands to show Motors, Stations, Single Vehicle Areas, 
and other items related to the path.

3. In the Configuration Tree, select Single Vehicle Areas, see Figure 4-128.

Figure 4-128: Configuration Tree with Single Vehicle Areas Selected

4. On the Edit menu in the Configurator Menu Bar, select Add To End... (or right-click 
on Single Vehicle Areas and select Add To End...).

NOTE: Right-click on an existing Single Vehicle Area to open the Edit shortcut 
menu to insert a new SVA before or after the selected SVA.

The list of Single Vehicle Areas is expanded and displayed below Single Vehicle 
Areas in the Configuration Tree, see Figure 4-129 with the new SVA added to the list. 
The SVA is automatically numbered with the next Single Vehicle Area ID.
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NOTE: If a Single Vehicle Area is inserted into the existing list of SVA, all SVA 
following the new area are renumbered.

Figure 4-129: Configuration Tree Showing Single Vehicle Area Added

5. Save all changes to the Single Vehicle Area by selecting Save XML Config on the 
File menu in the Configurator Menu Bar.

Edit a Single Vehicle Area

1. Expand the list of paths in the Configuration Tree by selecting the symbol in front of 
Paths or double-clicking Paths.

The list of paths is expanded and displayed below Paths in the Configuration Tree.

2. Expand the path where the SVA is located by selecting the symbol in front of its 
Single Vehicle Area ID.

The path expands to show Motors, Stations, Single Vehicle Areas, and other items 
related to the path.

3. Expand the SVA section by selecting the symbol in front of Single Vehicle Areas.

Single Vehicle Areas is highlighted and the list of Single Vehicle Areas is expanded to 
show all SVA on the path.

4. Open the Single Vehicle Area to be edited by selecting it.

The Single Vehicle Area Details page for the selected SVA is displayed in the 
Configuration Settings Pane, see Figure 4-130. This page identifies the path that the 
SVA is associated with.

Figure 4-130: Single Vehicle Area Page
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5. Update the parameters for the Single Vehicle Area as required (see Single Vehicle 
Areas on page 271 for detailed descriptions of all parameters).

6. From the Type drop-down list, select the direction of movement on the path where the 
Single Vehicle Area is located. Enter the specific start and end positions as measured 
from the beginning of the path.

7. Select Save XML Config on the File menu in the Configurator Menu Bar.

Examples

If the configuration of the downstream Single Vehicle Area is the same as the configuration 
shown in Figure 4-126, configure the SVA, see Figure 4-131. These settings create a 1.375 m 
long Single Vehicle Area that starts 3.125 m from the beginning of the path.

Figure 4-131: Single Vehicle Area Example – Downstream
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If the configuration of the upstream Single Vehicle Area is the same as the configuration 
shown in Figure 4-126, configure the SVA, see Figure 4-132. These settings create a 1.375 m 
long Single Vehicle Area that starts 4.5 m from the beginning of the path.

Figure 4-132: Single Vehicle Area Example – Upstream

Create and Edit Simulated Vehicles
This section describes how to show/hide simulated vehicles in the Configuration Tree and 
how to define and edit simulated vehicles in the Node Controller Configuration File. 
Simulated vehicles are required only when a node controller is being used as a high-level 
controller simulator for development (see the MagneMotion Node Controller Interface User 
Manual, publication MMI-UM001).

NOTE: Simulated Vehicles are hidden by default. Use the View menu in the Configuration 
Menu Bar, select Show Single Vehicle Areas to display them.

Show Simulated Vehicles

1. Enable the simulated vehicles option by selecting the Show Simulated Vehicles 
option in the View menu in the Configurator Menu Bar.

A check mark is displayed before the Show Simulated Vehicles, see Figure 4-133, to 
indicate it is selected. When a path is expanded, the Simulated Vehicles element is 
listed.

Figure 4-133: Show Simulated Vehicles Option Selected

NOTE: The Show Simulated Vehicles selection is not saved in the Node Controller 
Configuration File and always defaults to cleared (unchecked) when the 
Configurator is started. However, if there are simulated vehicles in a Node 

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um001_-en-p.pdf
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Controller Configuration File it defaults to selected (checked) after the 
Configuration File is loaded.

Create a Simulated Vehicle

1. Enable the simulated vehicles option by selecting the Show Simulated Vehicles 
option in the View menu in the Configurator Menu Bar.

2. Expand the list of paths in the Configuration Tree by selecting the symbol in front of 
Paths or double-clicking Paths.

The list of paths is expanded and displayed below Paths in the Configuration Tree.

3. Expand the path where the simulated vehicle is going to be added by selecting the 
symbol in front of its Simulated Vehicle ID or double-clicking its name.

The path is highlighted and expands to show Motors, Stations, Single Vehicle Areas, 
and Simulated Vehicles related to the path.

4. In the Configuration Tree, select Simulated Vehicles, see Figure 4-134.

Figure 4-134: Configuration Tree with Simulated Vehicles Selected

5. On the Edit menu in the Configurator Menu Bar, select Add To End... (or right-click 
on Simulated Vehicles and select Add To End...).

The list of simulated vehicles is expanded and displayed below Simulated Vehicles in 
the Configuration Tree, see Figure 4-135 with the new simulated vehicle added to the 
list. The simulated vehicle is automatically numbered with the next Simulated Vehicle 
ID.

Figure 4-135: Configuration Tree Showing Simulated Vehicle Added
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Edit a Simulated Vehicle

1. Expand the list of paths in the Configuration Tree by selecting the symbol in front of 
Paths or double-clicking Paths.

The list of paths is expanded and displayed below Paths in the Configuration Tree.

2. Expand the path where the simulated vehicle to be edited is located by selecting the 
symbol in front of its Simulated Vehicle ID or double-clicking its name.

The path is highlighted and expands to show Motors, Stations, Single Vehicle Areas, 
and Simulated Vehicles related to the path.

3. Expand the simulated vehicles section by selecting the symbol in front of Simulated 
Vehicles or double-clicking Simulated Vehicles.

Simulated Vehicles is highlighted and the list of simulated vehicles is expanded to 
show all simulated vehicles on the path.

4. Open the Simulated Vehicle to be edited by selecting it.

The Simulated Vehicle Details page for the selected simulated vehicle is displayed in 
the Configuration Settings Pane, see Figure 4-136. This page identifies the path that 
the simulated vehicle is associated with.

Figure 4-136: Simulated Vehicle Page

5. Update the parameters for the simulated vehicle as required (see Simulated Vehicles on 
page 273 for detailed descriptions of all parameters).

6. Select Save XML Config on the File menu in the Configurator Menu Bar.
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Example

Figure 4-137 shows a typical Simulated Vehicle located 1.5 meters from the beginning of 
Path 1.

Figure 4-137: Simulated Vehicle Example

Define and Edit E-Stops
When using node controllers equipped with digital I/O ports, the I/O ports can be connected 
directly to an E-Stop circuit. An E-Stop is a user-supplied button (typically locking) that an 
operator can press if an emergency situation arises to halt all motion on any specified paths. 
When the node controller detects that the E-Stop button is activated, it commands all paths 
that are associated with that E-Stop to suspend vehicle movement. All motors on those paths 
suspend vehicle target requests and permission granting, and all vehicles come to a controlled 
stop and are held in position by the motors at their last granted position. Stopping time for 
each vehicle is dependent on the mass of the vehicle, the payload, and the acceleration setting 
of its current movement command.

 

This section describes how to define and edit E-Stops (Emergency Stops) in the Node 
Controller Configuration File. See the MagneMotion Node Controller Hardware User 
Manual, publication MMI-UM013, to wire the transport system to use an E-Stop.

Multiple E-Stop circuits can be connected to one node controller. Each path can then be 
configured to be associated with a specific E-Stop bit. Any or all paths can be associated with 
the same E-Stop bit. One E-Stop circuit can have multiple buttons that are wired together in 
series so that pressing any button initiates an E-Stop. The same E-Stop circuit can be used for 
multiple paths on different node controllers by wiring the E-Stop circuit to each node 
controller in series. It can be wired to a maximum of eight node controllers and reference the 
appropriate digital input bit on each path. See the MagneMotion Node Controller Hardware 
User Manual, publication MMI-UM013, for more details.

NOTE: This function is equivalent of sending a suspend command from the host.

NOTICE The E-Stop is cleared by releasing the button that was
pressed and issuing a Resume command.

SHOCK HAZARD: The E-Stop only executes the actions
that are described, it is not the same as an EMO
(Emergency Off) which removes all power to the
transport system.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
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Define an E-Stop

1. Expand the list of paths in the Configuration Tree by selecting the symbol in front of 
Paths or double-clicking Paths.

The list of paths is expanded and displayed below Paths in the Configuration Tree.

2. Open the path where the E-Stop is going to be located by selecting the Path ID.

The Path Details page for the selected path, see Figure 4-138, is displayed in the 
Configuration Settings Pane.

Figure 4-138: Adding an E-Stop to a Path

3. From the E-Stop Bit Number drop-down list, select the digital input bit to use for the 
E-Stop.

NOTE: Maintain a log of digital I/O bits used on each node controller. Use the log to 
make sure that a bit is not configured for multiple uses and that all 
connections for a path use the same node controller.

4. Add the E-Stop to other paths that are connected to the node controller as required by 
setting the E-Stop Bit Number to the same input bit being used for the E-Stop.

5. Select Save XML Config on the File menu in the Configurator Menu Bar.

Edit an E-Stop

1. Expand the list of paths in the Configuration Tree by selecting the symbol in front of 
Paths or double-clicking Paths.
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The list of paths is expanded and displayed below Paths in the Configuration Tree.

2. Open the path where the E-Stop to be edited is located by selecting the Path ID.

The Path Details page for the selected path, see Figure 4-139, is displayed in the 
Configuration Settings Pane.

Figure 4-139: Editing an E-Stop on a Path

3. Change the E-Stop bit by selecting the new digital input bit to use for the E-Stop from 
the E-Stop Bit Number drop-down list.

NOTE: Update the log of digital I/O bits used on each node controller. Verify that 
bits are not configured for multiple uses and that all connections for a path 
use the same node controller.

4. Update the E-Stop on other paths that are connected to the node controller as required 
by setting the E-Stop Bit Number to the same input bit being used for the E-Stop.

5. Select Save XML Config on the File menu in the Configurator Menu Bar.

Define and Edit Interlocks
When using node controllers equipped with digital I/O ports, the I/O ports can be connected 
directly to an interlock circuit. An interlock is a user installed circuit that another piece of 
equipment in the facility can activate to halt all motion on any specified paths temporarily. 
When the node controller detects that the interlock circuit is activated, it commands all paths 
that are associated with that interlock to suspend vehicle movement. All motors on those paths 
suspend vehicle target requests and permission granting, and all vehicles come to a controlled 
stop and are held in position by the motors. Stopping time for each vehicle is dependent on the 
mass of the vehicle, the payload, and the acceleration setting of its current movement 
command. The interlock is cleared by deactivating the interlock circuit.

This section describes how to define and edit interlocks in the Node Controller Configuration 
File. See the MagneMotion Node Controller Hardware User Manual, publication 
MMI-UM013, to wire the transport system to use an interlock.

Multiple interlock circuits can be connected to one node controller. Each path can then be 
configured to a specific interlock bit. Any or all paths can be associated with the same 

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
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interlock bit. The same interlock circuit can be used for multiple paths on different node 
controllers by wiring the interlock circuit to each node controller in series. A maximum of 
eight node controllers can be wired to reference the appropriate digital input bit on each path. 
See the MagneMotion Node Controller Hardware User Manual, publication MMI-UM013, 
for more details.

NOTE: This function is equivalent to sending a suspend command from the hos

Define an Interlock

1. Expand the list of paths in the Configuration Tree by selecting the symbol in front of 
Paths or double-clicking Paths.

The list of paths is expanded and displayed below Paths in the Configuration Tree.

2. Open the path that is going to be interlocked by selecting the Path ID.

The Path Details page for the selected path, see Figure 4-140, is displayed in the 
Configuration Settings Pane.

SHOCK HAZARD: The Interlock only executes the
actions that are described, it is not the same as an EMO
(Emergency Off) which removes all power to the
transport system.

AUTOMATIC MOTION HAZARD: Movement of the
vehicles on the transport system is automatically resumed
when the interlock is cleared, which could result in
personal injury.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
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Figure 4-140: Adding an Interlock to a Path

3. From the Interlock Bit Number drop-down list, select the digital input bit to use for 
the interlock.
NOTE: Maintain a log of digital I/O bits used on each node controller. Use the log to 

make sure that a bit is not configured for multiple uses and that all 
connections for a path use the same node controller.

4. Add the interlock to other paths that are connected to the node controller as required 
by setting the Interlock Bit Number to the same input bit being used for the interlock.

5. Select Save XML Config on the File menu in the Configurator Menu Bar.

Edit an Interlock

1. Expand the list of paths in the Configuration Tree by selecting the symbol in front of 
Paths or double-clicking Paths.
The list of paths is expanded and displayed below Paths in the Configuration Tree.

2. Open the path where the interlock to be edited is located by selecting the Path ID for 
that path.
The Path Details page for the selected path, see Figure 4-141, is displayed in the 
Configuration Settings Pane.
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Figure 4-141: Editing an Interlock on a Path

3. Change the interlock bit by selecting the new digital input bit to use for the interlock 
from the Interlock Bit Number drop-down list.

NOTE: Update a log of digital I/O bits used on each node controller. Verify that bits 
are not configured for multiple uses and that all connections for a path use 
the same node controller.

4. Update the interlock on other paths that are connected to the node controller as 
required by setting the Interlock Bit Number to the same input bit being used for the 
interlock.

5. Select Save XML Config on the File menu in the Configurator Menu Bar.
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UI Reference 5

Overview
This chapter provides an overview of the User Interface (UI) for the MagneMotion® 
Configurator. Examples of each window, page, and dialog in the UI and descriptions of their 
features are included. The following parts of the User Interface are covered:

• User Interface Layout.

• User Interface Features.

• Dialog Box Reference.

• System Layout, including; the menu, layout options, and the track layout area.

• Configuration, including the menus and all configuration settings.

NOTE: Specific builds of the MagneMotion Configurator may not implement all the 
features that are described in this manual. See the Release Notes that are supplied 
with this application for more information. 

Download firmware, associated files (such as AOP, EDS, and DTM), and access 
product release notes at rok.auto/pcdc.

https://rok.auto/pcdc
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Interface Layout
All User Interface elements that are presented through the MagneMotion Configurator 
window follow the guidelines that are described in this chapter. The UI elements consist of 
three main areas that are always visible, see Figure 5-1. Additional windows that are opened 
through the UI can be positioned as desired.

Figure 5-1: Window Layout

Window Behavior
• Window Size – The window can be sized as required, it opens at its default size and 

location each time the MagneMotion Configurator is started.

• Pane Size – The bar between the Configuration Tree and the System Layout Pane and 
Configuration Settings Panes can be moved horizontally as required. The bar returns 
to its default location each time the MagneMotion Configurator is started.

The bar between the System Layout Pane and the Configuration Settings Pane can be 
moved vertically as required. The bar returns to its default location each time the 
MagneMotion Configurator is started.

MagneMotion Configurator Menu Bar and Window Controls

Configuration Settings Pane

Configuration Tree

System Layout Pane

Layout Toolbar

Track 
Symbols 

Area
NOTE: The Layout Toolbar, Track Symbols 

Area, and System Layout Pane only 
exist in a MM Lite Configuration.
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User Interface Features

Dialog Boxes

A dialog box, see Figure 5-2, is used to select options, input information, and start operations. 
Dialog boxes are displayed when certain functions (for example, buttons that allow user input) 
are selected in the current window or dialog box. The dialog box that is displayed depends on 
the type of input that is required.

To close a dialog box and save the selection, select the button for that action (Open, OK, and 
so on). To close a dialog box without saving, select Cancel.

NOTE: When certain dialog boxes are open, no actions are permitted until the dialog box is 
closed.

Figure 5-2: Dialog Box Example

Messages

Messages, see Figure 5-3, are used to display information, to confirm user input, or to warn of 
user input is invalid. The Configurator automatically displays these messages when a 
restricted operation is attempted, or when some important operational information must be 
conveyed.

• Single-button messages provide a descriptive message that is related to the previously 
selected action. Select the OK to close the message after reading.
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• Multi-button messages provide a descriptive message that is related to the previously 
selected action and options for response to the message. Select one of the options to 
close the message after reading.

NOTE: When certain messages are open, no actions are permitted until the message is 
closed.

Figure 5-3: Message Examples

Dialog Box and Window Elements

Checkboxes, see Figure 5-4, are used to turn an option on or off by selecting (checking) or 
clearing (unchecking) the box. In those areas where multiple checkboxes are presented, 
multiple checkboxes can be selected.

Figure 5-4: Checkbox Example

Drop-down menus or list, see Figure 5-5, are used to select one option from a list of available 
options. A drop-down menu or list is used when no confirmation of the selection is required; 
after an option is selected, it is immediately activated.

Figure 5-5: Drop-down Menu Examples

Single Button Message Multi-Button Message

Drop-Down Menu

Drop-Down List
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Text fields, see Figure 5-6, are used to enter variable information, such as names, setpoints, 
and position values. Display fields, see Figure 5-6, are used to display fixed and variable 
information, such as property names and values returned from the controlled components.

Figure 5-6: Text and Display Field Example

Each window, dialog box, and message contain graphical buttons (see Figure 5-7) that are 
used to perform various actions, including:

• Initiating an action.

• Changing the display.

• Opening dialog boxes, menus, or windows.

Figure 5-7: Button Example

Window and Dialog Box Reference
This reference provides a detailed description of each window, page, and dialog box displayed 
by the MagneMotion Configurator. All windows, menus, and dialog boxes in this reference 
are listed in functional order.

The MagneMotion Configurator is software that is used to create and edit the node_
configuration.xml file, which is used to configure the transport system for operation.

NOTICE Fields containing invalid or improperly formatted values
are outlined in red. If you hover over an invalid field, the
error message appears. 

Display Field

Text Field

Arrow Button
(Open Drop-Down List)

Command Button
(Initiate Action)
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Main Window

The Main Window for the MagneMotion Configurator, see Figure 5-8. This window provides 
access to all functions of the software. All window functions are described after the figure.

The Main Window provides access to the configuration menus in the Configurator Menu Bar 
at the top of the window, to the items in the Configuration Tree, and to the items displayed in 
the System Layout and Configuration Settings Panes. The function of each item in the 
Configuration Tree, the System Layout, and Configuration Settings Panes are described in this 
chapter along with all menu options and configuration settings.

Figure 5-8: MagneMotion Configurator Main Window Overview

• Configurator Menu Bar – Provides access to configuration and common functions.

• Configuration Tree – Displays a list of the configuration categories and elements. A 
category or element with a hollow triangle symbol ( ) in front of it indicates that it 
can be expanded to show more related categories or specific elements (select the 
symbol or double-click the name). A category or element with a filled triangle symbol 
( ) in front of it indicates that it can be collapsed to hide the related categories or 
elements (select the symbol or double-click the name).

Configuration Tree
Configurator Menu Bar

Configuration Settings Pane

Track Symbols Area
Layout Toolbar

System Layout Pane
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• System Layout Pane – Displays a graphic configuration tool for creating a graphical 
representation of the transport system layout for MM Lite. The pane is divided into 
three sections; the Layout Toolbar, the Track Symbols Area, and the Layout Area.

• Layout Toolbar – Provides access to track layout functions.

• Configuration Settings Pane – Displays the page of settings that are associated with 
the category or element that is selected in the Configuration Tree.

• Track Symbols Area – The area of the System Layout Pane that is available for MM 
Lite to access the symbols that are used to create the track layout.

System Layout Pane for MM Lite
The System Layout Pane (see Figure 5-9), provides a configuration tool for creating a 
graphical representation of the transport system layout for MagneMover Lite. The pane is 
divided into three sections; the Layout Toolbar, the Track Symbols Area, and the Layout Area.

Figure 5-9: System Layout Pane

Track Symbols AreaLayout Toolbar Layout Area
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Layout Toolbar

The Layout Toolbar, see Figure 5-10, at the top of the System Layout Pane (see Figure 5-9) 
provides drop-down menus for access to the track layout functions, see Table 5-1.

Figure 5-10: Layout Toolbar

Table 5-1: Layout Toolbar Descriptions

Symbol Name Function

Undo Undo the last action.

Redo Redo the last action.

Cut Copy the selected symbol to the Windows® 
Clipboard and delete it from the track layout.

Copy Copy the selected symbol to the Windows 
Clipboard.

Paste Paste the most recent addition to the Windows 
Clipboard to the track layout.

Duplicate Create a copy of the selected symbol and paste it to 
the track layout.

Zoom In Enlarge the track layout centered around the center 
of the display.

Zoom Out Reduce the track layout centered around the center 
of the display.

Toggle Grid Lines Changes the visibility of the grid lines.

 Global Settings Opens a dialog box for selection of system-wide 
configuration settings as described in Global 
Settings on page 47.
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Figure 5-11: Global Layout Settings

Place The Nodes  Automatically places Merge, Diverge, 
Merge-Diverge, Simple, and Terminus nodes. Node 
placement is based on the manual placement of one 
Merge, Diverge, Simple, or Terminus node.

Walk The Paths Clears any existing configuration information then 
automatically places Merge, Diverge, 
Merge-Diverge, Simple, and Terminus nodes. Node 
placement is based on the manual placement of one 
Merge, Diverge, Simple, or Terminus node. 
Populates the Configuration Tree with a new 
Configuration that is based on the layout.

Clear Path Indicators Clears the path indicators added to the track layout 
after running Walk the Paths.

Rotate Left Rotates each selected symbol counter-clockwise 
90°. When rotating multiple symbols, they are not 
rotated as a group, but instead each individual 
symbol is rotated around its own center. Symbols 
cannot be rotated if they are snapped to other 
symbols.

Rotate Right Rotates each selected symbol clockwise 90°. When 
rotating multiple symbols, they are not rotated as a 
group, but instead each individual symbol is rotated 
around its own center. Symbols cannot be rotated if 
they are snapped to other symbols.

Table 5-1: Layout Toolbar Descriptions (Continued)

Symbol Name Function
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Track Layout Options

The Track Symbols Area on the left of the System Layout Pane (see Figure 5-9) provides 
access to the symbols and tools that are used to create and control the track layout (see 
Figure 5-12). See Track Layout on page 44 for usage.

Figure 5-12: Track Symbols Area

• View Style – Options are provided to control the display of the track layout symbols. 
The default is Icons and Details.
• Icons and Details – Shows half-size icons, titles, and a description.
• Icons and Names – Shows half-size icons and titles.
• Icons Only – Shows only the symbol icons.
• List – Shows small icons and titles.

Group Combines the selected symbols into one object. 
Grouped symbols can be moved, rotated, or flipped 
as a group.

Ungroup Releases all symbols from the selected group.

Table 5-1: Layout Toolbar Descriptions (Continued)

Symbol Name Function
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• Thumbnails – Shows full-size icons and titles.

• MM Lite Track Symbols: The set of icons that are available for creating a transport 
system layout in the Layout Area.

Dimension Line: Provides a line where both ends can 
be positioned as required to measure the track layout.

Text: Provides a box that can be positioned as required 
for text entry. After positioning the icon, double-click 
to edit the text and right-click to edit the text 
properties.
Forward Direction: Provides an arrow to show the 
direction forward motion of the vehicle.

1 Meter Straight LSM: Provides a 1 meter motor 
symbol that can be positioned as required in the track 
layout. Right-click on the symbol to identify the motor 
as a Sync or air-cooled version.
1/4 Meter Straight LSM: Provides a 1/4 meter motor 
symbol that can be positioned as required in the track 
layout. Right-click on the symbol to open a dialog box 
to identify the motor as a Sync or air-cooled version.
90° Curve LSM: Provides a 90° curve motor symbol 
that can be positioned as required in the track layout. 
Right-click on the symbol to open a dialog box to 
identify the motor as a Sync or air-cooled version.
Left Switch LSM: Provides a left switch symbol that 
can be positioned as required in the track layout. Not 
available when precision rails are selected. Right-click 
on the symbol to open a dialog box to select standard 
or high payload.
Right Switch LSM: Provides a right switch symbol 
that can be positioned as required in the track layout. 
Not available when precision rails are selected. 
Right-click on the symbol to open a dialog box to 
select standard or high payload.
Precision Rail Straight: Provides a straight precision 
rail symbol that can be positioned as required in the 
track layout. Only available when precision rails are 
selected
90° Rail Curve: Provides a 90° precision rail curve 
symbol that can be positioned as required in the track 
layout. Only available when precision rails are 
selected.
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180° Rail Curve: Provides a 180° curve rail symbol 
that can be positioned as required in the track layout. 
Only available when precision rails are selected.

Leg: Provides a symbol that can be positioned as 
required in the track layout to indicate the position of 
legs. Right-click on the symbol to open a dialog box to 
specify the quantity of lanes being supported.
SYNC IT™ Controller: Provides a symbol that can 
be positioned as required in the track layout. 
Right-click on the symbol to open a dialog box to 
specify the quantity of Sync cables required (one per 
Sync motor).
Node: Provides a node identification symbol that can 
be positioned as required in the track layout.

Precision Locator: Provides a Precision Locators 
symbol that can be positioned as required in the track 
layout. Right-click on the symbol to open a dialog box 
to change the locator options.
Vehicles: Provides a box to show the number and type 
of vehicles being used in the track layout for individual 
material transport. Right-click on the symbol to open a 
dialog box to change the vehicle quantity and other 
options.
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Layout Area

The Layout Area for the transport system layout (see Figure 5-13), on the right of the System 
Layout Pane, provides space for the creation of the transport system layout.

Figure 5-13: Layout Area

• Ruler – Provides measurements in millimeters.

• Cursor Position – Red line on each ruler that shows the current location of the cursor.

• Background – Gridded area for positioning of the symbols that are used to create the 
track layout. It automatically expands to include new symbols as required.

Ruler

Cursor
Position

Background

Cursor
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Configuration
The MagneMotion Configurator, see Figure 5-14, provides a configuration tool for creating 
the Node Controller Configuration File for the transport system. The window is divided into 
three sections; the Configurator Menu Bar, the Configuration Tree, and the Configuration 
Settings Pane. Selecting a configurable item in the Configuration Tree displays the settings 
that are associated with the item in the Configuration Settings Pane.

Figure 5-14: Configuration Tree and Configuration Pane

Configurator Menu Bar

The Configurator Menu Bar, see Figure 5-15, at the top of the MagneMotion Configurator, 
provides drop-down menus for access to various configuration functions, see Figure 5-16. All 
Edit menu functions are also available on shortcut menus that are accessed by right-clicking 
on a Category or Element in the Configuration Tree.

Figure 5-15: Configurator Menu Bar

Configuration Tree
Configurator Menu Bar

Configuration Settings Pane



UI Reference
Configuration

Rockwell Automation Publication MMI-UM046A-EN-P - May 2023 197

Figure 5-16: Configurator Menus

File
• New NDX Layout – creates a new track layout file for MM Lite in the System Layout 

Pane.

• Open NDX Layout…– opens an existing track layout file for MM Lite in the System 
Layout Pane.

• Save NDX Layout – Saves the existing track layout file.

• Save NDX Layout As… – Opens a dialog box to name and save a new track layout 
file.

• New XML Config– Creates a Node Controller Configuration File that contains only 
the default values for the Global Settings.

• Open XML Config... – Opens a dialog box to locate and open an existing Node 
Controller Configuration File.

• Check Data Validation – Checks that all parameter values are within the correct 
range. Generates a notification of all values correct, or a notification indicating which 
values are invalid/out of range.

• System Type – Expandable list to choose motor type (MagneMover® Lite™, 
QuickStick®, or QuickStick HT™)

• Export – Expandable list to choose export options

File Menu (MM Lite)

Edit Menu

File Menu (QuickStick and QSHT)

Help MenuView Menu
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• NDX Layout to PDF – exports the track layout file that is used for MM Lite™ 
to PDF.

• NDX Layout to BMP – exports the track layout file that is used for MM Lite 
to BMP.

• Create MMTRK file from Config – Opens a dialog box for creation of a 
Track File that represents the current configuration for use with the NCHost 
TCP Interface Utility. Available for MM Lite only.

• Exit – Closes the MagneMotion Configurator. The Node Controller Configuration File 
is not saved and any changes that are made since the last save are discarded.

Edit

• Insert Before... – Adds another element of the selected type before the selected 
element. Also available through a shortcut menu.

• Insert After... – Adds another element of the selected type after the selected element. 
Also available through a shortcut menu.

• Add To End... – Adds another element of the selected type to the end of the list of 
elements. Also available through a shortcut menu.

• Cut – Copies the current values of all settings from the selected element to an internal 
clipboard and deletes the element. Only available for elements that do not have 
sub-elements. Also available through a shortcut menu.

• Copy – Copies the current values of all settings from the selected element to an 
internal clipboard. Only available for elements that do not have sub-elements. Also 
available through a shortcut menu.

Table 5-1: Menu Definitions and Short-cut Keys

Menu Action Short-cut

File New XML Config Ctrl+N

Open XML Config Ctrl+O

Save XML Config Ctrl+S

Edit Insert Before Ctrl+Shift+I

Insert After Ctrl+I

Add to End Ctrl+E

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Delete Del (Delete)
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• Paste – Pastes the current values of all cut or copied settings on the internal clipboard 
to the selected element. The element being pasted to must be the same type as the 
element that was copied. Only available for elements that do not have sub-elements. 
Also available through a shortcut menu.

• Delete – Deletes the selected element from the Configuration Tree. Also available 
through a shortcut menu.

View
• Show Per Motor Control Loop Parameters – Displays the Control Loop Parameter 

sets for each motor on its Motor page when selected.

• Show Stations – The Stations option is displayed under Paths in the Configuration 
Tree when selected. 

• Show Single Vehicle Areas – The Single Vehicle Areas option is displayed under 
Paths in the Configuration Tree when selected.

• Show Simulated Vehicles – The Simulated Vehicles option is displayed under Paths 
in the Configuration Tree when selected.

• European Number Formatting – Changes the formatting of all numbers that are 
displayed to European formatting (one thousand = 1.000,00) when selected.

Help
• About MagneMotion Configurator – Displays the MagneMotion Configurator 

version information.

Figure 5-17: About MagneMotion Configurator Message
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Shortcut Menus

The shortcut menus for the Configurator, which are accessed by right-clicking on a Category 
that has Elements or on an Element in the Configuration Tree, see Figure 5-18.

Figure 5-18: Configurator Shortcut Menus

Add Shortcut Menu

Available when right-clicking on paths, motors, stations, single vehicle areas, simulated 
vehicles, nodes, or node controllers in the Configuration Tree.

• Add To End... – Adds another element of the selected type to the end of the list of 
elements. Also available through a shortcut menu.

Edit Shortcut Menu

Available when right-clicking on a specific motor, station, single vehicle area, simulated 
vehicle, node, or node controller in the Configuration Tree.

• Insert Before... – Adds another element of the selected type before the selected 
element.

• Insert After... – Adds another element of the selected type after the selected element.

• Cut... – Copies the current values of all settings from the selected element to an 
internal clipboard and deletes the element.

• Copy... – Copies the current values of all settings from the selected element to an 
internal clipboard.

• Paste... – Pastes the current values of all cut or copied settings on the internal 
clipboard to the selected element. The element being pasted to must be the same type 
as the element that was copied.

• Delete... – Deletes the selected element from the Configuration Tree.

Insert Shortcut Menu

Available when right-clicking on a specific path in the Configuration Tree.

• Insert Before... – Adds another element of the selected type before the selected 
element.

• Insert After... – Adds another element of the selected type after the selected element.

• Delete... – Deletes the selected element from the Configuration Tree.

Insert Shortcut MenuAdd Shortcut Menu Edit Shortcut Menu Copy Shortcut Menu
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Copy Shortcut Menu

Available when right-clicking on the Motor Defaults for a path in the Configuration Tree.

• Copy... – Copies the current values of all settings from the selected element.

• Paste... – Pastes the current values of all cut or copied settings on the internal 
clipboard to the selected element. The element being pasted to must be the same type 
as the element that was copied.

Global Settings

Global Settings are settings that apply to all parts of the transport system (motors, nodes, 
vehicles, and so on). The Global Settings page with Advanced Parameters selected (see 
Figure 5-19), is accessed by selecting the Global Settings category at the top of the 
Configuration Tree. See Configure Global Settings on page 75 for usage.

Figure 5-19: Global Settings Page with Advanced Parameters (MM Lite)
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Figure 5-20: Global Settings Page with Advanced Parameters (QuickStick)

Figure 5-21: Global Settings Page with Advanced Parameters (QSHT)
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Table 5-2: Global Setting Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

Configuration 
Name 

An optional name for the configuration for reference. 
If entered, this name is used to identify log files. Valid 
characters are: a…z, A…Z, 0…9, ~!@#$%^*()_
+`-={}|:"?[]\;',./ and space (64 characters maximum).

X X X

Acceleration 
Limit 

Maximum acceleration/deceleration for all vehicles 
while they are on the transport system. The HLC 
rejects any vehicle motion commands that exceed this 
limit. The maximum acceleration can be set to any 
value within the limits of the transport system. The 
default is 2.0 m/s2 (this value is system-dependent, 
see Related Documentation on page 11 for the list of 
motor user manuals).

X X X

Velocity Limit Maximum velocity for all vehicles while they are on 
the transport system. The HLC rejects any vehicle 
motion commands that exceed this limit. The 
maximum velocity can be set to any value within the 
limits of the transport system. The default is 2.0 m/s 
(this value is system-dependent, see (this value is 
system-dependent, see Related Documentation on 
page 11 for the list of motor user manuals).

X X X

Terminus 
Acceleration 

This setting applies only when there are Terminus 
nodes in the transport system and defines the 
acceleration/deceleration of the vehicle in the 
Terminus node as it enters and before it receives it's 
initial order. The maximum acceleration can be set to 
any value within the limits of the transport system. 
The default is 1.0 m/s2.

X X X

Terminus 
Velocity 

This setting applies only when there are Terminus 
nodes in the transport system and defines the velocity 
of the vehicle in the Terminus node as it enters and 
before it receives it's initial order. The maximum 
velocity can be set to any value within the limits of 
the transport system. The default is 0.5 m/s.

X X X
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Arrival Position 
Tolerance 

For all paths, the maximum distance that the vehicle 
can deviate from the actual destination for the HLC to 
consider the vehicle as arrived at its destination by 
monitoring motor status updates. If the tolerance is set 
too small, and the vehicle cannot stop within that 
tolerance, then the vehicle appears to have not arrived 
at its position and the transport system continues 
trying to move the vehicle to its destination. The 
default is 0.010 m.

X X X

NOTE: The Arrival Position Tolerance and Arrival Velocity Tolerance settings in the Global Settings are 
used to trigger an asynchronous vehicle status message to the host controller that provides the 
current position of the vehicle. A vehicle is not considered to have arrived at its destination by the 
HLC (even if the Arrival Position Tolerance is met) if the Arrival Velocity Tolerance is not met. 
When running Demo Scripts (see the MagneMotion NCHost TCP Interface Utility User Manual, 
publication MMI-UM010) setting the Arrival Position Tolerance to a large value (for example, 1.0 
m) and setting the Arrival Velocity Tolerance to the system Velocity Limit supersedes the motor 
settings and allows uninterrupted motion as the system considers the vehicle to have arrived when 
it nears its target position, which allows the start of the next vehicle command for the vehicle 
without having the vehicle slow or stop.

Arrival Velocity 
Tolerance 

For all paths, the maximum velocity of a vehicle for 
the HLC to consider the vehicle as not moving by 
monitoring motor status updates. If the tolerance is 
set too small, and the velocity of the vehicle is not 
within the tolerance, the vehicle appears to have not 
arrived at its destination and the transport system 
continues trying to move the vehicle to its destination. 
The default is 0.020 m/s.
If a Reset command is sent to the node controller via 
the host controller interface, vehicles are commanded 
to stop and are not considered stopped until within 
this tolerance. If on a Reset command, all vehicles do 
not come to a stop within 5 seconds the node 
controller resets the motors, which means they stop 
applying stopping force to the vehicles.

X X X

NOTE: The Arrival Velocity Tolerance and the Arrival Position Tolerance are used together to make sure 
that the vehicle has arrived. A vehicle is not be considered to have arrived at its destination by the 
HLC (even if the Arrival Velocity Tolerance is met) if the Arrival Position Tolerance is not met.
When running Demo Scripts (see the MagneMotion NCHost TCP Interface Utility User Manual, 
publication MMI-UM010) setting the Arrival Velocity Tolerance to the system Velocity Limit and 
setting the Arrival Position Tolerance to a large value (for example, 1.0 m) supersedes the motor 
settings and allows uninterrupted motion as the system considers the vehicle to have arrived when 
it nears its target position, which allows the start of the next vehicle command for the vehicle 
without having the vehicle slow or stop.

Table 5-2: Global Setting Parameters (Continued)

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT
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TCP Host 
Disconnect 
Action 

Identifies the action to be taken on all paths, in the 
event the TCP/IP interface to the host controller 
disconnects. The default is Suspend.
None: No action is performed when a disconnect 
occurs.
Suspend: Directs all motors on the specified paths to 
suspend vehicle target requests and permissions and 
causes all vehicles to come to a controlled stop. After 
the vehicle is stopped, the motors hold the vehicles in 
position. Stopping time for each vehicle is dependent 
on the mass of the vehicle, the payload, and the 
acceleration setting of its current movement 
command.
FastStop*: Directs all motors on the specified paths 
to apply maximum thrust, opposite to the current 
direction of motion for the vehicles on those paths.

X X X

Obstructed Status 
Notification 

Select to have the HLC automatically send Vehicle 
Status (0xD5) messages that indicate a vehicle is 
obstructed sent asynchronously using the TCP/IP 
communications protocol whenever a vehicle 
becomes obstructed. Vehicles are obstructed when 
they are unable to acquire permission to move further 
because of a vehicle in the way, a hardware fault, or 
movement is suspended. The default is cleared (off).

X X X

NOTE: If enabled, this option can result in many Obstructed Vehicle Status messages being sent when 
vehicles are in a queue.
If not enabled, the host controller must poll the HLC for vehicle status information.
This setting does not apply to the EtherNet/IP™ communications protocol.

Send Node Status 
Asynchronously 

Select to have Node Status (0xD3) messages that 
indicate a change in a node sent asynchronously using 
the TCP/IP communications protocol whenever a 
node changes state. Nodes are considered to change 
state whenever a vehicle enters/exits the node, a 
switch changes position, and so on. The default is 
cleared (off).

X X X

NOTE: If enabled, this option can result in many node status messages being sent whenever any node 
changes state.
If not enabled, the host controller must poll the HLC for node status information.
This setting does not apply to the EtherNet/IP communications protocol.

Table 5-2: Global Setting Parameters (Continued)

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT
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Terminus Entry 
Clear Enable 

Select to enable support for the Terminus ENTRY_
CLEAR bit in the Node Status response from the 
HLC for handshaking Terminus nodes. If not selected, 
Terminus node operation remains unchanged with 
this bit masked to be always Off. The default is 
cleared (off).

X X X

Enable TCP 
Control Port 
Indefinitely 

Select to enable the TCP/IP control port. The default 
is selected (on). 
TCP Control Port Enable: Must be selected for the 
TCP/IP control port to remain active indefinitely. 
TCP Control Port Timeout: Used when the TCP/IP 
control port enable is off. Provides a window of 
access at boot time before the TCP/IP control port is 
disabled. 
The maximum timeout is 60 minutes. The default is 0 
min (no timeout).

X X X

HLC To NC Link 
Disconnect 
Action

Identifies the action to be taken on all paths, in the 
event the high level controller cannot communicate 
with a node controller. The default is Suspend.
Suspend: Directs all motors on the specified paths to 
suspend vehicle target requests and permissions and 
causes all vehicles to come to a controlled stop. After 
the motor is stopped, the motors hold the vehicles in 
position. Stopping time for each vehicle is dependent 
on the mass of the vehicle, the payload, and the 
acceleration setting of its current movement 
command.
FastStop*: Causes all motors on the specified paths 
to apply maximum thrust, opposite to the current 
direction of motion for the vehicles on those paths. 

X X X

Table 5-2: Global Setting Parameters (Continued)

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT
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Propulsion Power 
Supplies

The propulsion power supply parameters in the 
Global Settings identify all Kinetix® 2198-Pxxx 
DC-bus power supplies being used with QSHT 5700 
Inverters. Only available for QSHT 5700 systems.
Add PS: Adds a row to the power supply list.
Remove Last PS: Removes the last row from the 
power supply list.
ID: A Configurator specified unique ID number for 
each power supply.
Type: Power supply type. Currently only DC-bus 
power supply is supported.
Name: An optional name for the power supply for 
reference.

— — X

NOTE: Once all Propulsion Power Supplies have been created, each QSHT 5700 motor must be 
associated with a power supply. To configure, set the Propulsion Power Supply ID field in the 
Motor Defaults or Motor #n in Path n pages under QSHT 5700 Motor Parameters. See Propulsion 
Power Supply ID in Table 5-6 on page 227 for more information.

Stop Moving 
Suspect Vehicles 

Select to have the system stop moving vehicles that 
have been manually moved out of position. The 
default is cleared (off).

X — —

* This option is not available for MagneMover Lite.

Table 5-2: Global Setting Parameters (Continued)

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT
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EtherNet/IP Settings
• EtherNet/IP is used to communicate with an Allen-Bradley® ControlLogix® controller 

that is being used as a host controller (see the MagneMotion Host Controller TCP/IP 
Communication Protocol User Manual, publication MMI-UM003 and MagneMotion 
Host Controller EtherNet/IP Communication Protocol User Manual, publication 
MMI-UM004). The EtherNet/IP Settings page (see Figure 5-22), is accessed by 
selecting the EtherNet/IP category from the Configuration Tree. See Set EtherNet/IP 
Settings on page 78 for usage.

NOTE: If the host controller is using TCP/IP communications, do not enable this option or 
change the EtherNet/IP settings.

Figure 5-22: EtherNet/IP Settings Page (MM Lite)

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um003_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um004_-en-p.pdf
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Figure 5-23: EtherNet/IP Settings Page (QucikStick)



UI Reference
Configuration

210 Rockwell Automation Publication MMI-UM046A-EN-P - May 2023

Figure 5-24: EtherNet/IP Settings Page (QSHT)

Table 5-3: EtherNet/IP Settings Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

Use an 
EtherNet/IP 
Controller for 
Host Control 

Select to enable control of the transport system via the 
EtherNet/IP protocol. The default is cleared (off). X X X

Controller IP 
Address 

The IP address of the EtherNet/IP interface in the host 
controller that the HLC (high-level controller) uses 
for communication.

X X X

Controller CPU 
Slot 

The slot in the host controller that contains the CPU 
module that the HLC communicates with. This slot 
can be any slot and is typically a value from 0 to 13. 
The default is Slot 0.

X X X
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Max Vehicle ID Maximum quantity of vehicle IDs that the HLC 
reports vehicle status to the tag memory in the host 
controller. Used to limit the size of the 
MMI_ vehicle_status array. The default is 64 (the 
maximum is system-dependent, see MagneMotion 
Node Controller Hardware User Manual, publication 
MMI-UM013).

X X X

NOTE: Vehicle IDs greater than the Max Vehicle ID value are not reported. The Max Vehicle ID value 
that is specified in the Global Settings page must be equal to or smaller than the Max Vehicle ID 
value to make sure that status is reported for all possible vehicle IDs.

Vehicle Records / 
Status Period 

The quantity of vehicle records to update in the host 
controller memory each time the HLC pushes vehicle 
status to the host controller memory. 
When using standard Vehicle Status, the maximum is 
224 and must be less than or equal to PLC Max 
Vehicle ID. The default is 32.
When using Extended Vehicle Status, the maximum is 
144 and must be less than or equal to PLC Max 
Vehicle ID. The default is 32.

X X X

Send Vehicle 
Status Period 

How often to send vehicle status records (defined in 
Vehicle Records per Status Period) to the host 
controller memory in milliseconds. The maximum is 
5000 ms (5 seconds). The default is 100 ms.
When using a host controller with a slower CPU, this 
value can be increased. Do not set this setting too low 
when using a larger Vehicle Records per Status Period 
as the EtherNet/IP link could be saturated with traffic. 
If the setting for Vehicle Records per Status Period is a 
low number (for example, 16 or less), decrease this 
parameter to get vehicle status updates that are at least 
as current as the data in HLC memory.

X X X

Table 5-3: EtherNet/IP Settings Parameters (Continued)

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
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Tag Request 
Retry Timeout 

Time the HLC must wait for the host controller to 
acknowledge a tag operation in milliseconds. The 
minimum is 50 ms. Increase this value for a high 
latency network. The default is 250 ms.
After three timeouts and retries of a tag request, the 
communications link is restarted. For fast low latency 
networks, this value can be lowered. For slow high 
latency networks, or when using a host controller 
with a slower CPU, this value can be increased to 
help prevent premature cycling of the link. The 
MMI_heartbeat tag is written at an interval three 
times (3x) this parameter (default every 750 ms).

X X X

Host Disconnect 
Action 

Identifies the action to be taken on all paths in the 
event the EtherNet/IP interface to the host controller 
disconnects. The default is None.
None: No action is performed when disconnect 
occurs.
Suspend: Directs all motors on the specified paths to 
suspend vehicle target requests and permissions and 
causes all vehicles to come to a controlled stop. After 
the motor is stopped, the motors hold the vehicles in 
position. Stopping time for each vehicle is dependent 
on the mass of the vehicle, the payload, and the 
acceleration setting of its current movement 
command.
FastStop*: Causes the motor software to apply 
maximum thrust, opposite to that of each vehicle’s 
current direction, halting each vehicle abruptly, and 
holding each vehicle at its halted position.

X X X

Enable NC 
Remote 
Management 

Select to push node controller remote management 
response tags to the host controller memory. This 
selection allows up to 20 Managed Node Controller 
Configuration Files to be uploaded for a system. A 
managed Node Controller Configuration File can be 
activated on the HLC, and distributed to all node 
controllers system wide. The default is cleared (off).

X X X

Enable Extended 
HLC Status 

Select to push extended HLC status tags to the host 
controller memory. The extended HLC status tag 
includes the software version, configuration ID, and 
configuration status of the HLC. The default is 
cleared (off).

X X X

Table 5-3: EtherNet/IP Settings Parameters (Continued)

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT



UI Reference
Configuration

Rockwell Automation Publication MMI-UM046A-EN-P - May 2023 213

Enable Extended 
NC Status 

Select to push extended node controller status tags to 
the host controller memory. The extended node 
controller status tag includes the software version, 
configuration ID, and configuration status of the node 
controllers. The default is cleared (off).

X X X

Enable Vehicle 
Commands 

Select to push vehicle command and response 
memory tags to the host controller memory. The 
vehicle subcommands supported include; Clear 
Suspect Bit, Delete Vehicle, and so on. The default is 
cleared (off).

X X X

Enable Digital 
I/O Commands 

Select to enable the send and receive for Digital I/O 
Commands between the host controller and the HLC. 
The default is cleared (off).

X X X

Use Extended 
Vehicle Status 

Select to use the MMI_extended_vehicle_status tag 
(see the MagneMotion Host Controller TCP/IP 
Communication Protocol User Manual, publication 
MMI-UM003 and MagneMotion Host Controller 
EtherNet/IP Communication Protocol User Manual, 
publication MMI-UM004). Clear to use the MMI_
vehicle_status tag. The default is cleared (off).

X X X

Enable System 
Monitoring 

Select to enable the use of the system monitoring 
UDTs. The default is cleared (off). X X X

Enable Traffic 
Lights 

Select to push and read traffic light command and 
response memory tags to the host controller memory. 
The default is cleared (off).
Max Traffic Light ID: Only enabled when Enable 
Traffic Lights is selected. Defines the maximum 
quantity of traffic lights to accommodate in the host 
controller memory. The default is 128.

X X X

Enable Motor 
Inverter 
Command †

Select to enable the use of the motor inverter control 
UDTs. Only available for QSHT 5700 systems. The 
default is cleared (off).

— — X

NOTE: This feature is only active on certain custom configurations.

Table 5-3: EtherNet/IP Settings Parameters (Continued)

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um003_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um004_-en-p.pdf
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See the MagneMotion Host Controller TCP/IP Communication Protocol User Manual, publication 
MMI-UM003 and MagneMotion Host Controller EtherNet/IP Communication Protocol User Manual, 
publication MMI-UM004 for additional information on using TCP/IP or EtherNet/IP communication 
protocols.

Enable Sensor 
Mapping †

Select to enable the use of the sensor-mapping UDTs. 
Only available for QSHT systems. The default is 
cleared (off).
Sensor Maps Paths / Push Period: Only enabled 
when Enable Sensor Mapping is selected. Specifies 
the quantity of paths to update in the host controller 
memory each time the HLC pushes QuickStick HT 
motor sensor map data to the host controller memory. 
The default is 8.
Sensor Map Push Period: Only enabled when 
Enable Sensor Mapping is selected. Specifies the 
period (in milliseconds) to send the next batch of 
QuickStick HT motor sensor map data to the host 
controller memory. The default is 1000 ms.

— — X

Enable 
Propulsion 
Power†

Select to push propulsion power supply status tags to 
the host controller memory. Only available for QSHT 
5700 systems. The default is cleared (off).

— — X

* This option is not available for MagneMover Lite.
† This parameter is only for the QSHT 5700.

Table 5-3: EtherNet/IP Settings Parameters (Continued)

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um003_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um004_-en-p.pdf
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HLC Control Group Settings

The HLC Control Group is used only when the transport system has been subdivided into 
smaller transport systems where each subsystem has its own high-level controller (HLC) and 
you desire to have Vehicle ID management across the transport system. The HLC Control 
Group Settings page is used to identify the HLC of one of these subsystems as the Vehicle ID 
Server HLC. The Vehicle ID Server HLC provides Vehicle ID management across the HLC 
Control Group when Gateway nodes are used to transfer vehicles from one subsystem to 
another (see Gateway Node on page 252).

The HLC Control Group Settings page (see Figure 5-25), is accessed by selecting the HLC 
Control Group category from the Configuration Tree. See Defining HLC Control Groups on 
page 80 for usage.

Figure 5-25: HLC Control Group Settings Page

Table 5-4: HLC Control Group Settings Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

Enable HLC 
Control Group 

Select if the HLC of this configuration is part of a 
transport system with multiple HLCs using an HLC 
Control Group for Vehicle ID management.

X X X

HLC Control 
Group Role 

Identifies the role of this configuration's HLC within 
the HLC Control Group.
Server: The HLC that manages all the Vehicle ID 
numbers within the HLC Control Group.
Client: An HLC Control Group manager that receives 
the Vehicle ID numbers from the Server.

X X X

NOTE: When using an HLC Control Group, only one subsystem can be defined as the Vehicle ID Server. 
The HLCs for all other subsystems must be defined as Vehicle ID Clients.
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Number of HLCs The quantity of subsystems within the HLC Control 
Group. The HLC that is acting as the Vehicle ID 
Server is included in this count (that is, a HLC 
Control Group with one server and one client has two 
HLCs). Only available vehicle the HLC Control 
Group Role is defined as Server. The default is 2.

X X X

HLC Master IP 
Address 

The IP address of the Vehicle ID Server HLC within 
the HLC Control Group. Only available vehicle the 
HLC Control Group Role is defined as Server.

X X X

HLC Slave n IP 
Address 

The IP address of each Vehicle ID Client HLC within 
the HLC Control Group. Only available vehicle the 
HLC Control Group Role is defined as Server.

X X X

Table 5-4: HLC Control Group Settings Parameters (Continued)

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT
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Paths

The View Paths Table on page 86 provides a view only overview for the defined paths. There 
are links to the associated components for an alternate navigation through the file. Selecting 
Paths from the Configuration Tree displays a table of information about all paths that are 
defined in the configuration, see Figure 5-26.

Figure 5-26: Paths Table

Paths are used to define the route that a vehicle travels. The Path Details page for Path 1, see 
Figure 5-27. Select any path from the Paths list in the Configuration Tree to access the details 
page for that path. See Create and Edit Path on page 89 for usage. 

Figure 5-27: Path Details Page with Advanced Parameters
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Table 5-5: Paths Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

ID A unique numerical identifier for the path (must be a 
positive integer). X X X

Name An optional name for the path for reference. This 
name is not used, or displayed, by the transport 
system. Valid characters are: a…z, A…Z, 
0…9,~!@#$%^*()_+`-={}|:"?[]\;',./ and space (32 
characters maximum).

X X X

Upstream Port Identifies the port where the upstream end of the path 
is connected. The upstream ends of all paths must 
connect to a node controller. The default is None.
Serial Motors (RS-422): Select the port that is 
connected to the path via an RS-422 communication 
cable.
Ethernet Motors: Select Ethernet.

X X X

Downstream Port Identifies the port where the downstream end of the 
path is connected. The downstream ends of paths only 
connect to node controllers if vehicles will move past 
the path end onto another path. The default is None.
Serial Motors (RS-422): Select the port that is 
connected to the path via an RS-422 communication 
cable.
Ethernet Motors: Select Ethernet.

X X X

E-Stop Bit 
Number 

Provides a menu that lists all the digital input bits in 
the node controller. This bit is used to monitor an 
optional E-Stop button for this path. The default is 
None.
See the MagneMotion Node Controller Hardware 
User Manual, publication MMI-UM013to determine 
the Digital I/O options for the node controller.

X X X

Interlock Bit 
Number 

Provides a menu that lists all the digital input bits in 
the node controller. This bit is used to monitor an 
optional interlock for this path. The default is None.
See the MagneMotion Node Controller Hardware 
User Manual, publication MMI-UM013 to determine 
the Digital I/O options for the node controller.

X X X

Length The total length of the path as calculated from the 
motor sections included in the path. If the number or 
type of motors, or the spacing between motors is 
changed, this value can change.

X X X

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf
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Startup Style * Identifies the method to use during startup when there 
is a vehicle on the path.
Standard: Used for vehicles that are shorter than the 
length of the path. During startup the motors are 
commanded to move the vehicle to an empty motor 
block so the sensors in the motor can detect the front 
edge of the magnet array.
Edge Reveal: Used for vehicles that are longer than 
the length of the path. During startup the motors are 
commanded to move the vehicle in the specified 
direction until the edge of the array at the end of the 
magnet array at the opposite end of the array can be 
detected by the sensors in the motor. The default is 
Upstream.
• Upstream: Vehicles are moved upstream to 

detect the downstream edge of the magnet array 
while locating the vehicle. To allow the magnet 
array to move beyond the upstream end of the 
path, an Overtravel node must be placed at the 
upstream end of the path.

• Downstream: Vehicles are moved downstream to 
detect the upstream edge of the magnet array 
while locating the vehicle. To allow the magnet 
array to move beyond the downstream end of the 
path, either an Overtravel node must be placed at 
the downstream end of the path or a large 
downstream gap must be defined for the last 
motor on the path.

— — X

Arrival Position 
Tolerance

 Used when the tolerance for this path must differ 
from the global setting (see Global Setting 
Parameters on page 203 for the Arrival Position 
Tolerance parameter description). The default is 0.0 
m (use the Global Settings value).

Arrival Velocity 
Tolerance

Used when the tolerance for this path must differ 
from the global setting (see Global Setting 
Parameters on page 203 for the Arrival Position 
Tolerance parameter description). The default is 0.0 
m/s (use the Global Settings value).

* This parameter is only for the QSHT 5700.

Table 5-5: Paths Parameters (Continued)

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT
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Motors

Motors are used to move the vehicles on the track. To simplify configuration, Motor Defaults 
are used to predefine the motor settings on a path before they are added. After motors have 
been added to a path, changes to specific motor parameters, such as motor type, can be made. 
The individual motor pages provide a subset of the parameters on the Motor Defaults page. 
See Define and Edit Motors and Vehicle Parameters on page 91 for usage.

Motor Defaults

The Motor Defaults page (see Figure 5-28), is accessed by selecting Motor Defaults under a 
path in the Configuration Tree. See View or Edit Motor Defaults and Parameters on page 91 
for usage. This page provides the default settings for all motors added to the path where it is 
located.

NOTE: Changes made to the parameters in the Motor Defaults page are propagated to all 
motors that have already been added to a path. Any parameter that has been changed 
for a specific motor is not affected if changes are made on the Motor Defaults page. 

After a motor has been added to a path, changes to parameters specific to the 
individual motor are made using the motor-specific configuration pages. To display 
the configuration page for a motor, select the Motor ID assigned to that motor in the 
Configuration Tree. Motor-specific pages contain a subset of the parameters that are 
displayed on the Motor Defaults page.
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Figure 5-28: Motor Defaults Page (MM Lite)
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Figure 5-29: Motor Defaults Page (QucikStick)
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Figure 5-30: Motor Defaults Page (QSHT)
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Motor #n in Path n

The Motor page (see Figure 5-31), is accessed by selecting a specific motor under a Path in 
the Configuration Tree. This page provides the settings for each individual motor on the path 
where it is listed. See Define and Edit Motors and Vehicle Parameters on page 91 for usage. 
The parameters that are presented are described in Table 5-6 on page 227.

NOTE: The Control Loop Parameters section is only displayed when the Show Per Motor 
Control Loop Parameters option is selected in the View menu in the Configurator 
Menu Bar.

Figure 5-31: Motor Page - MagneMover Lite
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Figure 5-32: Motors Page - QuickStick 100
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Figure 5-33: Motor Page - QuickStick HT
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Table 5-6: Vehicle and Motor Parameters

Parameter 
Group

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

Vehicle Any Vehicle parameters are only available through Motor Defaults.

Magnet array 
type

The magnet array type options are 
populated based on the System Type. 
To change system types, select File > 
System Type.
MagneMover Lite: Select if the 
transport system is using MM Lite 
motors. The default MM Lite motor is 
ML_ Halbach. ML_Halbach is a 
special arrangement of permanent 
magnets (see Figure 5-34), placed 
perpendicular to the direction of 
motion that augments the magnetic 
field on the side of the array that faces 
the motor while canceling the field to 
near zero on the other side.
QuickStick: Select if the transport 
system is using QuickStick motors. 
The default for QuickStick is QS_100.
QuickStick HT: Select if the transport 
system is using QSHT motors. The 
default for QSHT is QS_HT.

X X X

Figure 5-34: Side View of Halbach Array, 1 Cycle, 3 Poles
SN N

Motion Motion

Mounting Surface
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Magnet array 
length 

Provides a menu listing the available 
lengths of the magnet array type that 
is selected for movement and position 
sensing. The magnet array length is 
determined by the total quantity of 
cycles and poles in the magnet array 
(Figure 5-34 shows a MM Lite 1 
cycle, 3 pole Halbach magnet array). 
Cycles: The quantity of 
North-South-North pole groups.
Poles: The quantity of poles in the 
array (two cycles share one North 
pole).

X X X

Vehicle 
Length 
QuickStick

Physical length of the vehicle 
measured from end to end (see 
Figure 5-35). The length is typically 
defined as longer than the actual 
vehicle length to account for the 
vehicle’s corners in curves (based on 
the actual vehicle geometry and curve 
radius). The Vehicle Length should 
include any overhang from the 
payload the vehicle is transporting, 
see Define Vehicle Defaults for 
QuickStick and QSHT on page 101. 
Also available for individual motors 
when Advanced Parameters is 
selected.
The default is 0.175 m.

— X X

Figure 5-35: Vehicle and Magnet Array Length

Table 5-6: Vehicle and Motor Parameters (Continued)

Parameter 
Group

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

ForwardVehicle

Vehicle
Center Line

Back

Propulsion
Array Offset

Vehicle Length

Magnet
Poles

Magnet Array Length



UI Reference
Configuration

Rockwell Automation Publication MMI-UM046A-EN-P - May 2023 229

Vehicle Length 
MM Lite 

When the Vehicle Shape is set to 
Linear, this is the physical length of the 
vehicle in meters (0.062 m to 1.50 m) 
as measured from end-to-end. 
If the track has curves or switches in 
it, the Vehicle Length must be 
configured to account for the corners 
of the vehicle in curves (based on the 
vehicle geometry and curve radius, see 
Figure 5-36) to help keep vehicles 
from colliding with each other when 
moving through curves. See 
Figure 4-25, Vehicle Length in Curves, 
on page 96. The Vehicle Length must 
include any overhang from the 
payload the vehicle is transporting, 
see Define Vehicle Defaults for MM 
Lite™ on page 97. Available through 
Motor Defaults, or for individual 
motors when the Advanced 
Parameters option is selected.
When using a standard 62 mm x 62 
mm vehicle, the vehicle length must be 
configured as 77 mm, which adds 15 
mm to the standard vehicle length to 
account for the corners of the vehicle 
when moving through curves. When 
using a standard 62 mm x 150 mm 
double-bogie tandem vehicle, the 
Vehicle Length must be configured as 
165 mm to account for the corners 
when moving through curves.

X — —

Table 5-6: Vehicle and Motor Parameters (Continued)

Parameter 
Group

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT



UI Reference
Configuration

230 Rockwell Automation Publication MMI-UM046A-EN-P - May 2023

Magnet Array 
Center Offset 

When the Vehicle Shape is set to 
Linear, this is the distance from the 
physical center of the vehicle to the 
physical center of the propulsion array 
in meters (+/- 500 mm). A positive 
value specifies the magnet array is 
downstream from the center of the 
vehicle (that is, at the vehicle front). A 
negative value specifies the magnet 
array is upstream from the center of 
the vehicle. See Figure 4-26, 
Figure 4-27, and Figure 4-28 on 
page 99. When a tandem vehicle is 
being used, this is the distance from 
the center of the vehicle to the 
mid-point between the two magnet 
arrays. When the Vehicle Shape is set 
to Rectangular, this is disabled and 
displays the last value entered. The 
default is 0.0 m.
The Magnet Array Center Offset and 
the Vehicle Length are used to define 
the location of the front and rear edges 
of the vehicle when using linear 
dimensions for collision avoidance 
purposes.

X — —

Vehicle Shape Identifies the type of vehicle in use. 
The default is Linear. X — —

Linear: Only the length of the vehicle 
is used for collision avoidance. On 
curved paths, a longer length must be 
specified, see Figure 5-36 to account 
for the effects of the width of the 
vehicle, which causes extra space 
between vehicles on a straight path.

X — —

Table 5-6: Vehicle and Motor Parameters (Continued)

Parameter 
Group

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT
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Figure 5-36: Linear Vehicle

Rectangular: The length, width, and 
position of the magnet array are used 
for collision avoidance, see 
Figure 5-37. The system performs all 
necessary calculations to provide 
proper spacing of vehicles without 
collision in both curves and straight 
sections of a path.

X — —

Table 5-6: Vehicle and Motor Parameters (Continued)

Parameter 
Group

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

Curve MM Motor

Straight MM MotorVehicle

Actual Vehicle
Virtual Vehicle
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Figure 5-37: Rectangular Vehicle

Fore Length The physical distance from the center 
of the magnet array to the front of the 
vehicle in meters (0.031…0.2125 m). 
Only available when a vehicle shape 
of Rectangular is selected. See 
Figure 5-37, Rectangular Vehicle, on 
page 232.

X — —

Aft Length The physical distance from the center 
of the magnet array to the back of the 
vehicle in meters (0.031…0.2125 m). 
Only available when a vehicle shape 
of Rectangular is selected.

X — —

Table 5-6: Vehicle and Motor Parameters (Continued)

Parameter 
Group

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT
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Aft
Length
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Starboard 
Width

The physical distance from the center 
of the magnet array to the starboard 
(right) side of the vehicle in meters 
(0.031…0.2125 m). Only available 
when a vehicle shape of Rectangular 
is selected.
If the value entered is larger than the 
radius of a curve motor, the 
Configurator displays a warning, see 
Figure 5-38. This notice is displayed 
as a reminder to verify the spacing of 
parallel paths to make sure that 
vehicles do not collide.

X — —

Figure 5-38: Vehicle Width Warning Alert

 Port Width The physical distance from the center 
of the magnet array to the port (left) 
side of the vehicle in meters 
(0.031…0.2125 m). Only available 
when a vehicle shape of Rectangular 
is selected.
If the value entered is larger than the 
radius of a curve motor, the 
Configurator displays a warning, see 
Figure 5-38.

X — —

Table 5-6: Vehicle and Motor Parameters (Continued)

Parameter 
Group

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT
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Number of 
Bogies 

 The quantity of sections on the 
bottom of a vehicle that contain 
magnet arrays. Single bogie vehicles 
contain one fixed magnet array. 
Double bogie vehicles (tandem 
vehicles) contain two magnet arrays, 
typically each magnet array is fixed to 
a pivoting vehicle section with a 
linkage that connects those vehicles to 
each other. Double bogies are used to 
provide additional thrust or movement 
of larger loads. Available through 
Motor Defaults only. The default is 1.

X X X

NOTE: All vehicles in the transport system must use the same quantity of bogies.

Gap Between 
Bogies

The space between the inner edges of 
the magnet arrays on each of the 
vehicles. Only applies when there are 
double bogies on the vehicles. Units 
are in cycles (1 cycle = 48 mm for 
QuickStick and 120 mm for QSHT). 
The number entered must be an 
integer. For example, if the magnet 
arrays are QS_100 and are separated 
by 200 mm, enter ‘4’ (200/48 ~ 4). 
Only available through Motor 
Defaults. The default is 0 cycles.

— X X

Interbogie 
Position 
Correction

Corrects the skewing of independent 
magnet arrays when the vehicle 
travels on curves in the transport 
system. It only applies when there are 
double bogies on the vehicles. It is the 
Edge-to-edge distance between the 
magnet arrays when on a curve. 
Contact Rockwell Automation® 
TechConnect for additional 
information on setting this parameter. 
Only available through Motor 
Defaults. The default is 0 m.

— X X

Table 5-6: Vehicle and Motor Parameters (Continued)

Parameter 
Group

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

https://rockwellautomation.custhelp.com/
https://rockwellautomation.custhelp.com/
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Propulsion 
Array Offset 

Distance from the physical center of 
the vehicle to the forward edge of the 
propulsion array (see Figure 5-35 on 
page 228). Only available through 
Motor Defaults. The default is 0.048 
m. The Propulsion Array Offset and 
the Vehicle Length are used to define 
the location of the front and rear edges 
of the vehicle for collision avoidance 
purposes.

— X X

Motor

Motor Type Provides a menu that lists the available 
motor types for selection of the type of 
motor being used according to the 
transport system layout. See Table 4-2 
on page 104 for motor types and 
descriptions based on system type.
The motor type options are populated 
based on the System Type. To change 
system types, select File > System 
Type. 

X X X

Acceleration 
Limit 

 Upper acceleration/deceleration limit 
to set for the motor. Make sure that the 
limit set is within the specification of 
the motor family, otherwise 
overshooting and collisions are 
possible. If the value is less than the 
system limit, vehicle motion that 
exceeds the value that is specified is 
limited to the specified value. The 
default is 2.0 m/s2 (this value is 
system-dependent, see the system 
maximums that are shown in (this 
value is system-dependent, see 
Related Documentation on page 11 
for the list of motor user manuals). 

X X X

Table 5-6: Vehicle and Motor Parameters (Continued)

Parameter 
Group

Parameter 
Name Parameter Description MM 
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Velocity Limit Upper velocity limit to set for the 
motor. Make sure that the limit set is 
within the specification of the motor 
family. In some instances, this limit 
can be lower than the velocity 
maximum specified for the path where 
the motor is located. For example, if a 
section of the path requires the motors 
enforce a lower velocity (to slow 
down for a curve for instance), those 
motors near the curve can have a 
lower velocity limit. If the value is 
less than the system limit, vehicle 
motion that exceeds the value that is 
specified is limited to the specified 
value. The default is 2.0 m/s (this 
value is system-dependent, see the 
system maximums that are shown 
(this value is system-dependent, see 
Related Documentation on page 11 
for the list of motor user manuals).

X X X

Arrival 
Position 
Tolerance 

The maximum distance that a vehicle 
can deviate from its actual destination 
for the motor to consider the vehicle 
as having arrived at its destination. If 
the tolerance is set too small, and the 
vehicle cannot stop within that 
tolerance, then the vehicle appears to 
have not arrived at its commanded 
position and the motor continues 
trying to move the vehicle to its 
destination. 
The default is 0.010 m.

X X X

NOTE: The Arrival Position Tolerance and the Arrival Velocity Tolerance are used 
together to make sure that the vehicle has arrived. A vehicle is not considered 
to have arrived at its destination by the motor (even if the Arrival Position 
Tolerance is met) if the Arrival Velocity Tolerance is not met.
When a vehicle arrives within the Arrival Position and Velocity Tolerances, the 
motor notifies the HLC by asynchronously sending a move command complete 
message. This does not trigger an asynchronous message from the HLC to the 
Host controller. The Host controller is updated about the arrival based on the 
Global Settings or Path Settings only.

Table 5-6: Vehicle and Motor Parameters (Continued)

Parameter 
Group

Parameter 
Name Parameter Description MM 
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Arrival 
Velocity 
Tolerance 

The maximum velocity of a vehicle 
for the motor to consider the vehicle 
as not moving and having arrived at 
it's destination. If the tolerance is set 
too small, and the vehicle cannot 
reach a velocity within the tolerance, 
then the vehicle appears to have not 
arrived at its commanded position and 
the motor will continue trying to move 
the vehicle to its destination The 
default is 0.010 m/s.

X X X

NOTE: The Arrival Velocity Tolerance and the Arrival Position Tolerance are used 
together to make sure that the vehicle has arrived. A vehicle is not considered 
to have arrived at its destination by the motor (even if the Arrival Velocity 
Tolerance is met) if the Arrival Position Tolerance is not met.
When a vehicle arrives within the Arrival Velocity Tolerance and the Arrival 
Position Tolerance, the motor notifies the HLC by asynchronously sending a 
move command complete message that provides the current position of the 
vehicle. This does not trigger an asynchronous message from the HLC to the 
Host controller. The Host controller is updated about the arrival based on the 
Global or Path settings only.

On Curve Select if the QuickStick motor is 
located on a curve on the transport 
system layout. The default is cleared 
(off). See QuickStick 100 User 
Manual, publication MMI-UM006 or 
the QuickStick 150 User Manual, 
publication MMI-UM047 for 
additional information.
Curve Correction Slot ID: Enabled 
if On Curve is selected. Indicate the 
slot ID of the curve correction table in 
the Web Interface to be used for this 
motor. Default is 1. 

— X —

Table 5-6: Vehicle and Motor Parameters (Continued)

Parameter 
Group

Parameter 
Name Parameter Description MM 

Lite
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Stick QSHT

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um006_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um047_-en-p.pdf
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Downstream 
Gap #1

The physical space between the rear 
end of one motor and the front end of 
the next abutting motor (also referred 
to as the Motor Gap). When using 
QSHT Dual Half motors, the 
Downstream Gap #1 is used for the 
gap between the two motors. The 
default is 0.0 m. The minimum space 
is 2.0 mm. See Figure 4-36 on 
page 108.

— X X

Downstream 
Gap #2 *

The physical space between the rear 
end of one motor and the front end of 
the next abutting motor (also referred 
to as the Motor Gap). The Gap 
Downstream #2 parameter only 
applies when using 1 m QSHT and 
QSHT Dual Half motors. The default 
is 0.0 m. The minimum space is 2.0 
mm. See Figure 4-36 on page 108.

— — X

NOTE: The additional distance, inside the motor, from the end of the stator to the end 
of the motor housing, for both ends of abutting motors is automatically added 
to this distance and is specific to the motor type and size. For detailed 
information about calculating the motor gap based on the motor type, see either 
the QuickStick 100 User Manual, publication MMI-UM006, the QuickStick 
150 User Manual, publication MMI-UM047, or the QuickStick HT User 
Manual, publication MMI-UM007.

Table 5-6: Vehicle and Motor Parameters (Continued)

Parameter 
Group

Parameter 
Name Parameter Description MM 
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https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um006_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um007_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um002_-en-p.pdf
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NC 
Disconnect 
Action *

Provides a menu listing the action to 
be taken by the motor, in the event the 
NC communication link disconnects. 
The default is None.
None: No action is performed when a 
disconnect occurs.
Suspend: Directs the motor to 
suspend vehicle target requests and 
permissions and causes all vehicles on 
the motor to come to a controlled stop. 
After the motor is stopped, the motor 
holds the vehicles in position. 
Stopping time for each vehicle is 
dependent on the mass of the vehicle, 
the payload, and the acceleration 
setting of its current movement 
command.
FastStop: Directs the motor to apply 
maximum thrust, opposite to the 
current direction of motion for all 
vehicles on the motor. After the motor 
is stopped, the motor holds the 
vehicles in position. Stopping time for 
each vehicle is dependent on the mass 
of the vehicle, the payload, and the 
acceleration setting of its current 
movement command.

— X † X †

Table 5-6: Vehicle and Motor Parameters (Continued)
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Control Loop Parameters

16 sets of Control Loop Parameters are available for configuration and use for PID loop 
control. Specific sets of parameters can be specified through either the Host Controller 
TCP/IP Communication Protocol or the Host Controller EtherNet/IP Communication 
Protocol. Available through Motor Defaults, or for individual motors when Show Per Motor 
Control Loop Parameters is selected.

Digital Input 
#n *

Provides a menu listing the actions 
available for the motor to take when 
the selected QSHT 5700 Inverter 
digital input is low. Only available for 
QSHT 5700 systems. The default is 
None.
None: No action is performed.
Suspend: Directs the motor to 
suspend vehicle target requests and 
permissions and causes all vehicles on 
the motor to come to a controlled stop. 
After the motor is stopped, the motor 
holds the vehicles in position. 
Stopping time for each vehicle is 
dependent on the mass of the vehicle, 
the payload, and the acceleration 
setting of its current movement 
command.
FastStop: Directs the motor to apply 
maximum thrust, opposite to the 
current direction of motion for all 
vehicles on the motor. After the motor 
is stopped, the motor holds the 
vehicles in position. Stopping time for 
each vehicle is dependent on the mass 
of the vehicle, the payload, and the 
acceleration setting of its current 
movement command.

— — X

Propulsion 
Power Supply 
ID *

The ID of the propulsion power 
supply for this QSHT 5700 motor, 
which is identified on the Global 
Settings page. Only available for 
QSHT 5700 systems. The default is 1.

— — X

* This option is not available for MagneMover Lite.
† This option is for QuickStick 150 and QSHT 5700 only, it is not for QuickStick 100 or QSHT.

Table 5-6: Vehicle and Motor Parameters (Continued)
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Group
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• Set 0 (Unloaded) – Always enabled. Predefined as the set to be used for unloaded 
vehicles when Set 1 is also enabled.

• Set 1 (Loaded) – If enabled, predefined as the set to be used for loaded vehicles.

• Sets 2…14 – Available for defining various payload and velocity requirements.

• Set 15 – Predefined as the startup PID values. This PID set is automatically used 
during startup. If it is not enabled (unchecked), PID Set 0 is scaled by 25% and used 
for startup.

Different PID sets can be defined to account for such things as incremental changes in payload 
and to meet desired vehicle acceleration and velocity during operation. After the PID is 
defined in the Configurator, and saved in the Node Controller Configuration file, a PID set 
becomes available for use in vehicle move commands. Vehicle move commands are executed 
through either the Host Controller TCP/IP Communication Protocol, the Host Controller 
EtherNet/IP Communication Protocol, or the NCHost TCP Interface Utility. When a move 
command is issued, the sending application references a specific PID Set by its index number, 
as defined in the Configuration file.

The checkbox must be selected (checked) in order for the parameters for a specific PID Set to 
be saved and available to the host application(s) from the Configuration File when the 
specified control loop parameter set is specified in a command:

Table 5-7: Control Loop Parameters

Parameter 
Name * Parameter Description MM 

Lite
Quick
Stick QSHT

Set PID set index used by the Host Controller to identify 
which control loop values to use for a motion 
command.

X X X

Enable Select to enable the use of the specific Set. The 
default is cleared (unchecked) for all sets except Set 0. 
Only sets that are enabled can be specified in motion 
commands.

X X X

Mass (kg) The mass of the vehicle (vehicle + magnet_array + 
payload). The default value varies by system type and 
quantity of bogies.

X X X

Kp Kp is the control loop proportional gain, it controls 
the amount of force applied proportional to the 
position error.

X X X

Ki Ki is the control loop integral gain, it controls the 
amount of force applied proportional to the integral 
loop gain error, correcting errors in position over 
time.

X X X
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Kd Kd is the control loop derivative gain, it controls the 
amount of force applied proportional to the velocity 
error, providing damping in the control loop.

X X X

Kff Kff is the control loop feed forward scale, it increases 
or decreases the feedforward force without affecting 
other control loop gains. The feedforward force 
normally applies the correct amount of force to 
achieve the desired acceleration based on the 
specified mass.

X X X

* For each PID Set, the all parameters apply.

Table 5-7: Control Loop Parameters (Continued)

Parameter 
Name * Parameter Description MM 
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Advanced Parameters

Table 5-8: Advanced Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

Drag 
Compensation 
Thrust 

Used to compensate for friction. This force is applied 
in the direction that a vehicle moves to arrive at the 
destination and ramps down to zero when near the 
destination. The default is 0.0 N.

X X X

Constant Thrust Defines the constant thrust that is applied to vehicles 
for sloped transport systems. 
The default is 0.0 N.

X X X

Thrust Limit Limits the maximum thrust that is applied to a vehicle 
to a percentage of available motor thrust. Lowering 
the thrust limit achieves smoother motion. The 
default is 100%.

X X X

Integrator Always 
On 

The Integrator Velocity Threshold and Integrator 
Distance Threshold options are ignored when selected. 
This setting must be cleared if vehicles on the motor 
are held at a specific position by an external 
mechanism to help prevent PID Loop windup. The 
default is selected (on).
Integrator Velocity Threshold: The velocity below 
which the PID Control Loop Integrator is enabled. 
The default is 0.1 m/s.
Integrator Distance Threshold: The distance to the 
destination below which the PID Control Loop 
Integrator is enabled. If set to -1.0 m, the integrator is 
always on unless disabled due to another setting. The 
default is -1.0 m.

X X X
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Thrust Constant * Select Calculate Thrust Constant to enable the use of 
the Vertical Magnet Gap and Magnet Coverage 
Percentage to calculate the Thrust Constant. Vertical 
Magnet Gap and Magnet Coverage Percentage is 
enabled, and Thrust Constant is disabled. When off, 
Vertical Magnet Gap and Magnet Coverage 
Percentage is disabled, and Thrust Constant is 
enabled to allow manual entry of the desired value. 
The default is unselected (off).
Vertical Magnet Gap: The measured vertical gap 
between the top of the motor and the bottom of the 
magnet array in mm. 
QuickStick default is: 4 mm
QSHT default is: 11 mm
Magnet Coverage Percentage: Scales the thrust 
constant based on the magnet array coverage 
percentage for stations on this motor. Use 100% 
coverage if the magnet array is shorter than the motor 
when the vehicle is at it's destination. The default is 
100%.
Thrust Constant: Thrust constant of the motor per 
cycle of the engaged magnet array. One cycle for a 
standard MM Lite magnet array is 54.5 mm long and 
consists of one full-size magnet array and two 
half-size magnets in a Halbach array. When the 
magnet array consists of multiple cycles (like one 
QuickStick and QSHT system), the half-size magnets 
from adjacent cycles are combined into one full-size 
magnet. The thrust constant varies with the vertical 
gap between the magnet and the motor and the 
magnet coverage percentage. 
MM Lite default is: 8.0 N/A/cycle
QuickStick default is: 3.786 N/A/cycle
QSHT default is: 18.81 N/A/cycle

X X X

Downstream Gap 
MM Lite

The physical space between motors. Do not change 
this setting for a standard MM Lite installation. The 
default is 0.003 m.

X — —

Control Off 
Position 
Tolerance 

The distance to the destination below which the PID 
Control Loop is disabled (no thrust is applied due to 
the control loop). Thrust is not enabled until the 
distance from the destination is twice this value. The 
default is 0.0 m.

X — —

Table 5-8: Advanced Parameters (Continued)

Parameter 
Name Parameter Description MM 
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Forward Drive 
Phase % 

Controls the amount of downward force that is 
applied to the vehicle during forward (downstream) 
moves as a percentage of the thrust force. Increasing 
the percentage increases the downward force. The 
default is 0%.

X — —

Backward Drive 
Phase % 

Controls the amount of downward force that is 
applied to the vehicle during backward (upstream) 
moves as a percentage of the thrust force. Increasing 
the percentage increases the downward force. The 
default is 0%.

X — —

Use Smart 
Integrator

When checked, enables the use of the smart integrator 
feature. Smart integrator controls the integral term of 
the PID Control Loop to apply a consistent force 
when the vehicle is at standstill, allowing better 
compensation for cogging.
Smart Integrator On Distance: Enable the smart 
integrator when the distance to the target falls below 
this value. Default is 0 m.
Smart Integrator Off Distance: Disable the smart 
integrator when the distance to the target becomes 
larger than this value. Default is 0 m.
Smart Integrator Delay: Time the vehicle must be 
within the Smart Integrator On Distance before the 
smart integrator enables. Default is 0 ms.

— X —

Table 5-8: Advanced Parameters (Continued)

Parameter 
Name Parameter Description MM 
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Use Hold Down 
Current †

When checked, enables the use of the hold down 
feature. Hold down force applies a vertical force to 
the magnet array, increasing the attractive force to the 
track. This increases friction and decreases the effect 
of disturbances on the vehicle while at rest.
Hold Down On Distance: Enable hold down when 
the distance to the target falls below this value. 
Default is 0 m.
Hold Down Off Distance: Disable hold down when 
the distance to the target becomes larger than this 
value. Default is 0 m.
Hold Down Magnitude: Current (in Amps) to apply 
to holding down a vehicle. Default is 0 A.

— X —

Use EMP When checked, enables the use of the 
Electro-Magnetic Pinning (EMP) feature. EMP 
applies a lateral force to the vehicle that increases as 
the vehicle is moved away from its target independent 
of the control loop. this reduces motion while in 
station and compensates for disturbances.
EMP On Distance: Enable EMP when the distance 
to the target falls below this value. Default is 0 m.
EMP Off Distance: Disable EMP when the distance 
to the target becomes larger than this value. Default is 
0 m.
EMP Magnitude: Current (in Amps) to apply to 
pinning a vehicle. Default is 0 A.

— X —

* The Thrust Constant parameter is available for all system types. The Calculate Thrust Constant, Vertical Magnet Gap,
and Magnet Coverage Percentage are only for QuickStick and QSHT.

† The magnitude of the hold down current and EMP combined must be less than the continuous current limit of the
motor to prevent overheating

Table 5-8: Advanced Parameters (Continued)

Parameter 
Name Parameter Description MM 
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Keepout Areas

Keepout Areas are sections of a path where the motors do not allow a vehicle to enter unless it 
has permission (from the motors) to move fully past the area. It is typically used near merge 
points to keep two vehicles from merging onto one path simultaneously or in areas where 
some other action needs to occur that requires the area to be clear (such as closing a fire door). 
If vehicle movement is suspended (E-Stop, Interlock, or a Suspend command is issued), any 
vehicle in the Keepout Area moves beyond the Keepout Area and then decelerates to a stop. 
See Create and Edit Nodes on page 119 for usage.

A vehicle that enters a Keepout Area in the direction of the Keepout Area takes ownership of 
all motor blocks within the Keepout Area. A Keepout Area in one direction does not affect the 
motion of vehicles moving in the other direction unless there is a vehicle within the Keepout 
Area moving in the direction of the Keepout Area. If vehicle movement is suspended (E-Stop, 
Interlock, or a Suspend command is issued), any vehicle in the Keepout Area moving in the 
direction of the Keepout Area moves beyond the Keepout Area and then decelerates to a stop.

NOTE: Keepout Areas can start anywhere on a motor but must always end at the end of a 
motor.

Table 5-9: Keepout Area Parameters

Parameter 
Name *

* These parameters do not exist on the Motor Default page, only on the individual motor pages.

Parameter Description MM 
Lite

Quick
Stick QSHT

No Move 
Permission 
Before

For vehicles moving upstream, the position relative to 
the start of the motor where the Keepout Area begins. 
All motors in the desired area must have this value set 
correctly for proper operation. Maximum is 6.0 m. 
The default is 0.0 m (not in a Keepout Area).

X X X

No Move 
Permission After 

For vehicles moving downstream, the position 
relative to the start of the motor where the Keepout 
Area begins. All motors in the desired area must have 
this value set correctly for proper operation. The 
default is 5.0 m (not in a Keepout Area).

X X X
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Nodes

Nodes are used to define the connections between paths. The Node page (see Figure 5-39), is 
accessed by expanding the Nodes list in the Configuration Tree and selecting the appropriate 
node. See Create and Edit Nodes on page 117 for usage. The parameters pages for the 
different node types are provided after the description of the basic nodes page. Only the 
additional parameters for each node type are described.

Figure 5-39: Node Page
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Table 5-10: Node Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

ID A unique numerical identifier for the node, it must be 
a positive integer. X X X

Name An optional name for the node for reference. If used, 
the name is displayed on the node controller 
parameters page.

X X X

Node Type Provides a menu that lists all available node types. 
The default is None. 
The node types vary based on system type.
None: The node type has not been specified.
Simple: Begins a path.
Relay: Connects the end of a path and the beginning 
of a path.
Terminus: Connects a path on the transport system to 
an external system to allow vehicles to move to or 
from the transport system.
Gateway: Connects two independent paths, with 
each path managed by separate HLC Control Groups. 
Separate HLCs must be configured to manage each 
independent control group.
Merge: Connects two paths to a third path.
Diverge: Connects one path to two additional paths.
Merge-Diverge: Connects two paths to two 
additional paths.
Overtravel – Permits a vehicle to move past the end 
of the motor at the beginning or end of a path.
Moving Path – Connects Paths, mounted on a 
Host-controlled mechanism that moves those Paths to 
other Paths at multiple locations.

X X X
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Simple Node

A Simple node is used to begin a path that is not connected to anything else at the upstream 
end. See Simple Node on page 121 for configuration. The additional parameters for the 
Simple node are described after Figure 5-40.

Figure 5-40: Simple Node Parameters

Table 5-11: Simple Node Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

Exit Path ID Provides a menu that lists all paths in the transport 
system for selection of the path that exits the node. 
The default is None.

X X X
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Relay Node

A Relay node is used to connect the downstream end of a path and the upstream end of a path. 
See Relay Node on page 123 for configuration. The additional parameters for the Relay node 
are described after Figure 5-41.

Figure 5-41: Relay Node Parameters

Terminus Node

A Terminus node is used to move vehicles to or from another system. See Terminus Node on 
page 124 for configuration. It may be located at either the upstream or downstream end of a 
path. The additional parameters for the Terminus node are described after Figure 5-42.

Figure 5-42: Terminus Node Parameters

Table 5-12: Relay Node Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

Entry Path ID Provides a menu that lists all paths in the transport 
system for selection of the path that enters the node. 
The default is None.

X X X

Exit Path ID Provides a menu that lists all paths in the transport 
system for selection of the path that exits the node. 
The default is None.

X X X
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Gateway Node

A Gateway node is used for connecting paths between independent transport systems. These 
independent transport systems may or may not be linked using an HLC Control Group. After 
the Gateway node is configured, vehicles are able to pass freely between transport system 
subsystems (each managed by its own HLC). If the subsystems are linked using an HLC 
Control Group, vehicles passing between subsystems will keep their assigned Vehicle ID.

NOTE: There is a maximum of two Gateway nodes per node controller, one upstream and 
one downstream. The Gateway nodes do not need to be on the same path.

• - The upstream Gateway node in a gateway pair has a corresponding 
downstream node on another node controller belonging to another 
subsystem of the transport system. 

• - The downstream Gateway node in a gateway pair has a corresponding 
upstream node on another node controller belonging to another 
subsystem of the transport system.

The additional parameters for the Gateway node are described after Figure 5-43. See Gateway 
Node on page 138 for configuration.

Table 5-13: Terminus Node Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

Path Provides a menu that lists all paths in the transport 
system for selection of the path where the node is 
located. The default is None.

X X X

Path End Provides a menu for selection of the path end where 
the node is located. The default is Upstream.
Downstream: The node is located at the downstream 
end of the path (end of the path).
Upstream: The node is located at the upstream end of 
the path (beginning of the path).

X X X

NOTE: Typically the upstream end is used to bring vehicles into the transport system and the downstream 
end is used to remove vehicles from the transport system. However, vehicle motion can be 
bidirectional, which allows movement in either direction at either end of the path.

Custom Initial 
Target

Initial target destination on the specified Path for 
vehicles entering the transport system through this 
node.

X X X
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Figure 5-43: Gateway Node Parameters

Table 5-14: Gateway Node Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

Path Provides a menu that lists all paths in the transport 
system to select the path where the node is located. 
The default is None.

X X X

Path End Provides a menu for selection of the path end where 
the node is located. The default is Upstream.
Downstream: The node is used at the downstream 
end of the path.
Upstream: The node is used at the upstream end of 
the path.

X X X

Peer IP Address The IP address of the node controller responsible for 
the Gateway node in the other subsystem. Both node 
controllers must be on the same local subnet.

X X X

Peer Node ID The Node ID of the Gateway node in the other 
subsystems. The default is None. X X X
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Merge Node

A Merge node is used to connect the downstream ends of two paths to the upstream end of a 
third path. See Merge Node on page 126 for configuration. The additional parameters for the 
Merge node are described after Figure 5-46.

NOTE: Merge nodes are only available for MagneMover Lite.

Figure 5-44: Merge Node Parameters - Linear Vehicle Shape on Paths

Figure 5-45: Merge Node Parameters - Rectangular Vehicle Shape on Paths

Figure 5-46: Merge Node Parameters - Vehicle Shape Mismatch
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Table 5-15: Merge Node Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

Entry/Exits Lists the entry and exit paths for the node. X — —

Path ID Provides menus that list all paths in the transport 
system for selection of the two entry paths and the 
two exit paths where the node is located. The default 
is None.

X — —

Gate Position Used for Merge, Diverge, and Merge-Diverge nodes 
where all Paths in the node have a Linear vehicle 
shape. The gate location is defined as the position of 
the center of the vehicle (in meters) from the start of 
the entry or exit path. See MM Lite Linear Gates and 
Clearances on page 152 for more information.

X — —

Clearance 
Position

Used for Merge, Diverge, and Merge-Diverge nodes 
where all Paths in the node have a Linear vehicle 
shape. The clearance location is defined as the 
position of the center of the vehicle (in meters) from 
the start of the Entry/Exits path. See MM Lite Linear 
Gates and Clearances on page 152 for more 
information.

X — —

Use Gates and 
Clearances

Used for Merge, Diverge, and Merge-Diverge nodes 
where all Paths in the node have a Linear vehicle 
shape. Enables/disables the use of the Gate Position 
and Clearance Position parameters. See MM Lite 
Linear Gates and Clearances on page 154 for more 
information.

X — —

Gate Distance Used for Merge, Diverge, and Merge-Diverge nodes 
where all Paths in the node have a Rectangular 
vehicle shape. The gate location is defined as the 
distance in meters from the end of the motor closest to 
the node to the center of the vehicle. See MM Lite 
Rectangular Gates and Clearances on page 153 for 
more information.

X — —

Clearance 
Distance

Used for Merge, Diverge, and Merge-Diverge nodes 
where all Paths in the node have a Rectangular 
vehicle shape. The clearance location is defined as the 
distance in meters from the end of the motor closest to 
the node to the center of the vehicle. See MM Lite 
Rectangular Gates and Clearances on page 153 for 
more information.

X — —
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Diverge Node

A Diverge node is used to connect the downstream end of one path to the upstream ends of 
two paths. See Diverge Node on page 128 for configuration. The additional parameters for the 
Diverge node are described after Figure 5-49.

NOTE: Diverge nodes are only available for MagneMover Lite.

Consecutive 
Vehicle Limit

This limit applies to downstream motion through the 
switch. For each entry path, this limit defines the 
quantity of vehicles that are allowed to traverse the 
path downstream when there is a vehicle in cue for 
switch access in the downstream direction on the 
other entry path. After the specified quantity of 
vehicles has traversed the switch or there are no more 
vehicles cued, additional vehicles on that entry path 
are stopped and control of the switch is transferred to 
the other entry path. Any vehicles in cue on that other 
entry path can then enter the switch (up the maximum 
that is specified for that path if vehicles are now cued 
on the other path). The default is 0 (no limit).

X — —

Path Length The total length of the selected Path ID as calculated 
from the motor sections included in the path. If the 
number, type of motors, or the spacing between 
motors is changed, this value can change.

X — —

Vehicle Shape The vehicle shape defined in the Motor Defaults of 
the selected Path ID. Only displayed when there is a 
mismatch of vehicle shapes that are involved in a 
node, which is accompanied by a Vehicle Shape 
Mismatch Error (Figure 4-67 on page 128).

X — —

Table 5-15: Merge Node Parameters (Continued)

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT
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Figure 5-47: Diverge Node Parameters - Linear Vehicle Shape

Figure 5-48: Diverge Node Parameters - Rectangular Vehicle Shape

Figure 5-49: Diverge Node Parameters - Vehicle Shape Mismatch
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Table 5-16: Diverge Node Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

Entry/Exits Lists the entry and exit paths for the node. X — —

Path ID Provides menus that list all paths in the transport 
system for selection of the two entry paths and the 
two exit paths where the node is located. The default 
is None.

X — —

Gate Position Used for Merge, Diverge, and Merge-Diverge nodes 
where all Paths in the node have a Linear vehicle 
shape. The gate location is defined as the position of 
the center of the vehicle (in meters) from the start of 
the entry or exit path. See MM Lite Linear Gates and 
Clearances on page 154 for more information.

X — —

Clearance 
Position

Used for Merge, Diverge, and Merge-Diverge nodes 
where all Paths in the node have a Linear vehicle 
shape. The clearance location is defined as the 
position of the center of the vehicle (in meters) from 
the start of the entry or exit path. See MM Lite Linear 
Gates and Clearances on page 154 for more 
information.

X — —

Use Gates and 
Clearances

Used for Merge, Diverge, and Merge-Diverge nodes 
where all Paths in the node have a Linear vehicle 
shape. Enables/disables the use of the Gate Position 
and Clearance Position parameters. See MM Lite 
Linear Gates and Clearances on page 154 for more 
information.

X — —

Gate Distance Used for Merge, Diverge, and Merge-Diverge nodes 
where all Paths in the node have a Rectangular 
vehicle shape. The gate location is defined as the 
distance in meters from the end of the motor closest to 
the node to the center of the vehicle. See MM Lite 
Rectangular Gates and Clearances on page 153 for 
more information.

X — —

Clearance 
Distance

Used for Merge, Diverge, and Merge-Diverge nodes 
where all Paths in the node have a Rectangular 
vehicle shape. The clearance location is defined as the 
distance in meters from the end of the motor closest to 
the node to the center of the vehicle. See MM Lite 
Rectangular Gates and Clearances on page 153 for 
more information.

X — —
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Merge-Diverge Node

A Merge-Diverge node is used to connect the downstream ends of two paths to the upstream 
ends of two paths. See Merge-Diverge Node on page 132 for configuration. The additional 
parameters for the Merge-Diverge node are described after Figure 5-52.

NOTE: Diverge nodes are only available for MagneMover Lite.

Consecutive 
Vehicle Limit

This limit applies to downstream motion through the 
switch. For each entry path, this limit defines the 
quantity of vehicles that are allowed to traverse the 
path downstream when there is a vehicle in cue for 
switch access in the downstream direction on the 
other entry path. After the specified quantity of 
vehicles has traversed the switch or there are no more 
vehicles cued, additional vehicles on that entry path 
are stopped and control of the switch is transferred to 
the other entry path. Any vehicles in cue on that other 
entry path can then enter the switch (up the maximum 
that is specified for that path if vehicles are now cued 
on the other path). The default is 0 (no limit).

X — —

Path Length The total length of the selected Path ID as calculated 
from the motor sections included in the path. If the 
number, type of motors, or the spacing between 
motors is changed, this value can change.

X — —

Vehicle Shape The vehicle shape defined in the Motor Defaults of 
the selected Path ID. Only displayed when there is a 
mismatch of vehicle shapes that are involved in a 
node, which is accompanied by a Vehicle Shape 
Mismatch Error (Figure 4-67 on page 128).

X — —

Table 5-16: Diverge Node Parameters (Continued)

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT
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Figure 5-50: Merge-Diverge Node Parameters - Linear Vehicle Shape

Figure 5-51: Merge-Diverge Node Parameters - Rectangular Vehicle Shape

Figure 5-52: Merge-Diverge Node Parameters - Vehicle Shape Mismatch
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Table 5-17: Merge-Diverge Node Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

Entry/Exits Lists the entry and exit paths for the node. X — —

Path ID Provides menus that list all paths in the transport 
system for selection of the two entry paths and the 
two exit paths where the node is located. The default 
is None.

X — —

Gate Position Used for Merge, Diverge, and Merge-Diverge nodes 
where all Paths in the node have a Linear vehicle 
shape. The gate location is defined as the position of 
the center of the vehicle (in meters) from the start of 
the entry or exit path. See MM Lite Linear Gates and 
Clearances on page 154 for more information.

X — —

Clearance 
Position

Used for Merge, Diverge, and Merge-Diverge nodes 
where all Paths in the node have a Linear vehicle 
shape. The clearance location is defined as the 
position of the center of the vehicle (in meters) from 
the start of the entry or exit path. See MM Lite Linear 
Gates and Clearances on page 154 for more 
information.

X — —

Use Gates and 
Clearances

Used for Merge, Diverge, and Merge-Diverge nodes 
where all Paths in the node have a Linear vehicle 
shape. Enables/disables the use of the Gate Position 
and Clearance Position parameters. See MM Lite 
Linear Gates and Clearances on page 154 for more 
information.

X — —

Gate Distance Used for Merge, Diverge, and Merge-Diverge nodes 
where all Paths in the node have a Rectangular 
vehicle shape. The gate location is defined as the 
distance in meters from the end of the motor closest to 
the node to the center of the vehicle. See MM Lite 
Rectangular Gates and Clearances on page 153 for 
more information.

X — —

Clearance 
Distance

Used for Merge, Diverge, and Merge-Diverge nodes 
where all Paths in the node have a Rectangular 
vehicle shape. The clearance location is defined as the 
distance in meters from the end of the motor closest to 
the node to the center of the vehicle. See MM Lite 
Rectangular Gates and Clearances on page 153 for 
more information.

X — —
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Overtravel Node Parameters

An Overtravel node is used to permit part of a vehicle to move past the end of the motor at the 
beginning or the end of a path (see Overtravel Node on page 140 for usage). Additional 
support structure (guideway) for the vehicle must be provided, or the vehicle’s supports 
(wheels) must not be allowed to move past the end of the guideway. If appropriate cautions 
are not taken for the vehicle, it could fall off of the guideway or get caught on the end of the 
guideway preventing further movement. The additional properties for the Overtravel node are 
described after Figure 5-53.

Figure 5-53: Overtravel Node Parameters

Consecutive 
Vehicle Limit

This limit applies to downstream motion through the 
switch. For each entry path, this limit defines the 
quantity of vehicles that are allowed to traverse the 
path downstream when there is a vehicle in cue for 
switch access in the downstream direction on the 
other entry path. After the specified quantity of 
vehicles has traversed the switch or there are no more 
vehicles cued, additional vehicles on that entry path 
are stopped and control of the switch is transferred to 
the other entry path. Any vehicles in cue on that other 
entry path can then enter the switch (up the maximum 
that is specified for that path if vehicles are now cued 
on the other path). The default is 0 (no limit).

X — —

Path Length The total length of the selected Path ID as calculated 
from the motor sections included in the path. If the 
number, type of motors, or the spacing between 
motors is changed, this value can change.

X — —

Vehicle Shape The vehicle shape defined in the Motor Defaults of 
the selected Path ID. Only displayed when there is a 
mismatch of vehicle shapes that are involved in a 
node, which is accompanied by a Vehicle Shape 
Mismatch Error (Figure 4-67 on page 128).

X — —

Table 5-17: Merge-Diverge Node Parameters (Continued)

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT
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Moving Path Node Parameters

A Moving Path node is used to connect the ends of fixed paths to the ends of paths being 
moved by a Host-controlled mechanism (see Moving Path Node on page 143 for usage). The 
mechanism providing the movement may be any user-supplied mechanism including 
QuickStick motors. The additional properties for the Moving Path node are described after 
Figure 5-54.

Use of the Moving Path node requires the host controller to command the drive mechanism to 
position an entry path so that it aligns with an exit path. The host controller must then issue a 
Link command (see the MagneMotion Host Controller TCP/IP Communication Protocol User 
Manual, publication MMI-UM003 and MagneMotion Host Controller EtherNet/IP 
Communication Protocol User Manual, publication MMI-UM004) to connect the two paths to 
allow vehicle movement. After the vehicle has moved beyond the node, the paths must be 
unlinked before moving the moving path to a new position.

NOTE: Moving Path nodes are only available for QuickStick and QuickStick HT 
systems.

Table 5-18: Overtravel Node Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

Path Provides a menu listing all paths in the transport 
system for selection of the path where the node is 
located. The default is None.

— X X

Path End Provides a menu for selection of the path end where 
the node is located. The default is Upstream.
Downstream: The node is located at the downstream 
end of the path (end of the path).
Upstream: The node is located at the upstream end of 
the path (beginning of the path).

— X X

Maximum 
Position

The maximum vehicle overtravel (a negative number 
indicates travel before an upstream node and a 
positive number indicates travel after a downstream 
node). The default is 0.0 (no overtravel).

— X X

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um003_-en-p.pdf
https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um004_-en-p.pdf
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Figure 5-54: Moving Path Node Properties
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Table 5-19: Moving Path Node Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

Entry Paths Route 
Type

Provides a menu for selection of the type of routing 
that is used when the path is an entry path. An entry 
path is a path whose downstream end is a member of 
the Moving Path node. A vehicle moving downstream 
enters the node on an entry path. The default is 
Specific-route.
Specific-route: Used if the entry path is fixed and 
only a specific moving path in the node can satisfy the 
route. The HLC requests alignment of specific paths.
Equivalent-route: Used if the entry path is a moving 
path and any moving path in the node can satisfy the 
route. The host controller identifies and aligns 
equivalent paths.

— X X

Exit Paths Route 
Type

Provides a menu for selection of the type of routing 
that is used when the path is an exit path. An exit path 
is a path whose upstream end is a member of the 
Moving Path node. A vehicle moving downstream 
exits the node on an exit path. The default is 
Specific-route.
Specific-route: Used if the exit path is fixed and only 
a specific moving path in the node can satisfy the 
route. The HLC requests alignment of specific paths.
Equivalent-route: Used if the exit path is a moving 
path and any moving path in the node can satisfy the 
route. The host controller identifies and aligns 
equivalent paths.

— X X

Entries and Exits Provides a menu for selection of the path’s 
relationship to the node. The default is None.
Entry: The path at this position is an entry to the 
Moving Path node.
Exit: The path at this position is an exit from the 
Moving Path node.
None: The entry is not used.

— X X

Path Provides menus listing all paths in the transport 
system for selection of the entry paths and exit paths 
where the node is located. The default is None.

— X X
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Clearance Path ID: (if different from the Entry/Exit Path ID) 
where the Clearance Position is located.
Position: The location, in meters, to the center of the 
vehicle where the vehicle’s trailing edge is considered 
cleared from the node. Applies to the trailing edge for 
all vehicles exiting the node, regardless of vehicle 
direction. The default is 0.0 m (see Node Gates and 
Clearances on page 147).

— X X

Entry Gate Path ID: (if different from the Entry/Exit Path ID) 
where the Clearance Position is located.
Position: The location, in meters, to the center of the 
vehicle where the leading edge of the vehicle is 
considered clear of the node and/or vehicles and their 
payloads on adjoining paths. Applies to the leading 
edge for all vehicles entering the switch, regardless of 
vehicle direction. The default is 0.0 m (see Node 
Gates and Clearances on page 147).

— X X

Gap Delta Used on exit paths to correct for the difference in the 
distance between the downstream gap of the last 
motor on the entry path and the front end of the first 
motor on each exit path. The default is 0.0 m (see Gap 
Delta on page 157).

— X X

Table 5-19: Moving Path Node Parameters (Continued)

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT
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Node Controllers

Node controllers are used to provide monitoring and control of the nodes, paths, and motors in 
the transport system. The Node Controller page (see Figure 5-55), is accessed by expanding 
the Node Controllers list in the Configuration Tree and selecting the appropriate node 
controller. See Define and Edit Node Controllers on page 160 for usage.

Figure 5-55: Node Controllers Page

Table 5-20: Node Controller Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

ID A unique numerical identifier for the node controller 
(must be a positive integer). X X X

Name An optional name for the node controller for reference. 
This name is not used, or displayed, by the transport 
system.

X X X

IP Address IP address of the node controller. X X X
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Digital I/O Board 
Type 

Provides a menu of the types of digital I/O boards that 
may be installed in the node controller. The default is 
None. The options vary based on system type.
None: No digital I/O board installed.
NC-12 Solid State 16 Bit: Provides 16 optically 
isolated solid-state digital inputs and 16 optically 
isolated solid-state digital outputs.
NC-E Series A Solid State 4 Bit: Provides 4 optically 
isolated solid-state digital inputs and 4 optically 
isolated solid-state digital outputs.
NC-E Series B Solid State 8 Bit: Provides 8 
optically isolated solid-state digital inputs and 8 
optically isolated solid-state digital outputs.

X X X

NOTE: I/O board selection does not apply to node controllers that do not provide digital I/O.

Node Ownership 
Control 

This section provides the tools to select the nodes that 
this node controller is responsible for.
Node ID: Provides a menu that lists all nodes in the 
transport system for selection of a node to be 
controlled, or released, by the node controller. The 
default is 1.
Take Ownership: Causes the node controller to take 
ownership of the selected node. The node is listed in 
the Node Ownership and all paths that are associated 
with the node are listed in the Path End Ownership.
Remove Ownership: Causes the node controller to 
release ownership of the selected node. The node is 
removed from the Node Ownership and all paths that 
are associated with the node are removed from the 
Path End Ownership.

X X X

Node Ownership Lists the nodes, their type, and their optional name that 
this node controller is responsible for. X X X

Path End 
Ownership List

Lists all path ends involved in the node(s) that are 
owned by this node controller. X X X

Table 5-20: Node Controller Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT
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Path End Ownership List

Table 5-21: Path End Ownership List Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

Path ID Shows the ID of the paths that are connected to the 
node. X X X

Path End Identifies the end of the paths connecting to the node 
(upstream or downstream). X X X

Node Member Identifies the node and the way the path connects to 
the node (Enters or Exits). X X X

Comm Port Provides a menu that lists all communication ports 
that could be available on the node controller. The 
selected port is used for communication with the 
motor at the Path End that is connected to the node. 
The menu lists the maximum quantity of ports that 
could be available, make sure the port selected is the 
port connected to the motor.
• For all node controller types that support RS-422, 

when using RS-422 communication, select the 
port being used.

• For all node controllers types, when using 
Ethernet communication, select Ethernet.

X X X
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All Stations

The All Stations category in the Configuration Tree provides an easy method to view all 
configured stations regardless of the path that they are on. There are no parameters that are 
associated with this category. However, selecting any of the stations in the All Stations list 
displays its property page for review or editing, see Figure 5-56.

Figure 5-56: All Stations Configuration Tree Category

Stations

Stations are used to define a specific position on a path to send a vehicle. The Station page 
(see Figure 5-57), is accessed either by expanding the Stations list under a path in the 
Configuration Tree or by expanding the All Stations list and selecting the appropriate station. 
See Create and Edit Stations on page 165 for usage.

NOTE: Stations are hidden by default. Use the View menu in the Configuration Menu Bar, 
select Show Stations to display them. Before adding new stations to a path with 
existing stations, make sure that they are set appropriately.

Figure 5-57: Stations Page

Table 5-22: Station Page Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

ID A unique numerical identifier for the station 
(1…2048). X X X
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Single Vehicle Areas

Single Vehicle Areas (SVA) define an area on a path where only one vehicle at a time can 
enter and move. The Single Vehicle Area page (see Figure 5-58), is accessed by expanding the 
Single Vehicle Areas list under a path in the Configuration Tree and selecting the appropriate 
SVA. See Create and Edit Single Vehicle Areas on page 169 for usage.

NOTE: Single Vehicle Areas are hidden by default. Use the View menu in the Configuration 
Menu Bar, select Show Single Vehicle Areas to display them.

Figure 5-58: Single Vehicle Area Page

NOTE: Two or more Single Vehicle Areas that are defined in the same direction cannot 
overlap. Single Vehicle Areas that are defined in opposite directions can overlap; 
that is, an SVA for downstream motion can cover some or all of an SVA for upstream 
motion.

Name An optional name for the station for reference. This 
name is not used, or displayed, by the transport 
system. Valid characters are: a…z, A…Z, 
0…9,~!@#$%^*()_+`-={}|:"?[]\;',./ and space (32 
characters maximum).

X X X

Location Position on the path where the station is located, 
measured from the beginning of the path. The default 
is 0.0 m.

X X X

Path n Length The total length of the path as calculated from the 
motor sections included in the path where the station 
is located. If the number, type of motors, or the 
spacing between motors is changed, this value can 
change.

X X X

Table 5-22: Station Page Parameters (Continued)

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT
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Table 5-23: Single Vehicle Area Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

Type Provides a menu that lists the area types by direction of 
movement on the path. The default is Downstream.
Downstream: The normal commanded motion on the 
path where the Single Vehicle Area is located is 
downstream (forwards).
Upstream: The normal commanded motion on the 
path where the Single Vehicle Area is located is 
upstream (backwards).

X X X

Start Location Position for the start of the Single Vehicle Area, which 
is measured from the beginning of the path where the 
area is located. The default is 0.0 m.

X X X

End Location Position for the end of the Single Vehicle Area, which 
is measured from the beginning of the path where the 
area is located. The default is 0.0 m.

X X X

NOTE: For a downstream Single Vehicle Area, the end location on the path is further downstream (larger 
number than the Start Location). For an upstream Single Vehicle Area, the end location on the 
path is further upstream (smaller number than the Start Location).

Path n Length The total length of the path as calculated from the 
motor sections included in the path where the SVA is 
located. If the number, type of motors, or the spacing 
between motors is changed, this value can change.

X X X
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Simulated Vehicles

Simulated vehicles are used to create simulated vehicles for transport system testing. The 
Simulated Vehicle page (see Figure 5-59), is accessed by expanding the Simulated Vehicles 
list under a path in the Configuration Tree and selecting the appropriate simulated vehicle. See 
Create and Edit Simulated Vehicles on page 174 for usage. The simulated vehicle is a 
simulated version of the vehicle that is defined on the Motor Defaults page.

NOTE: To access the Simulated Vehicle page (see Figure 5-59), make sure the Show 
Simulated Vehicles option in the View menu in the Configurator is selected.

Figure 5-59: Simulated Vehicles Page

Table 5-24: Simulated Vehicle Parameters

Parameter 
Name Parameter Description MM 

Lite
Quick
Stick QSHT

Location The starting position for the Simulated Vehicle 
measured from the beginning of the path. The default 
is 0.0 m.

X X X

Path n Length The total length of the path as calculated from the 
motor sections included in the path where the 
Simulated Vehicle is located. If the number, type of 
motors, or the spacing between motors is changed, 
this value can change.

X X X
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Troubleshooting 6

Overview

This chapter describes the common difficulties that may be encountered when using the 
MagneMotion® Configurator. Included in this chapter are:

• Initial Troubleshooting.

MagneMotion Configurator Troubleshooting
Table 6-1 briefly identifies common MagneMotion Configurator faults, and general solutions.

Table 6-1: Initial MagneMotion Configurator Troubleshooting

Symptom Problem Solution

Transport system components, 
such as paths, are not displayed in 
the Configuration Tree or not 
displayed correctly.

No Node Controller 
Configuration File loaded.

Open the Node Controller 
Configuration File in the 
Configurator. See Run the 
MagneMotion Configurator on 
page 26.

Incorrect Node Controller 
Configuration File loaded.

Make sure that the correct Node 
Controller Configuration File is 
open. See Run the MagneMotion 
Configurator on page 26.

The MagneMotion Configurator 
does not run.

Microsoft® .NET is not installed 
or is missing components.

Download and install the 
Microsoft .NET Framework 4 
(Standalone Installer).
(http://www.microsoft.com/en-us/
download/details.aspx?id=17718)

The Track Layout File does not 
contain the saved layout.

The MagneMotion Configurator 
crashes when running the Walk 
the Paths command.

Red outline displayed next to text 
entry field.

Invalid or improperly formatted 
value was entered.

Reenter the value and make sure 
that it is valid and correctly 
formatted. See Dialog Box and 
Window Elements on page 186.

http://www.microsoft.com/en-us/download/details.aspx?id=17718
http://www.microsoft.com/en-us/download/details.aspx?id=17718
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Appendix

Additional Documentation

Release Notes

The release notes that are supplied with MagneMotion software include special instructions, 
identification of software versions, identification of new features and enhancements, and a list 
of known issues. Reading this file is recommended before using the software.

Upgrade Procedure

The upgrade procedures that are supplied with MagneMotion software provide instructions 
for upgrading from one version of MagneMotion software to another. They also include the 
procedures for file and driver upgrades that are associated with the software.

Transport System Limits
For information on transport system limits, see the MagneMotion Node Controller Hardware 
User Manual, publication MMI-UM013.

https://literature.rockwellautomation.com/idc/groups/literature/documents/um/mmi-um013_-en-p.pdf


Appendix

278 Rockwell Automation Publication MMI-UM046A-EN-P - May 2023

This page intentionally left blank.



Rockwell Automation Publication MMI-UM046A-EN-P - May 2023 279

Index

A
All Stations

function, 270
view, 168

B
BMP, 67

C
Checkboxes, 186
Communication Cables, 15
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Configuration File, see Node Controller Config-
uration File
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Configurator

about, 13
description, 17
install, 23
running, 23, 26, 42
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Configurator Menu Bar, 196
Configurator, see Configurator
Console Interface, description, 17

controller_image, see Node Controller Software
Image File

Copy
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Cut
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D
Delete
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Demo Script
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E-stop, 178
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placing, 59

Diverge Node
configuration, 128
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Copy, 73
Cut, 73
Delete, 75
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Edit Layout
reposition, 43
symbol properties, 43

E-stop
configure, 177
edit, 178

Ethernet Motor Commissioning Tool, descrip-
tion, 17

Ethernet, node controller address, 21
EtherNet/IP

configuration, 78
European Number Formatting

configure, 72
hide, 72
show, 72

F
File Types, 17

G
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motor, 106
Gateway Node

configuration, 136
page description, 252

Getting Started, 18
Global Settings

configuration, 75
overview, 34
page description, 201

Global Settings Parameters, 201
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H
Help, 199
High Level Controller, 15
HLC Control Group

page description, 215
Host Controller, 15

I
Icon

motor, 31
node, 31

Image Files
motor, 17
node controller, 17

Interlock
configure, 179
edit, 181

K
Keepout Area

configure, 110
property, 247

L
Layout Area

System Layout, 195
Layout Options

System Layout, 192
Layout Toolbar, 190
Layout, see Track Layout
Leg Icon

placing, 61
Load From Track Layout File, 33

M
MagneMover LITE

components, 15
motors, 101, 102
transport system, 13

Magnet Array
identification, 15

Magnet Array Type File, description, 17
magnet_array_type.xml, see Magnet Array Type

File
Manual

prerequisites, 9
related manuals, 11

Menu
configurator, 196
shortcut, 200
system layout, 190

Merge Node
configuration, 124
page description, 254

Merge-Diverge Node
configuration, 132
page description, 259
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Messages, 185
MICS File, description, 18
MICS_motor_data.xml, see MICS File
MMConfigTool.exe, see Configurator
Motor

default parameters, 91
define default parameters, 100
gaps, 106
Keepout Area, 247
overview, 34
page description, 220, 224
system components, 15

Motor Icons
overview, 31
placing, 48

Motor Image File, description, 17
Motor Type File, description, 17
motor_image.erf, see Motor Image File
motor_type.xml, see Motor Type File
Moving Path Node

configuring, 141
page description, 263

N
NC File Retrieval Tool, description, 17
NCHost TCP Interface Utility, description, 17
NCHost.exe, see NCHost TCP Interface Utility
Network, 15
New

Node Controller Configuration File, 36
Track Layout File, 31

Node Controller
define, 161
edit, 162
identification, 15
overview, 35
page description, 267
paths, 34

Node Controller Configuration File
about, 34
create, 36
create automatically, 20
create manually, 20
define, 69
description, 17
edit, 38
motors, 34

node controllers, 35
nodes, 35
open, 38
paths, 34
save, 36

Node Controller Console Interface, see Console
Interface

Node Controller Software Image File, descrip-
tion, 17

Node Controller Web Interface, see Web Inter-
face

Node Icon
overview, 31
placing, 52

Node Type
Diverge, 128
Gateway, 136
Merge, 124
Merge-Diverge, 132
Moving Path, 141
Overtravel, 138
Relay, 121
Simple, 119
Terminus, 122

node_configuration.xml, see Node Controller
Configuration File

Nodes
create, 118
edit, 118
overview, 35
page description, 248

Notes, 9

O
Open XML Configuration, 38
Overtravel Node

configuring, 138
page description, 262

P
Pane

configuration properties, 184
configuration tree, 184
system layout, 184
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Parameters
Advanced, 243
Control Loop, 241
EtherNet/IP Settings, 210
Global Settings, 201, 203
HLC Control Group Settings, 215
Keepout Areas, 247
Motor, 235
Node, 249

Diverge, 258
Gateway, 253
Merge, 255
Merge-Diverge, 261
Moving Path, 265
Overtravel, 263
Relay, 251
Simple, 250
Terminus, 252

Node Controller, 267
Path End Ownership List, 269
Paths, 218
Simulated Vehicle, 273
Single Vehicle Area, 272
Stations, 270
Vehicle, 227

Paste
configuration elements, 73

Paths
configuration, 88
downstream end, 87
edit, 89
overview, 34
page description, 217
stations, 165
upstream end, 87
view table, 86
zero point, 87

PDF, 66
Per Motor Control Loop Parameters

hide, 109
show, 109

PID, 240
PLC EtherNet/IP

page description, 208
Power Cables, 15
Power Supply, 15

Precision Locator Icon
placing, 59

Puck, see Vehicle

Q
QuickStick

motors, 102
QuickStick 100

transport system, 13
QuickStick HT

transport system, 13
QuickStick transport systems., 13

R
Relay Node

configuration, 121
page description, 251

Reposition Layout Symbols, 43
Restricted Parameters File

description, 18
restricted_parameters.xml, see Restricted Pa-

rameters File
Running the Configurator, 26

S
Safety Alert Types, 9
Save

Node Controller Configuration File, 39
Track Layout File, 32

Save As
Node Controller Configuration File, 37
Track Layout File, 31

Saving Files
Node Controller Configuration File, 36
Track Layout File, 31

Scope, see Virtual Scope
Short-cut keys, 18
Show Advanced Parameters, 199
Show Per Motor Control Loop Parameters, 109,

199
Show Simulated Vehicles, 199
Simple Node

configuration, 119
page description, 250
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Simulated Vehicle
create, 175
edit, 176
page description, 273

Single Vehicle Area
create, 171
edit, 172
page description, 271

Single Vehicle Areas
create, 170
create and edit, 169
edit, 172
show, 170

Software Requirements, 23
Software Types, 16
Station Insert Mode, 199
Stations

create, 166
edit, 167
page description, 270
paths, 165
show, 166
view, 168

Sync Box Icon
placing, 49

System Layout Pane, 29, 184, 189
System Type, 27

T
Terminus Node

configuration, 122
page description, 251

Text and Display Fields, 187
Text Files

Demo Script, 18
Track File, 18

Text Icon
placing, 64

Track File, overview, 18
Track Layout

add text, 64
automatic node placement, 54
Clear Path Indicators, 58
create BMP, 67
create Node Controller Configuration File,

55
create PDF, 66

dimensioning, 63
editing, 43
forward motion, 59
legs, 61
Motors, 48
node placement, 52
Precision Locator, 59
vehicles, 60

Track Layout File
about, 30
create, 31
define, 42
description, 18
edit, 33
open, 33
save, 31

track_file.mmtrk, see Track File
track_layout.ndx, see Track Layout File
Transport System, software, 16
Type Files

magnet array, 17
motor, 17

U
UI, see User Interface
Upstream, 87
User Interface

configuration properties pane, 189
configuration tree, 188
Configurator Menu Bar, 188, 196
description, 187
elements, 184
features, 185
Layout Menu Bar, 189
layout toolbar, 190
starting, 23, 26
system layout pane, 189

Utilities, 16

V
Vehicle

aft length, 98
default parameters, 95, 99
fore length, 98
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Icon
placing, 60

linear, 95
port width, 99
rectangular, 98
starboard width, 98

Virtual Scope, description, 17

W
Walk the Paths, 57
Web Interface, description, 16

X
XML Files

Magnet Array Type File, 17
MICS File, 18
Motor Type File, 17
Node Controller Configuration File, 17
restricted parameters file, 18
Track Layout File, 18

Z
Zero Point, path, 87
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